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Attention!

FFFFFederal Communications Commission (FCC) Complianceederal Communications Commission (FCC) Complianceederal Communications Commission (FCC) Complianceederal Communications Commission (FCC) Complianceederal Communications Commission (FCC) Compliance
Notice:Notice:Notice:Notice:Notice:
Radio FRadio FRadio FRadio FRadio F requency Noticerequency Noticerequency Noticerequency Noticerequency Notice

NOTE:NOTE:NOTE:NOTE:NOTE:  This equipment has been tested and found to comply with the
limits for a Class A digital device, pursuant to Part 15 of the FCC rules. These
limits are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial environment.
This equipment generates, uses, and can radiate radio frequency energy
and, if not installed and used in accordance with the instruction manual,
may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference in
which case the user will be required to correct the interference at his own
expense.

This is a Class A product. In a domestic environment, thisThis is a Class A product. In a domestic environment, thisThis is a Class A product. In a domestic environment, thisThis is a Class A product. In a domestic environment, thisThis is a Class A product. In a domestic environment, this
product may cause radio interference, in which case, theproduct may cause radio interference, in which case, theproduct may cause radio interference, in which case, theproduct may cause radio interference, in which case, theproduct may cause radio interference, in which case, the
user may be required to take appropriate measures.user may be required to take appropriate measures.user may be required to take appropriate measures.user may be required to take appropriate measures.user may be required to take appropriate measures.

This equipment must be installed and wired properly in order to assure
compliance with FCC regulations.

Caution!Caution!Caution!Caution!Caution!      Any modifications not expressly approved in writing by Any modifications not expressly approved in writing by Any modifications not expressly approved in writing by Any modifications not expressly approved in writing by Any modifications not expressly approved in writing by
Wheatstone could void the user's authority to operate this equipment.Wheatstone could void the user's authority to operate this equipment.Wheatstone could void the user's authority to operate this equipment.Wheatstone could void the user's authority to operate this equipment.Wheatstone could void the user's authority to operate this equipment.
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Attention!
Important Safety Instructions

1. Read these instructions.
2. Keep these instructions.
3. Heed all warnings.
4. Follow all instructions.
5. This equipment must be installed and operated in a dry location free from dripping or 

splashing liquids. No objects filled with liquid (such as beverage containers and the like) 
shall be placed on or near the unit.

6. Clean only with dry cloth.
7. Do not block any ventilation openings. Install in accordance with the manufacturer’s 

instructions.
8. Do not install near any heat sources such as radiators, heat registers, stoves, or other ap‑

paratus (including amplifiers) that produce heat.
9. Do not defeat the safety purpose of the polarized or grounding‑type plug. A polarized plug 

has two blades with one wider than the other. A grounding type plug has two blades and 
a third grounding prong. The wide blade or the third prong are provided for your safety. 
If the provided plug does not fit into your outlet, consult an electrician for replacement 
of the obsolete outlet.

10. Protect the power cord from being walked on or pinched particularly at plugs, convenience 
receptacles, and the point where they exit from the apparatus.

11. Only use attachments/accessories specified by the manufacturer.
12. Unplug this apparatus during lightning storms or when unused for long periods of time.
13. Refer all servicing to qualified service personnel. Servicing is required when the apparatus 

has been damaged in any way, such as power‑supply cord or plug is damaged, liquid has 
been spilled or objects have fallen into an apparatus, the apparatus has been exposed to 
rain or moisture, does not operate normally, or has been dropped.

14. DISCONNECTING DEVICE FROM MAINS – Main power cord plug is the disconnect‑
ing device. The power plug of an installed unit must remain readily accessible/operable 
at all times.

WheatNet-IP Blade3s

WARNING!
To reduce the risk of fire or electric shock, do not 

expose this apparatus to rain or moisture.
(PRODUCT IDENTITY)

8D48
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Attention!
Consignes De Sécurité Importantes

WheatNet-IP Blade3s

1. Lire ces instructions.
2. Conserver ces instructions.
3. Observer tous les avertissements.
4. Suivre toutes les instructions.
5. Ce matériel doit être installé et utilisé dans un endroit sec à l'abri d'éclaboussures de  liquides 

ou de gouttes. Aucun objet rempli de liquides tel que breuvages ou autres, ne doit être 
placé sur le dessus ou à côté de cet appareil.

6. Nettoyer uniquement avec un linge sec.
7. Ne pas bloquer les ouvertures de ventilation. Installer d'après les instructions du  manufacturier.
8. Ne pas installer près de sources de chaleur tels que des radiateurs, registres de chaleur, 

poêles ou autres appareils (incluant les amplificateurs) pouvant de la chaleur.
9. Ne pas contourner le dispositif de sécurité de la fiche polarisée ou de mise à la terre. Une 

fiche polarisée a deux lames dont une plus large que l'autre. Une fiche de terre a deux 
lames et une troisième broche de mise à la terre. La lame large ou la troisième broche est 
fournie pour votre sécurité. Si la fiche fournie ne rentre pas dans votre prise, consultez un 
électricien pour le remplacement de la prise obsolète.

10. Protéger le cordon d'alimentation en évitant qu'il ne soit piétiné ou écrasé notamment au 
niveau des fiches et le point de sortie de l'appareil.

11. N'utiliser que les fixations et accessoires spécifiés par le fabricant.
12. Débrancher cet appareil pendant les orages ou lorsqu'il n'est pas utilisé pendant de longues 

périodes de temps.
13. Confier toute réparation à un personnel qualifié. Une réparation est nécessaire lorsque 

l'appareil a été endommagé de quelque façon que ce, soit tel que :  le  cordon d'alimentation 
ou la fiche est endommagée, du liquide a été renversé ou des objets sont tombés dans  
l'appareil ou celuici a été exposé à la pluie ou à l'humidité ou ne fonctionne pas  normalement 
ou s'il est tombé.

14. DÉBRANCHEMENT DE L'APPAREIL DU SECTEUR – Le cordon d'alimentation prin-
cipal est le dispositif de déconnexion. Le cordon d'alimentation d'une unité installée doit 
rester facilement accessible / utilisable à tout moment.

ATTENTION!
Pour réduire le risque d'incendie ou de choc électrique, 
ne pas exposer cet appareil à la pluie ou à l'humidité.

(PRODUCT IDENTITY)
8D48
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Before Getting Started
The purpose of this document is to aid in the quick setup of your new Wheatstone

WheatNet-IP product. The WheatNet-IP product comes with a setup wizard that will
walk you through the setup process. This wizard is designed to help you get the system
up and running quickly with little effort. If you have any issues during the setup process
please contact Wheatstone Technical Support for further assistance at (252) 638-7000.

The guide assumes that connectivity will take place by one of the following methods.

Isolated Network

It is recommended that connectivity of the WheatNet-IP be made through an isolated
Gigabit Ethernet switch.

House Network

Careful planning should be done if the WheatNet-IP system will integrate into your
house network. A separate VLAN or other isolation method must be deployed to contain
the multicast traffic. This guide assumes the network is equipped with a Gigabit network
switch or router capable of handling this type of configuration. Consult your IT
department for more information.

Snake Mode

This connection method assumes there will be two BLADEs connected back to back
via a crossover cable to provide a point-to-point audio link. See “Snake” in Chapter 2 of
this manual.

Network Setup

BLADE ID

Once power is applied the BLADE Quick Setup wizard will start automatically,
assuming this is a first-time startup, and the front panel display should read as follows.

Rotate the encoder knob to the desired BLADE ID and press the TAKE button.

W h e a t N e t - I P  Q u i c k  S t a r t  S e t u p  G u i d e

WheatNet-IP / Jan 2010
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Consideration should be given to the ID selection as no two BLADEs in the system
may have the same ID. The ID should be chosen based on system topology and should
reflect how the system will ultimately be configured.

Wheatstone recommends assigning ID “1” to the first BLADE you power up on the
network, ID “2” to the second, etc. The numbers have no real significance, only that they
must be unique.

IP Address

Based on the BLADE ID selected the wizard will recommend an IP address. The
default IP address will be in the 192.168.87.XXX scheme. Press the TAKE button if this
address is correct for your network scheme and the wizard will automatically advance to
“Signal Setup” section.

Consult the manual or Wheatstone Support if you cannot accept this IP Address.

Sample Rate

The WheatNet-IP system operates at 44.1kHz or 48kHz sample rates. Here you will
select the default sample rate at which the system will operate. It is a good idea to pick
a sample rate that your entire facility will adopt and stick with it. If 3rd party gear is
operating at a different sample rate the WheatNet-IP system is capable of receiving inputs
from 32kHz up to 96kHz and will up or down convert accordingly to the WheatNet-IP
sample rate.

Signal Setup
Now that the Network Setup is complete the wizard will assist with creating audio

signals if desired. The WheatNet-IP unit is equipped with signal templates to aid in quick
setup. These templates are standard signal setups that may be a good starting point,
depending on the application. The WheatNet-IP 88a, 88d, and 88ad have three template
layouts. Choose from Custom, Stereo I/O, and Mono I/O templates. The 88m has two
available templates, Mono_Mic and Stereo_Mic. The WheatNet-IP 88cb has three
template layouts. Choose from Custom, Console_Stereo_In, and Console_Mono_In
templates.

To select a template rotate the encoder knob to the desired template and press Take.

Custom Template

This template creates no signals. Instead the user will create the signals using the
Navigator GUI.

Stereo I/O Template

This template creates eight Stereo Inputs and eight Stereo Outputs. Signal names are
assigned based on the BLADE ID and will have a “BLxx_yy” naming convention, where
“xx” is the BLADE ID and “yy” is source (or destination) 01 through 08.

Mono I/O Template

This template creates 16 Mono Inputs and 16 Mono Outputs. Signal names are
assigned based on the BLADE ID and will have a “BLxx_yy” naming convention, where
“xx” is the BLADE ID and “yy” is source (or destination) 01 through 16.

WheatNet-IP / June 2010
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Stereo Mic I/O Template

This template creates eight Mono Microphone inputs and four Stereo outputs.
Signal names are assigned based on the BLADE ID and will have a “BLxx_yy” naming
convention, where “xx” is the BLADE ID and “yy” is source 01 through 08 or
destination 01 through 04.

Mono Mic I/O Template

This template creates eight Mono Microphone inputs and eight Mono outputs.
Signal names are assigned based on the BLADE ID and will have a “BLxx_yy” naming
convention, where “xx” is the BLADE ID and “yy” is source or destination 01 through 08.

Console I/O Template

This template creates and maps all connections needed to run your E-1 control
surface. This includes the four Program busses, along with the Headphone, Cue, and
Studio outputs. All surface output mixes are automatically routed to the Console
Blade’s rear panel connectors to help speed up the installation process.

Connection Status
After completing the setup process the BLADE will attempt to join the network.

During this process a “Connecting...” message will appear on the display.

Once the BLADE has successfully joined the network the front panel will display:
To access the Main Menu rotate the encoder and select the desired option by

pressing “Take.”

Things To Look For In The Wizard

If an online BLADE is detected with the same ID the wizard will display the
following

“IP ALREADY IN USE! VERIFY SETUP”
This message will be displayed until the user acknowledges by pressing the TAKE

button. The wizard will then start over. Simply change the BLADE ID to a unique ID
and advance through the options.

If replacing a failed BLADE on the network and you wish to assume the identity of
the failed BLADE, select the ID previously used. This will place the new BLADE on
the network in a default configuration. Once online you may restore the previous
configuration from a backup copy using the WheatNet-IP Navigator GUI or the
BLADE Web Interface. For more information on backing up and restoring BLADE
configuration please refer to the WheatNet-IP Navigator GUI section of the manual.

WheatNet-IP / June 2010
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Surface Setup
If you have an Mix Engine Blade, it can be used with a Wheatstone E-Series surface

to provide mixing capability. In order to be used in a BLADE system, the surface must
first be properly configured.

Network Settings

When the E-Series surface is powered up the first time it will display a dialog box
stating that no network file was found (See Figure 1).

To configure the network settings for the E-Series surface select “YES” from the
dialog box. The surface will now display the Options Tab (See Figure 2). Here you will
set the BLADE ID and IP address of the Engine to which the surface will connect, along
with the Surface IP Address, Subnet Mask, and Gateway. If Automatic mode is
selected, enter the BLADE ID of the Mix Engine Blade to be associated with the surface
and remaining settings are configured for you. You can manually enter this information
by turning off Automatic mode and using the numbered keypad on the screen. Pressing
NEXT will advance to the next field. When done simply press APPLY to finalize these
settings and the surface will request a reboot (See Figure 3).

Figure 1
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Figure 2

For convenience, Wheatstone uses the following convention for IP Addressing in the
WheatNet-IP system:

1. The IP Address of a BLADE is equal to the BLADE ID plus 100; i.e.
 BLADE 3 = 192.168.87.103

2. The IP Address of an E-6 control surface is equal to the Engine BLADE ID plus 200;
i.e. Engine BLADE = 5, Surface IP Address = 192.168.87.205

A Configuration
Mode

This is where you select the Configuration mode desired. The choices are
Automatic or Manual.

B Mix Engine
     ID

This is where the ID of the Mix Engine Blade that will be associated with
the surface is assigned. One Mix Engine Blade supports a single surface.

C Blade
     Status

This is the Blade connection status. If properly configured and connected to
an Engine, status will be “CONNECTED.” If improperly configured the
status will read “DISCONNECTED.”

WheatNet-IP / June 2010
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Select YES from the dialog box and the surface will reboot. Once the surface has been
rebooted navigate to the Options Tab and select Network Settings from the drop down
menu. If all information was entered properly the BLADE STATUS will display “CON-
NECTED” (See Figure 4). The E-Series surface has been successfully configured.

Figure 3

WheatNet-IP / June 2010
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Figure 4
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General Information
Introduction

Congratulations on acquiring the Wheatstone WheatNet-IP system. This exciting 
new technology allows you to build a networked audio system of I/O devices, control 
surfaces, computers, and controllers, all without using a dedicated audio router. How 
do we do this? By using a LAN (Local Area Network) itself to connect the various 
devices together and distribute audio and logic data where needed.

Each WheatNet-IP device (we call them “BLADEs”) functions primarily as an 
audio access point, where analog or digital audio signals are connected to this network. 
Within the WheatNet-IP unit, the audio channels are converted to packets of data 
that can travel over an Ethernet LAN. The Ethernet switches that compose the core 
of the LAN directly control the distribution of packets and perform the “switching” 
function of a traditional audio router. Once the audio packets have been forwarded 
to the desired destination end point (typically a PC or another WheatNet-IP device), 
they are reassembled into an audio signal and made available.

By converting audio into data packets, the traditional audio wiring infrastructure 
of multipair cables, trunk lines, patch bays, and punchblocks is no longer needed. 
In fact all the distribution cables you need may already be in place – in the form of 
your LAN and its CAT-5e cables. You’ll only need to wire your source and destina-
tion devices to “BLADEs” to complete your system. Best of all, the dozens of audio 
cables and hundreds of logic connections you used to need to connect up each audio 
console have been replaced with a single CAT-5e cable to the control surface. What 
could be easier?

A word about latency – a finite and not insignificant delay from when audio or 
logic starts at the input of the system and when it appears at the output. Packet based 
audio networks have a reputation of having significant latency issues due to the per-
formance of the earliest implementations, some of which had tens and even hundreds 
of milliseconds of latency. Each component of the system contributes to latency. On 
the input side, the A/D convertors (or Sample Rate Convertors for digital inputs) take 
a little time to do their work. Multiple samples of audio data must be accumulated and 
formed into packets before they are placed on the network. Ethernet switches take 
time to analyze the packets before they are sent on to their destinations, where they 
are disassembled and formed into audio streams which finally can be converted by 
D/A converters before the audio starts to play. All of this eats up a little bit of time at 
each step along the way. The WheatNet-IP system has been designed from the out-
set to use Gigabit networks, among other things, to minimize latency. Total latency 
from a BLADE’s input through an Ethernet switch to a different BLADE’s output 
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is roughly 1/2 millisecond, which is well below the 5-10 millisecond human threshold 
of detection. Unfortunately, due to the none-real time nature of the Windows operating 
system and the fact that Windows requires buffers for audio streams, latency to/from a 
Windows PC  remains on the order of 100 milliseconds.

Rack Mounting
The WheatNet-IP is designed to fit into an industry standard 19" equipment rack, and 

requires one rack unit (1.75 inches) of vertical space. Every BLADE model has a depth 
of 13-1/4" behind the rack rails (including chassis connectors), with the exception of 
the MADI BLADE with a 13-3/4" depth and LIO-48 BLADE with a 9-1/2" depth. An 
 additional five inches of space is required for wiring cables to pass through. The chassis of 
all BLADE models has a width of 17-3/8". Space needed in front of rack rails is 3/4"for all 
BLADE models. The WheatNet-IP does not have top or bottom cover vent holes.  Latent 
heat is vented out of the enclosure by natural convection through slots in the top of the 
rear panel. Cooler air is drawn into the unit through vertical slots positioned lower in the 
side panels. There is no fan inside the WheatNet-IP because its power consumption is 
low enough to not require one.

The WheatNet-IP may be mounted between other devices in the equipment rack and 
in accordance with good engineering practice should not be mounted directly above 
 devices that generate significant amounts of heat. If such a location is unavoidable then it 
is  advisable to utilize an extra 1RU blank rack panel between the WheatNet-IP and devices 
immediately above and/or below it. WheatNet-IP 88a analog BLADEs in particular run 
hotter and should be installed with spaces in between to avoid detrimental heat build up.

WARNING! Under no circumstances should the WheatNet-IP unit be opened! 
The unit contains high voltage circuits that are hazardous and potentially harmful. 
The unit has no user-serviceable parts inside! If you have a problem the unit must 
be returned to Wheatstone Corporation for repair.

Installation Tips
• Place any surge protection circuits as close as possible to the WheatNet-IP or other 

device being protected. 
• Establish a low impedance common ground in your facility and try to route all 

grounds to that point.
• Choose the best power conditioning / UPS units that you can afford and suitable 

for your equipment – focus on the features and options you need. The better UPS 
products can prevent thousands of dollars in equipment damage — some even come 
with an external equipment damage warranty.

• Unbalanced audio connections to the WheatNet-IP should be made with shielded two 
conductor cable such as Belden 8451 or 9451 as if connecting a balanced source. At 
the unbalanced source’s output connect the + Output to the HI input wire and connect 
the source GND wire to the LO wire. Connect the shield at the WheatNet-IP end only.

• For digital audio connections always use a good quality digital audio cable with a 
characteristic impedance of 110 ohms. 

The AES/EBU specification, with its broad impedance tolerance, allows for cables with impedances 
from 88 ohms to 132 ohms – 110 ohms is ideal. Twisted pair cable should be shielded, and in the 
case of multi-pair cable, each pair should be individually shielded. Foil shielding is recommended for 
permanent installations and foil shield plus overall braid should be used in applications where frequent 
flexing of the cable will occur. One cable pair is capable of carrying two channels of digital audio.

WheatNet-IP / Aug 2012WheatNet-IP / Mar 2013WheatNet-IP / May 2013WheatNet-IP / Mar 2014



G E N E R A L  I N F O R M A T I O N

page  1 – 5WheatNet-IP / Aug 2011

Generic “audio” cable such as Belden 8451 may be used for interconnecting 
AES3 digital audio devices but only for distances of less than about 25 feet. 
The actual cable length that will work satisfactorily in an installation is pri-
marily determined by the error correction and jitter tolerance of the AES3 
receiver device and the cable used. 

The impedance of most ‘analog’ cables ranges from 40 ohms to 70 ohms and represents a 
large impedance mismatch from the nominal 110 ohms required in the AES3 standard. Such 
mismatch will result in signal reflections, causing bit errors at the AES3 receiver. The higher 
capacitance of generic analog cables also slows down the rise time of the digital data signals, 
impairing the ability of the AES3 receiver to accurately detect digital signal transitions. This 
may result in increased jitter.

Energizing
Assuming the WheatNet-IP is correctly rackmounted, you may now energize 

it. There is no power switch. The AC line input voltage is permitted to be be-
tween 90 and 260VAC, 50 or 60Hz. Power consumption is under 100VA. 

Aggressive AC input filtering is utilized at the AC input of the WheatNet-IP; 
however, it is always advisable to use external surge protection and/or an uninter-
ruptible power supply (UPS), especially where AC power quality is questionable, 
such as at a remote transmitter site. 

Power conditioning, surge suppression, and even power backup devices are wise 
investments when using sensitive modern electronic devices that use an internal 
computer. 

Use of a UPS (uninterruptible power supply) is a good idea and will protect the 
WheatNet-IP from short duration power interruptions which may cause it to reboot. 
During boot up, audio is interrupted for approximately 40 seconds.

A Word About Nomenclature
Throughout this manual references are made to “BLADEs,” “sources,” “des-

tinations,” and other terms whose meanings may not be instantly understood by 
everyone. Let’s take a moment to clarify some terms.

1. BLADE. In the WheatNet-IP system a “BLADE” is taken to mean an indi-
vidual member of a WheatNet-IP system; any device that has a unique BLADE ID. It 
commonly refers to an individual input/output rackmount unit, but a more complete 
definition would include any network connected PC running a WheatNet-IP driver 
as well, including Automation servers and even the Program Director’s PC if they 
are running the WheatNet-IP driver to listen to audio streams. Conversely, any PC 
that is running the WheatNet-IP Navigator GUI program or using a browser for 
interfacing to the built in web servers on BLADEs is not a BLADE itself. Only those 
devices that can transmit and/or receive WheatNet-IP audio streams are “BLADEs.”

2. Source. A source is any audio signal in the WheatNet-IP system that is uniquely 
generated. Any WheatNet-IP signal that is created by accepting and packetizing an 
input is a source, as is any signal generated within the system. Source signals may be 
audio, logic, or both. A logic source might be  a logic port triggered by an external 
switch. We generally avoid using the term “input” to describe WheatNet-IP signals 
because the term can be misleading. One would easily understand that an external 
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audio input jack could be an “input” or “source,” but less obvious is the fact that 
an audio mix bus output is also a WheatNet-IP source because it is generating a 
unique signal (the mix) and making it available to stream throughout the system. 
Likewise, PCs streaming audio from a file via the WheatNet-IP driver can clearly 
be seen as a “source.”

3. Destination. A destination is the opposite of a source. It is a signal that can 
accept any WheatNet-IP stream. A destination can take the received WheatNet-IP 
stream and convert it to a physical analog or digital output, or, in the case of a 
PC, a virtual output that subsequent PC application programs can convert to an 
audio output at the PC’s speakers, or lay down as an audio track on the hard disc. 
Destinations can be audio, logic, or both. A logic destination might be a logic 
port wired to a lamp or relay. We avoid using the term “output” for WheatNet-IP 
signals. While it is clear that a WheatNet-IP destination wired to an output jack 
is an “output,” control surface fader channels would not normally be considered 
“outputs” but they are “destinations” in the WheatNet-IP system, because you 
can route a WheatNet-IP audio stream to them.

4. LIO. Shorthand for Logic Input or Output. In the WheatNet-IP system, 
an LIO signal is a signal that either generates or receives logic state information 
created either physically via a logic port or virtually via some state change within 
a mixing control surface. In the WheatNet-IP system logic information can be 
routed and cross connected just as audio can be.

5. GUI. Shorthand for Graphical User Interface. A method of providing for 
user interaction with the system using a special computer program that displays 
information in the form of images and text on the computer screen and accepts 
user input via typing and mouse clicking within the computer program. The 
WheatNet-IP Navigator is a computer program that provides a GUI.

6. Web Server. A special computer program running on WheatNet-IP devices. 
Its intention is to provide for user interaction with the system by means of com-
mon place computer programs called “Web Browsers” that the user is likely to 
have on their PC  and be familiar with because of their use accessing web pages 
over the World Wide Web via the Internet. The  web server and Navigator GUI 
provide similar functions but in opposite ways: the Navigator GUI provides user 
access via the special program that must first be installed and then run on a par-
ticular PC, while the web server is a special program installed on every BLADE 
to provide user access via commonplace programs from any PC. Why do we 
provide both? Each has it advantages. A Browser is a general purpose program 
designed for viewing many different web pages and, as such, is best suited for 
general viewing functions such as seeing status, version, or logging information, 
while the Navigator GUI is a special program written specifically to control the 
nuances of a WheatNet-IP system. A browser is easier to use because you don’t 
have to install any special programs, so any network connected PC should be 
capable of accessing the system, but the WheatNet-IP Navigator GUI is more 
powerful because it was designed from the ground up to control a WheatNet-IP 
system. Since each method of user access has some advantages, we have provided 
for both methods in the WheatNet-IP system.



G E N E R A L  I N F O R M A T I O N

page  1 – 7WheatNet-IP / Aug 2011

WheatNet-IP System Description
Let’s take a look at the parts of the WheatNet-IP system in more detail.

First there are the “BLADEs” themselves of which there are five flavors.
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Model 88a - Analog BLADE
WheatNet-IP 88a is an access point for analog audio. 

It has two DB-25 and eight RJ-45 connectors (the DB and RJ connections are 
in parallel so you can choose your preferred connector type) for 16 audio inputs. 
These can be set up as eight stereo, 16 mono, or any combination up to a maximum 
of 16 discrete channels. 

It also has two DB-25 and eight RJ-45 connectors (again, use your preferred 
connector) for 16 audio outputs. These can also be set up as eight stereo, 16 mono, 
or any combination up to a maximum of 16 discrete channels. 

It has two more RJ-45 connectors to provide 12 logic ports, which can be individu-
ally designated during set up as inputs or outputs. These ports are where you wire the 
various external switches, indicators, and control functions you need in your facility.

There are two RJ-45 jacks for Ethernet. One is for 1 Gigabit Ethernet – connect 
this one to your network. The 100 Megabit Ethernet port is not used – do not con-
nect anything to this port.

Consult the wiring diagram at the page 1-35 for detailed information.
The unit has a standard IEC power connector. The BLADEs have an internal 

power supply that will accept 100-240 volts 50/60 hertz AC power.

Model 88d - Digital BLADE
WheatNet-IP 88d is an access point for digital audio. 

It has two DB-25 and eight RJ-45 connectors (the DB and RJ connections are 
in parallel so you can choose your preferred connector type) for eight AES audio 
inputs. These can be set up as eight stereo, 16 mono, or any combination up to a 
maximum of 16 discrete channels. Please note that because AES audio signals rep-
resent two audio channels on one connection, some of the input connections on the 
WheatNet-IP 88d are unused. 

It also has two DB-25 and eight RJ-45 connectors (again, use your preferred con-
nector) for eight AES audio outputs. These can be set up as eight stereo, 16 mono, or 

WheatNet-IP / Oct 2012
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any combination up to a maximum of 16 discrete channels. Please note that because 
AES audio signals represent two audio channels on one connection, some of the 
output connections on the WheatNet-IP 88d are unused. 

It has two more RJ-45 connectors to provide 12 logic ports, which can be indi-
vidually designated during set up as inputs or outputs. These ports are where you 
wire the various external switches, indicators, and control functions you need in 
your facility.

There are two RJ-45 jacks for Ethernet. One is for 1 Gigabit Ethernet – connect 
this one to your network. The 100 Megabit Ethernet port is not used – do not con-
nect anything to this port.

Consult the wiring diagram at the page 1-36 for detailed information.
The unit has a standard IEC power connector. The BLADEs have an internal 

power supply that will accept 100-240 volts 50/60 hertz AC power.

Model 88ad - Analog/Digital BLADE
WheatNet-IP 88ad is a hybrid access point for analog and digital audio. 

It has two DB-25 and eight RJ-45 connectors (the DB and RJ connections are in 
parallel so you can choose your preferred connector type) for audio inputs. These 
can be set up as eight stereo, 16 mono, or any combination up to a maximum of 
16 discrete channels. The first DB-25 and the first four RJ-45 jacks are set up as 
analog inputs. The second DB-25 and the last four RJ-45 jacks are set up as AES 
digital inputs. 

It also has two DB-25 and eight RJ-45 connectors (again, use your preferred 
connector) for audio outputs. These can be set up as eight stereo, 16 mono, or any 
combination up to a maximum of 16 discrete channels. The first DB-25 and first 
four RJ-45 jacks are set up as analog outputs. The second DB-25 and the last four 
RJ-45 jacks are set up as AES digital outputs. 

It has two more RJ-45 connectors to provide 12 logic ports, which can be indi-
vidually designated during set up as inputs or outputs. These ports are where you 
wire the various external switches, indicators, and control functions you need in 
your facility.

There are two RJ-45 jacks for Ethernet. One is for 1 Gigabit Ethernet – connect 
this one to your network. The 100 Megabit Ethernet port is not used – do not con-
nect anything to this port.

Consult the wiring diagram at the page 1-37 for detailed information.
The unit has a standard IEC power connector. The BLADEs have an internal 

power supply that will accept 100-240 volts 50/60 hertz AC power.

WheatNet-IP / Oct 2012
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Model 88m - Microphone BLADE
WheatNet-IP 88m is an access point for eight microphones. 

Both Console BLADEs integrate a powerful mix engine with analog and digital 
I/O to give you a single rack-space console solution. Pairing the 88cbe with the 
E-1 control surface, or pairing the 88cb with IP-12 control surface, results in a 
super-compact, ultra powerful-mix station that ties perfectly into your WheatNet-IP 
network or functions as a stand-alone console.

Two female XLR connectors are microphone preamplifier inputs. Recessed rear 
panel phantom power switches and gain trims can be independently configured, and 
one RJ-45 connector connects the preamp outputs to any one of the Analog Input 
RJ-45’s. 

When using the mi-
crophone preampli-
fiers, a jumper must 
be connected from 
the MIC OUTS to 
the desired analog 
input port (1-4).

WheatNet-IP / Nov 2012

This box has eight female XLR connectors for microphone inputs. Phantom power 
can be applied independently to each of the individual inputs. 

It also has one DB-25 and eight RJ-45 connectors (the DB and RJ connections are in 
parallel so you can choose your preferred connector type) for audio outputs. Only the first 
four RJ-45 ports are used. These can be set up as four stereo, eight mono, or any com-
bination up to a maximum of eight discrete channels. These are setup as analog outputs.

Two RJ-45 connectors provide 12 logic ports, which can be individually designated 
during set up as inputs or outputs. Use these ports to wire the various external switches, 
indicators, and control functions you need in your facility.

There are two RJ-45 jacks for Ethernet. One is for 1 Gigabit Ethernet – connect this 
one to your network. The 100 Megabit Ethernet port is not used – do not connect any-
thing to this port.

Consult the wiring diagram on page 1-38 for detailed information.
The unit has a standard IEC power connector. The BLADEs have an internal power 

supply that will accept 100-240 volts 50/60 hertz AC power.

Model 88cb, 88cbe - Console BLADE
The WheatNet-IP 88cb and 88cbe Console BLADE models provide comprehensive 

access points for typical control room audio I/O.
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Eight RJ-45 connectors are for audio inputs. The first four RJ-45 jacks are set up as 
analog inputs which can be setup as four stereo, eight mono, or any combination stereo 
and mono. The last four RJ-45 jacks are set up as AES digital inputs. 

Both Console BLADEs have eight RJ-45 connectors for audio outputs. The first four 
RJ-45 jacks are set up as analog stereo outputs, and the last four RJ-45 jacks are set up as 
AES digital outputs. The “Console” template, by default has a signal map that automatically 
cross connects the surfaces Program, Headphone, Cue, and Studio sources to the desig‑
nated outputs. The Digital outputs follow the Analog outputs and cannot be independently 
connected to different audio sources. 

An RJ-45 or four 1/4” jacks are provided for headphone and cue outputs.
Four XLR male connectors are provided for control room and studio outputs.
Console BLADEs have two more RJ-45 connectors to provide 12 logic ports, which 

can be individually designated during set up as inputs or outputs. These ports are where 
you wire the various external switches, indicators, and control functions you need in your 
facility.

There are two RJ-45 jacks for Ethernet. One is for 1 Gigabit Ethernet – connect this 
one to your network. The 100 Megabit Ethernet port is not used – do not connect anything 
to this port.

Consult the wiring diagram on page 1-39 for detailed information.
The unit has a standard IEC power connector. The BLADEs have an internal power 

supply that will accept 100-240 volts 50/60 hertz AC power.

Model e - Mix Engine DSP
WheatNet‑IP e is a special device that contains the mix engine and signal processing 

needed for a control surface. One WheatNet-IP e is needed for each control surface.

WheatNet-IP / Apr 2013

As you can see, it has no connections for audio inputs or outputs.
It has two RJ-45 connectors to provide 12 logic ports, which can be individually 

designated during set up as inputs or outputs. These ports are where you wire the various 
external switches, indicators, and control functions you need in your facility.

There are two RJ-45 jacks for Ethernet. One is for 1 Gigabit Ethernet – connect this 
one to your network. The 100 Megabit Ethernet port is not used – do not connect any‑
thing to this port.

Consult the wiring diagram at the page 1-40 for detailed information.
The unit has a standard IEC power connector. The BLADEs have an internal power 

supply that will accept 100-240 volts 50/60 hertz AC power.
As for the control surfaces, there are a variety of models (E-1, E-4, E-5, E-6) and sizes 

(from as few as 4 to as many as 28 faders) to choose from. These look like traditional 
audio consoles and perform similar kinds of functions and more. Consult the specific 
control surface manual for detailed information.



G E N E R A L  I N F O R M A T I O N

page  1 – 12WheatNet-IP / Aug 2011

Model Aura8ip - Vorsis Embedded BLADE
The WheatNet-IP Aura8ip Audio Processing BLADE brings two of Wheatstone’s 

core technologies together (Vorsis Audio Processing and the WheatNet-IP Intelligent 
Network) to provide a convenient and cost effective way to bring access to audio pro-
cessing wherever you need it on your WheatNet-IP network.

The Aura8ip BLADE occupies a single rack space, but packs an impressive comple-
ment of eight fully independent Vorsis Embedded multi-band stereo audio processors. 
Refer to the Aura8ip Vorsis Embedded Processing Blade technical manual for audio 
processor description and configuration.   

This BLADE has two DB-25 and eight RJ-45 connectors (the DB and RJ connec-
tions are in parallel so you can choose your preferred connector type) for audio inputs. 
The first DB-25 and the first four RJ-45 jacks are set up as analog inputs. The second 
DB-25 and the last four RJ-45 jacks are set up as AES digital inputs. 

The BLADE also has two DB-25 and eight RJ-45 connectors (again, use your 
preferred connector) for audio outputs. The first DB-25 and first four RJ-45 jacks are 
set up as analog outputs. The second DB-25 and the last four RJ-45 jacks are set up 
as AES digital outputs.

The BLADE has two more RJ-45 connectors to provide 12 logic ports, which can 
be individually designated during set up as inputs or outputs. These ports are where 
you wire the various external switches, indicators, and control functions you need in 
your facility.

There are two RJ-45 jacks for Ethernet. One is for 1 Gigabit Ethernet – connect 
this one to your network. The 100 Megabit Ethernet port is not used – do not connect 
anything to this port.

Consult the wiring diagram on page 1-41 for detailed information.
The unit has a standard IEC power connector. The BLADEs have an internal power 

supply that will accept 100-240 volts 50/60 hertz AC power.

Signal Configuration
The Aura8ip BLADE can be operated as a stand alone unit, or can be operated as 

part of a larger WheatNet-IP network.
If the Stand alone option is selected when the BLADE is configured, the rear panel 

inputs and outputs are automatically configured to provide the required connections to 
the eight channels of audio processing. Line 1 Input feeds signal to the first channel of 
audio processing, Line 2 Input feeds signal to the second channel, and so on. Likewise, 
Line 1 Output provides the output connection for the first channel of processing, Line 2 
Output for the second channel, and so on. In this mode, all inputs and outputs are con-
figured as stereo signals. Thus, in Stand alone mode, the Aura8ip BLADE functions 
as eight independent channels of stereo audio processing, four with analog inputs and 
outputs, and the other four with digital inputs and outputs.
WheatNet-IP / Oct 2012
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If the Mono, Stereo, or Custom template is selected when the BLADE is configured, 
the eight channels of audio processing are divorced from the unit’s input and output con‑
nections, and these inputs and outputs can then be routed to other BLADEs in the system.  
In this Networked mode the inputs of the eight audio processing channels become destina‑
tions in the system, to which any available sources in the system can be routed. Likewise, 
the outputs of the eight audio processing channels become sources in the system, and may 
be routed to any available destinations.

Also in this Networked mode, signals wired to the BLADE’s input connections  become 
sources in the system and can be freely routed to any available destinations, which can 
include the processing channel inputs if desired. Meanwhile, the BLADE’s output connec‑
tions become destinations to which any available system sources can be routed, including 
the processing channel outputs, if so desired.

In the Networked mode the BLADE’s inputs and outputs can be configured as mono,  
stereo, or any combination of mono and stereo required. Whether in Networked or Stand 
alone mode the audio processing channels are always stereo in and out. 

Model MADI - Multichannel Audio Digital Interface BLADE
The MADI BLADE is an access point on the WheatNet-IP Intelligent Network, con‑

verting a 64-channel MADI input to data streams on the network, and converting data 
streams to 64-channel MADI outputs.

The MADI BLADE bridges the gap between any MADI-capable audio gear or  network 
and the WheatNet-IP Intelligent Network. With the MADI BLADE, users can add-on 
to their existing infrastructure to access audio via MADI with affordable and proven 
WheatNet‑IP equipment.

The MADI BLADE makes it possible for WheatNet-TDM Bridge users to use 
WheatNet-IP control surfaces and BLADEs with their existing networks to access up to 
64 channels of audio. The added functionality and low cost of WheatNet-IP make this 
an exceptionally attractive offering. But its functionality is not limited to Wheatstone 
systems. WheatNet‑IP can now put to use audio from ANY system that utilizes MADI.

The MADI BLADE supports either copper or fiber connectivity.
A pair of 75 ohm BNC connectors are provided on the rear panel and are labeled  INPUT 

and OUTPUT. All connections should be made with a high quality 75 ohm coaxial cable 
terminated to male BNC connectors. By installing digital video grade coax, cable runs of 
200M or more can be realized.

The MADI BLADE supports an optional fiber connection to the Bridge Router. The 
MADI BLADE uses an SFP module interface with integral LC connectors. See page 1-32 
for more information on the Optical Fiber Interface.

WheatNet-IP / Mar 2014



G E N E R A L  I N F O R M A T I O N

page  1 – 14WheatNet-IP / Aug 2011 page  1 – 13a

A rear panel BNC ACTIVE or FIBER ACTIVE LED will illuminate when a MADI 
input signal is present.

This BLADE has two RJ-45 connectors to provide 12 logic ports, which can be 
individually designated during set up as inputs or outputs. These ports are where you 
wire the various external switches, indicators, and control functions you need in your 
facility.

There are two RJ-45 jacks for Ethernet. One is for 1 Gigabit Ethernet – connect 
this one to your network. The 100 Megabit Ethernet port is not used – do not connect 
anything to this port.

Consult the wiring diagram on page 1-42 for detailed information.
The unit has a standard IEC power connector. The BLADEs have an internal power 

supply that will accept 100-240 volts 50/60 hertz AC power.

Model M4IP - Microphone Processing BLADE
The M4IP Preamp BLADE is the newest member of Wheatstone’s WheatNet-IP 

Intelligent Network family. Two devices in one package, it’s a complete WheatNet-IP 
BLADE with four microphone inputs, four high quality microphone processors, and 
both digital and analog outputs.

The Wheatstone M4IP hosts four discrete, very high quality microphone processors. 
The Vorsis Embedded™ processing features of the M4IP, the processing capabilities of 
the M4IP and how to control it with the included Windows-based GUI application are 
described in the M4IP Microphone Processing BLADE technical manual.

This unit has four XLR female connectors for microphone-level inputs. 
It also has one DB-25 and eight RJ-45 connectors (the DB and analog 1-4 RJ connec‑

tions are in parallel so you can choose your preferred connector type) for audio outputs. 
Two RJ-45 connectors provide 12 logic ports, which can be individually designated 

during set up as inputs or outputs. Use these ports to wire the various external switches, 
indicators, and control functions you need in your facility.

There are two RJ-45 jacks for Ethernet. One is for 1 Gigabit Ethernet – connect 
this one to your network. The 100 Megabit Ethernet port is not used – do not connect 
anything to this port.

Consult the wiring diagram on page 1-43 for detailed information.
The unit has a standard IEC power connector. The BLADEs have an internal power 

supply that will accept 100-240 volts 50/60 hertz AC power.

WheatNet-IP / Mar 2014
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Model LIO-48 - Multiple Port Logic I/O BLADE
Wheatstone’s new LIO‑48 is a high‑density logic BLADE for the WheatNet‑IP 

 Intelligent Network that can handle all those new conditional logic functions needed for 
today’s busy studios. The LIO‑48 provides 48 universal logic I/O ports, each  individually 
configurable, for turning devices on or off by time or event, for automatically adjusting 
the audio processing settings when a certain mic turns on, and for any other logic control 
you need in your studio operation.

 The front panel of the LIO‑48 has a logic I/O meter array that lets you drill down to 
see the information for each of the 48 ports. The front panel also sports a display which 
can show various status messages relating to the BLADE’s performance and  configuration. 
A SCROLL knob, a TAKE button, and four status indicator LEDs complete the front 
panel. Refer to the LIO-48 Multiple port Logic I/O Blade technical manual for front 
panel configuration and software setup.

The rear panel has eight RJ‑45 connectors that have the connections for all 48 ports 
(each RJ‑45 has connections for six ports). Two DB‑25 female connectors duplicate 
the logic port connections. A DB‑9 female connector provides access to +5VDC from 
the BLADE. Two additional RJ‑45 connectors are stacked at the right side of the rear 
panel. The top one of there is reserved for future use, while the bottom one provides a 
1 Gigabit connection to the WheatNet‑IP network. At the far right of the rear panel is a 
standard IFC power connector. The LIO‑48 has an internal power supply that will accept 
100‑240 Volts 50/60 Hertz AC power.  

Consult the wiring diagram on page 1‑44 for detailed information.

Network Switches
The next component of the WheatNet‑IP system is your network switch(es). These 

are standard Ethernet devices that form the core of your LAN. You may already have 
a suitable one in place in your facility. There are literally hundreds of different models 
available in the market place which vary widely in size and capability, costing anywhere 
from $30 to $30,000 and up. Obviously the $30,000 switch has more features and 
capability than the $30 switch. The important thing to remember is that most Gigabit 
switches will work with WheatNet‑IP – up to a point. As the size of your system in‑
creases, it’s easy to exceed the capability of inexpensive switches. Large systems need 
high  capacity managed switches to avoid the bane of Ethernet audio systems, network 
overload. Simply put, if the WheatNet‑IP devices are streaming packets faster than the 
Ethernet switch can distribute them, packets get dropped and the audio starts to break 
up. This is why your Ethernet switches must be sized appropriately, and your network 
traffic managed and controlled so that the sizing assumptions you made remain valid. 
Because 24 bit 48K sample rate audio streams represent a much larger packet rate than 
Ethernet networks were originally assumed to contain, they can represent the vast  majority 

WheatNet-IP / May 2013WheatNet-IP / Aug 2012WheatNet-IP / Mar 2014
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of data in the network. Consequently just about any switch or link can get overloaded 
if you are streaming lots of channels and don’t attempt to manage your network and 
switch configuration. Conversely, because we use Gigabit ports for the WheatNet-IP 
to minimize link overload issues, a smaller system will run just fine on an inexpensive 
unmanaged switch, as long as it is a Gigabit switch. It’s all in the numbers. Consult the 
chapter on Ethernet considerations for more information about switches, or call us at 
Wheatstone Corporation for help with switch recommendations.

CAT-5e Wiring
The next component of your WheatNet-IP system is the CAT-5e wiring itself. Each 

“BLADE” requires a single 1 Gigabit network connection, which is typically a CAT-5e 
cable. Due to the nature of Ethernet and CAT-5e cabling, these connections must be at 
least 1 meter but less than 100 meters in length. If you must connect devices together that 
are more than 100 meters apart, use an interim Ethernet “edge” switch, or else use optical 
fiber and copper/fiber convertors to extend the range of the Ethernet LAN connections.

AoIP Driver
The next component of your system is the WheatNet-IP AoIP driver. This is software 

that will allow any Windows 2000 or XP device to send and receive audio packets as a 
member of the WheatNet-IP system. Typically, this driver would be installed on your 
Automation PCs to allow them to play back audio into the WheatNet‑IP system  without 
using a sound card. You can install the driver on any PC that you wish to get audio  
to/from. On a modern PC, the driver will allow up to eight different audio streams play‑
ing back simultaneously while accepting eight different audio input streams. That’s a 
lot of audio, representing over half of the total bandwidth available on the standard 
100 Mbit Ethernet NIC card installed in most PCs. Please note that any PC can use the 
WheatNet-IP AoIP driver; it doesn’t need to be an Automation server. If you want to 
stream your station’s Program output to the PD’s office PC, you can. Likewise, many 
modern audio devices such as codecs are really PCs at heart. If they are running Windows 
and can work with standard WDM drivers, they can most likely be directly connected 
to the WheatNet‑IP system.

Software Tools
The next components of your WheatNet‑IPs system are the software tools used to 

administer it. While the WheatNet-IP system is completely functional (unlike some 
competitors) without running any software on a PC, you will find the Navigator GUI 
program very handy for administrating normal system functions like setting access 
passwords, controlling signal visibilities, naming sources and destinations, etc. Each 
WheatNet-IP device also runs a web server, thus allowing convenient access from any 
web browser for basic set up and control. These tools are described later in this manual.

Audio Devices
Lastly are your audio devices themselves. Your loudspeakers and headphone amps, 

your microphones, CD players, and Sat receivers, your processors and codecs. These 
are the devices you’ve created your audio network for. Wire them up to the appropriate 
“BLADE” and they have instant access to all of the audio in your system. Connecting 
any source to any destination is just a simple “click” away.

WheatNet-IP / May 2013WheatNet-IP / Aug 2012WheatNet-IP / Mar 2014
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I/O Connections
All audio input and output, control, Ethernet, and power supply connections are 

made via DB-25, RJ-45, XLR, BNC connectors, and 1/4” jacks mounted on the 
WheatNet-IP rear panel. The pinout drawings on pages 1-35 through 1-44 summarize 
all wiring connections.

Model 88a

Inputs

The WheatNet‑IP 88a is fed from analog line level inputs via two DB-25 or eight 
RJ-45 connectors.

The line level analog audio inputs are +4dBu balanced. The analog line inputs 
exhibit a bridging impedance and can handle signals up to +20dBu. 

Analog 1-4 DB-25

Pin 24 – HI
Pin 12 – LO    Line 1 Lt In 
Pin 25 – SH
Pin 10 – HI
Pin 23 – LO    Line 1 Rt In
Pin 11 – SH
Pin 21 – HI
Pin   9 – LO    Line 2 Lt In
Pin 22 - SH
Pin   7 – HI
Pin 20 – LO    Line 2 Rt In
Pin   8 – SH
Pin 18 – HI
Pin   6 – LO    Line 3 Lt In
Pin  19 – SH
Pin   4 – HI
Pin 17 – LO    Line 3 Rt In
Pin   5 – SH
Pin 15 – HI
Pin   3 – LO    Line 4 Lt In 
Pin 16 – SH
Pin   1 – HI
Pin 14 – LO    Line 4 Rt In 
Pin   2 – SH
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Analog 5-8 DB-25

Pin 24 – HI
Pin 12 – LO    Line 5 Lt In 
Pin 25 – SH
Pin 10 – HI
Pin 23 – LO    Line 5 Rt In 
Pin 11 – SH
Pin 21 – HI
Pin   9 – LO    Line 6 Lt In 
Pin 22 - SH
Pin   7 – HI
Pin 20 – LO    Line 6 Rt In 
Pin   8 – SH
Pin 18 – HI
Pin   6 – LO    Line 7 Lt In 
Pin 19 – SH
Pin   4 – HI
Pin 17 – LO    Line 7 Rt In 
Pin   5 – SH
Pin 15 – HI
Pin   3 – LO    Line 8 Lt In 
Pin 16 – SH
Pin   1 – HI
Pin 14 – LO    Line 8 RT In 
Pin   2 – SH

Analog 1-8 RJ-45

RJ-45#1 Pin 1 – HI
RJ-45#1 Pin 2 – LO
RJ-45#1 Pin 3 – HI
RJ-45#1 Pin 6 – LO
RJ-45#2 Pin 1 – HI
RJ-45#2 Pin 2 – LO
RJ-45#2 Pin 3 – HI
RJ-45#2 Pin 6 – LO
RJ-45#3 Pin 1 – HI
RJ-45#3 Pin 2 – LO
RJ-45#3 Pin 3 – HI
RJ-45#3 Pin 6 – LO
RJ-45#4 Pin 1 – HI
RJ-45#4 Pin 2 – LO
RJ-45#4 Pin 3 – HI
RJ-45#4 Pin 6 – LO
RJ-45#5 Pin 1 – HI
RJ-45#5 Pin 2 – LO
RJ-45#5 Pin 3 – HI
RJ-45#5 Pin 6 – LO
RJ-45#6 Pin 1 – HI
RJ-45#6 Pin 2 – LO
RJ-45#6 Pin 3 – HI
RJ-45#6 Pin 6 – LO

Line 1 Lt In

Line 1 Rt In

Line 2 Lt In 

Line 2 Rt In

Line 3 Lt  In 

Line 3 Rt In 

Line 4 Lt In

Line 4 Rt In

Line 5 Lt In

Line 5 Rt In

Line 6 Lt In 

Line 6 Rt In 
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RJ-45#7 Pin 1 – HI
RJ-45#7 Pin 2 – LO
RJ-45#7 Pin 3 – HI
RJ-45#7 Pin 6 – LO
RJ-45#8 Pin 1 – HI
RJ-45#8 Pin 2 – LO
RJ-45#8 Pin 3 – HI
RJ-45#8 Pin 6 – LO

Outputs

The line level analog output signal is +4dBu, balanced. 
Analog 1-4 DB-25

Pin 24 – HI
Pin 12 – LO    Line 1 Lt Out
Pin 25 – SH
Pin 10 – HI
Pin 23 – LO    Line 1 Rt Out
Pin 11 – SH
Pin 21 – HI
Pin   9 – LO    Line 2 Lt Out
Pin 22 - SH
Pin   7 – HI
Pin 20 – LO    Line 2 Rt Out
Pin   8 – SH
Pin 18 – HI
Pin   6 – LO    Line 3 Lt Out
Pin 19 – SH
Pin   4 – HI
Pin 17 – LO    Line 3 Rt Out
Pin   5 – SH
Pin 15 – HI
Pin   3 – LO    Line 4 Lt Out
Pin 16 – SH
Pin   1 – HI
Pin 14 – LO    Line 4 Rt Out
Pin   2 – SH

Analog 5-8 DB-25

Pin 24 – HI
Pin 12 – LO    Line 5 Lt Out
Pin 25 – SH
Pin 10 – HI
Pin 23 – LO    Line 5 Rt Out
Pin 11 – SH
Pin 21 – HI
Pin   9 – LO    Line 6 Lt Out
Pin 22 - SH

Line 7 Lt In

Line 7 Rt In

Line 8 Lt In 

Line 8 Rt In 
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Pin   7 – HI
Pin 20 – LO    Line 6 Rt Out
Pin   8 – SH
Pin 18 – HI
Pin   6 – LO    Line 7 Lt Out
Pin  19 – SH
Pin   4 – HI
Pin 17 – LO    Line 7 Rt Out
Pin   5 – SH
Pin 15 – HI
Pin   3 – LO    Line 8 Lt Out
Pin 16 – SH
Pin   1 – HI
Pin 14 – LO    Line 8 Rt Out
Pin   2 – SH

Analog 1-8 RJ-45

RJ-45#1 Pin 1 – HI
RJ-45#1 Pin 2 – LO
RJ-45#1 Pin 3 – HI
RJ-45#1 Pin 6 – LO
RJ-45#2 Pin 1 – HI
RJ-45#2 Pin 2 – LO
RJ-45#2 Pin 3 – HI
RJ-45#2 Pin 6 – LO
RJ-45#3 Pin 1 – HI
RJ-45#3 Pin 2 – LO
RJ-45#3 Pin 3 – HI
RJ-45#3 Pin 6 – LO
RJ-45#4 Pin 1 – HI
RJ-45#4 Pin 2 – LO
RJ-45#4 Pin 3 – HI
RJ-45#4 Pin 6 – LO
RJ-45#5 Pin 1 – HI
RJ-45#5 Pin 2 – LO
RJ-45#5 Pin 3 – HI
RJ-45#5 Pin 6 – LO
RJ-45#6 Pin 1 – HI
RJ-45#6 Pin 2 – LO
RJ-45#6 Pin 3 – HI
RJ-45#6 Pin 6 – LO
RJ-45#7 Pin 1 – HI
RJ-45#7 Pin 2 – LO
RJ-45#7 Pin 3 – HI
RJ-45#7 Pin 6 – LO
RJ-45#8 Pin 1 – HI
RJ-45#8 Pin 2 – LO
RJ-45#8 Pin 3 – HI
RJ-45#8 Pin 6 – LO

Line 1 Lt Out

Line 1 Rt Out

Line 2 Lt Out

Line 2 Rt Out

Line 3 Lt Out

Line 3 Rt Out

Line 4 Lt Out

Line 4 Rt Out

Line 5 Lt Out

Line 5 Rt Out

Line 6 Lt Out

Line 6 Rt Out

Line 7 Lt Out

Line 7 Rt Out

Line 8 Lt Out

Line 8 Rt Out
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Model 88d

Inputs

The WheatNet-IP 88d is fed from digital inputs via two DB-25 or eight RJ-45 
connectors.

The WheatNet-IP 88d will accommodate digital inputs having a wide range of 
sample rates. These inputs will be sample rate converted to the system’s chosen 
sample rate of 44.1kHz or 48kHz, which is set via the WheatNet-IP Navigator 
GUI. The GUI also allows you to select input 8 of the digital BLADE, or of any 
BLADE that has a digital input as input 8, to be a primary external reference, and 
a digital input 8 from a different BLADE to be a secondary external reference. 
Please note that the sample rate of a digital input 8 should be the same, either 
44.1kHz or 48kHz, as the system’s chosen sample rate. 

AES sources are by design stereo; if the BLADE is not set to be stereo the ap-
propriate Left or Right signal within the AES stream will be applied to the signal 
path.

Digital 1-4 DB-25

Pin 24 – HI
Pin 12 – LO    AES 1 In 
Pin 25 – SH
Pin 21 – HI
Pin   9 – LO    AES 2 In
Pin 22 - SH
Pin 18 – HI
Pin   6 – LO    AES 3 In
Pin 19 – SH
Pin 15 – HI
Pin   3 – LO    AES 4 In 
Pin 16 – SH

Digital 5-8 DB-25

Pin 24 – HI
Pin 12 – LO    AES 5 In 
Pin 25 – SH
Pin 21 – HI
Pin   9 – LO    AES 6 In 
Pin 22 - SH
Pin 18 – HI
Pin   6 – LO    AES 7 In 
Pin 19 – SH
Pin 15 – HI
Pin   3 – LO    AES 8 In
Pin 16 – SH
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Digital 1-8 RJ-45

RJ-45#1 Pin 1 – HI
RJ-45#1 Pin 2 – LO
RJ-45#2 Pin 1 – HI
RJ-45#2 Pin 2 – LO
RJ-45#3 Pin 1 – HI
RJ-45#3 Pin 2 – LO
RJ-45#4 Pin 1 – HI
RJ-45#4 Pin 2 – LO
RJ-45#5 Pin 1 – HI
RJ-45#5 Pin 2 – LO
RJ-45#6 Pin 1 – HI
RJ-45#6 Pin 2 – LO
RJ-45#7 Pin 1 – HI
RJ-45#7 Pin 2 – LO
RJ-45#8 Pin 1 – HI
RJ-45#8 Pin 2 – LO

Outputs

Digital 1-4 DB-25

Pin 24 – HI
Pin 12 – LO    AES 1 Out
Pin 25 – SH
Pin 21 – HI
Pin   9 – LO    AES 2 Out
Pin 22 - SH
Pin 18 – HI
Pin   6 – LO    AES 3 Out
Pin 19 – SH
Pin 15 – HI
Pin   3 – LO    AES 4 Out
Pin 16 – SH

Digital 5-8 DB-25

Pin 24 – HI
Pin 12 – LO    AES 5 Out
Pin 25 – SH
Pin 21 – HI
Pin   9 – LO    AES 6 Out
Pin 22 - SH
Pin 18 – HI
Pin   6 – LO    AES 7 Out 
Pin 19 – SH
Pin 15 – HI
Pin   3 – LO    AES 8 Out
Pin 16 – SH

AES 4 In

AES 5 In

AES 6 In

AES 7 In

AES 8 In

AES 1 In

AES 2 In

AES 3 In
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Digital 1-8 RJ-45

RJ-45#1 Pin 1 – HI
RJ-45#1 Pin 2 – LO
RJ-45#2 Pin 1 – HI
RJ-45#2 Pin 2 – LO
RJ-45#3 Pin 1 – HI
RJ-45#3 Pin 2 – LO
RJ-45#4 Pin 1 – HI
RJ-45#4 Pin 2 – LO
RJ-45#5 Pin 1 – HI
RJ-45#5 Pin 2 – LO
RJ-45#6 Pin 1 – HI
RJ-45#6 Pin 2 – LO
RJ-45#7 Pin 1 – HI
RJ-45#7 Pin 2 – LO
RJ-45#8 Pin 1 – HI
RJ-45#8 Pin 2 – LO

Model 88ad

Inputs

The WheatNet-IP 88ad is fed from a combination of analog and digital inputs 
via two DB-25 or eight RJ-45 connectors.

The digital inputs of the WheatNet-IP 88ad (inputs 5-8) will accommodate 
digital inputs having a wide range of sample rates. These inputs will be sample 
rate converted to the system’s chosen sample rate of 44.1kHz or 48kHz, which is 
set via the WheatNet-IP Navigator GUI. The GUI also allows you to select input 
8 of the digital BLADE, or of any BLADE that has a digital input as input 8, to be 
a primary external reference, and a digital input 8 from a different BLADE to be a 
secondary external reference. Please note that the sample rate of a digital input 8 
should be the same, either 44.1kHz or 48kHz, as the system’s chosen sample rate. 

AES sources are by design stereo; if the BLADE is not set to be stereo the 
appropriate Left or Right signal within the AES stream will be applied to the 
signal path.

Analog 1-4 DB-25

Pin 24 – HI
Pin 12 – LO    Line 1 Lt In 
Pin 25 – SH
Pin 10 – HI
Pin 23 – LO    Line 1 Rt In
Pin 11 – SH

AES 4 Out

AES 5 Out

AES 6 Out

AES 7 Out

AES 8 Out

AES 1 Out

AES 2 Out

AES 3 Out
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Pin 21 – HI
Pin   9 – LO    Line 2 Lt In
Pin 22 - SH
Pin   7 – HI
Pin 20 – LO    Line 2 Rt In
Pin   8 – SH
Pin 18 – HI
Pin   6 – LO    Line 3 Lt In
Pin 19 – SH
Pin   4 – HI
Pin 17 – LO    Line 3 Rt In
Pin   5 – SH
Pin 15 – HI
Pin   3 – LO    Line 4 Lt In 
Pin 16 – SH
Pin   1 – HI
Pin 14 – LO    Line 4 Rt In 
Pin   2 – SH

Digital 5-8 DB-25

Pin 24 – HI
Pin 12 – LO    AES 5 In 
Pin 25 – SH
Pin 21 – HI
Pin   9 – LO    AES 6 In 
Pin 22 - SH
Pin 18 – HI
Pin   6 – LO    AES 7 In 
Pin  19 – SH
Pin 15 – HI
Pin   3 – LO    AES 8 In
Pin 16 – SH

Analog 1-4 RJ-45

RJ-45#1 Pin 1 – HI
RJ-45#1 Pin 2 – LO
RJ-45#1 Pin 3 – HI
RJ-45#1 Pin 6 – LO
RJ-45#2 Pin 1 – HI
RJ-45#2 Pin 2 – LO
RJ-45#2 Pin 3 – HI
RJ-45#2 Pin 6 – LO
RJ-45#3 Pin 1 – HI
RJ-45#3 Pin 2 – LO
RJ-45#3 Pin 3 – HI
RJ-45#3 Pin 6 – LO
RJ-45#4 Pin 1 – HI
RJ-45#4 Pin 2 – LO
RJ-45#4 Pin 3 – HI
RJ-45#4 Pin 6 – LO

Line 1 Lt In

Line 1 Rt In

Line 2 Lt In 

Line 2 Rt In

Line 3 Lt  In 

Line 3 Rt In 

Line 4 Lt In

Line 4 Rt In
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Digital 5-8 RJ-45

RJ-45#5 Pin 1 – HI
RJ-45#5 Pin 2 – LO
RJ-45#6 Pin 1 – HI
RJ-45#6 Pin 2 – LO
RJ-45#7 Pin 1 – HI
RJ-45#7 Pin 2 – LO
RJ-45#8 Pin 1 – HI
RJ-45#8 Pin 2 – LO

Outputs

Analog 1-4 DB-25

Pin 24 – HI
Pin 12 – LO    Line 1 Lt Out
Pin 25 – SH
Pin 10 – HI
Pin 23 – LO    Line 1 Rt Out
Pin 11 – SH
Pin 21 – HI
Pin   9 – LO    Line 2 Lt Out
Pin 22 - SH
Pin   7 – HI
Pin 20 – LO    Line 2 Rt Out
Pin   8 – SH
Pin 18 – HI
Pin   6 – LO    Line 3 Lt Out
Pin 19 – SH
Pin   4 – HI
Pin 17 – LO    Line 3 Rt Out
Pin   5 – SH
Pin 15 – HI
Pin   3 – LO    Line 4 Lt Out
Pin 16 – SH
Pin   1 – HI
Pin 14 – LO    Line 4 Rt Out
Pin   2 – SH

Digital 5-8 DB-25

Pin 24 – HI
Pin 12 – LO    AES 5 Out
Pin 25 – SH
Pin 21 – HI
Pin   9 – LO    AES 6 Out
Pin 22 - SH
Pin 18 – HI
Pin   6 – LO    AES 7 Out
Pin  19 – SH
Pin 15 – HI
Pin   3 – LO    AES 8 Out
Pin 16 – SH

AES 5 In

AES 6 In

AES 7 In

AES 8 In 
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Analog 1-4 RJ-45

RJ-45#1 Pin 1 – HI
RJ-45#1 Pin 2 – LO
RJ-45#1 Pin 3 – HI
RJ-45#1 Pin 6 – LO
RJ-45#2 Pin 1 – HI
RJ-45#2 Pin 2 – LO
RJ-45#2 Pin 3 – HI
RJ-45#2 Pin 6 – LO
RJ-45#3 Pin 1 – HI
RJ-45#3 Pin 2 – LO
RJ-45#3 Pin 3 – HI
RJ-45#3 Pin 6 – LO
RJ-45#4 Pin 1 – HI
RJ-45#4 Pin 2 – LO
RJ-45#4 Pin 3 – HI
RJ-45#4 Pin 6 – LO

Digital 5-8 RJ-45

RJ-45#5 Pin 1 – HI
RJ-45#5 Pin 2 – LO
RJ-45#6 Pin 1 – HI
RJ-45#6 Pin 2 – LO
RJ-45#7 Pin 1 – HI
RJ-45#7 Pin 2 – LO
RJ-45#8 Pin 1 – HI
RJ-45#8 Pin 2 – LO

Model 88m

Inputs

The WheatNet-IP 88m analog mono mic level input (-50dBu nominal) is fed 
from the female XLR connector to the internal microphone preamplifier. The mic 
preamp has digitally controlled gain, up to a maximum of 70 dB, and displays 
remarkably high performance and accuracy. Phantom power is available. 

Analog 1-8 XLR

XLR#1 Pin 1 – SH
XLR#1 Pin 2 – HI        Mic 1 In 
XLR#1 Pin 3 – LO
XLR#2 Pin 1 – SH
XLR#2 Pin 2 – HI        Mic 2 In 
XLR#2 Pin 3 – LO
XLR#3 Pin 1 – SH
XLR#3 Pin 2 – HI        Mic 3 In
XLR#3 Pin 3 – LO

Line 1 Lt Out

Line 1 Rt Out

Line 2 Lt Out

Line 2 Rt Out

Line 3 Lt Out

Line 3 Rt Out

Line 4 Lt Out

Line 4 Rt Out

AES 5 Out

AES 6 Out

AES 7 Out

AES 8 Out
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XLR#4 Pin 1 – SH
XLR#4 Pin 2 – HI       Mic 4 In
XLR#4 Pin 3 – LO
XLR#5 Pin 1 – SH
XLR#5 Pin 2 – HI        Mic 5 In
XLR#5 Pin 3 – LO
XLR#6 Pin 1 – SH
XLR#6 Pin 2 – HI        Mic 6 In
XLR#6 Pin 3 – LO
XLR#7 Pin 1 – SH
XLR#7 Pin 2 – HI        Mic 7 In
XLR#7 Pin 3 – LO
XLR#8 Pin 1 – SH
XLR#8 Pin 2 – HI        Mic 8 In
XLR#8 Pin 3 – LO

Outputs

The output signals are available as analog line level (+4dBu, balanced) or mono 
mic level (-50dBu) on the DB-25 connector, or on the four RJ-45 (#1 through #4) 
connectors. 
Analog 1-4 DB-25

Pin 24 – HI
Pin 12 – LO     Line 1 Lt Out
Pin 25 – SH
Pin 10 – HI
Pin 23 – LO     Line 1 Rt Out
Pin 11 – SH
Pin 21 – HI
Pin   9 – LO     Line 2 Lt Out
Pin 22 - SH
Pin   7 – HI
Pin 20 – LO     Line 2 Rt Out
Pin   8 – SH
Pin 18 – HI
Pin   6 – LO     Line 3 Lt Out
Pin 19 – SH
Pin   4 – HI
Pin 17 – LO     Line 3 Rt Out
Pin   5 – SH
Pin 15 – HI
Pin   3 – LO     Line 4 Lt Out
Pin 16 – SH
Pin   1 – HI
Pin 14 – LO     Line 4 Rt Out
Pin   2 – SH

Analog 1-8 RJ-45

RJ-45#1 Pin 1 – HI
RJ-45#1 Pin 2 – LO
RJ-45#1 Pin 3 – HI
RJ-45#1 Pin 6 – LO

Line 1 Lt Out

Line 1 Rt Out
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RJ-45#2 Pin 1 – HI
RJ-45#2 Pin 2 – LO
RJ-45#2 Pin 3 – HI
RJ-45#2 Pin 6 – LO
RJ-45#3 Pin 1 – HI
RJ-45#3 Pin 2 – LO
RJ-45#3 Pin 3 – HI
RJ-45#3 Pin 6 – LO
RJ-45#4 Pin 1 – HI
RJ-45#4 Pin 2 – LO
RJ-45#4 Pin 3 – HI
RJ-45#4 Pin 6 – LO

Model 88cb, 88cbe

Inputs

The WheatNet-IP 88cb and 88cbe console BLADEs can be fed from three different 
types of inputs: microphone, analog line level, and AES-3 digital.

When processing mic level (-50dBu nominal) inputs, the input to the internal micro-
phone preamplifiers is fed from one of the two female XLR connectors. When using the 
internal microphone preamplifiers, a jumper must be connected from the MIC OUTS 
RJ-45 to a selected Analog input (1-4). The mic preamp has digitally controlled gain, 
up to a maximum of 70dB, and displays remarkably high performance and accuracy. 
Phantom power is available via recessed rear panel switches. 

Four RJ-45 connectors can be used for analog line level inputs. The line level analog 
audio inputs are +4dBu balanced. The analog line inputs exhibit a bridging impedance 
and can handle signals up to +20dBu. 

To handle digital line level sources there are also four RJ-45 connectors. 
The digital inputs of the WheatNet-IP 88cb and 88cbe (inputs 5-8) will accommo-

date digital inputs having a wide range of sample rates. These inputs will be sample rate 
converted to the system’s chosen sample rate of 44.1kHz or 48kHz, which is set via the 
WheatNet-IP Navigator GUI. The GUI also allows you to select input 8 of the digital 
BLADE, or of any BLADE that has a digital input as input 8, to be a primary external 
reference, and a digital input 8 from a different BLADE to be a secondary external ref-
erence. Please note that the sample rate of a digital input 8 should be the same, either 
44.1kHz or 48kHz, as the system’s chosen sample rate. 

AES sources are by design stereo; if the BLADE is not set to be stereo the appropri-
ate Left or Right signal within the AES stream will be applied to the signal path.

MIC IN XLR

XLR#1 Pin 1 – SH
XLR#1 Pin 2 – HI        Mic 1 In 
XLR#1 Pin 3 – LO

Line 2 Lt Out

Line 2 Rt Out

Line 3 Lt Out

Line 3 Rt Out

Line 4 Lt Out

Line 4 Rt Out
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XLR#2 Pin 1 – SH
XLR#2 Pin 2 – HI         Mic 2 In 
XLR#2 Pin 3 – LO

Analog 1-4 RJ-45

RJ-45#1 Pin 1 – HI
RJ-45#1 Pin 2 – LO
RJ-45#1 Pin 3 – HI
RJ-45#1 Pin 6 – LO
RJ-45#2 Pin 1 – HI
RJ-45#2 Pin 2 – LO
RJ-45#2 Pin 3 – HI
RJ-45#2 Pin 6 – LO
RJ-45#3 Pin 1 – HI
RJ-45#3 Pin 2 – LO
RJ-45#3 Pin 3 – HI
RJ-45#3 Pin 6 – LO
RJ-45#4 Pin 1 – HI
RJ-45#4 Pin 2 – LO
RJ-45#4 Pin 3 – HI
RJ-45#4 Pin 6 – LO

Digital 5-8 RJ-45

RJ-45#5 Pin 1 – HI
RJ-45#5 Pin 2 – LO
RJ-45#6 Pin 1 – HI
RJ-45#6 Pin 2 – LO
RJ-45#7 Pin 1 – HI
RJ-45#7 Pin 2 – LO
RJ-45#8 Pin 1 – HI
RJ-45#8 Pin 2 – LO

Outputs

The WheatNet-IP 88cb and 88cbe provide four stereo analog outputs on RJ-45 conec-
tors, four digital AES formatted outputs on RJ-45 connectors, cue and headphone outputs 
on RJ-45 connector and on 1/4” jacks, and control room and studio monitor outputs on 
XLR male connectors.

MIC OUTS RJ-45

RJ-45 Pin 1 – HI
RJ-45 Pin 2 – LO
RJ-45 Pin 3 – HI
RJ-45 Pin 6 – LO

CUE/HDPN OUT RJ-45

RJ-45 Pin 1 – HI
RJ-45 Pin 2 – LO
RJ-45 Pin 3 – HI
RJ-45 Pin 6 – LO

Line 1 Lt In

Line 1 Rt In

Line 3 Lt In

Line 3 Rt In

Line 2 Lt In

Line 2 Rt In

Line 4 Lt In

Line 4 Rt In

AES 5 In

AES 6 In

AES 7 In

AES 8 In

Mic 1 Out

Mic 2 Out

When using the microphone 
preamplifiers, a jumper must 
be connected from the MIC 
OUTS to the desired analog 
input port (1-4).

HDPN Lt Out

HDPN Rt Out
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RJ-45 Pin 4 – HI
RJ-45 Pin 5 – LO
RJ-45 Pin 7 – HI
RJ-45 Pin 8 – LO

STUDIO OUT XLR

XLR#1 Pin 1 – SH
XLR#1 Pin 2 – HI       Studio Lt Out
XLR#1 Pin 3 – LO
XLR#2 Pin 1 – SH
XLR#2 Pin 2 – HI       Studio Rt Out
XLR#2 Pin 3 – LO

CR OUT XLR

XLR#1 Pin 1 – SH
XLR#1 Pin 2 – HI        CR Lt Out
XLR#1 Pin 3 – LO
XLR#2 Pin 1 – SH
XLR#2 Pin 2 – HI        CR Rt Out
XLR#2 Pin 3 – LO

PGM OUT ANALOG RJ-45

RJ-45 A Pin 1 – HI
RJ-45 A Pin 2 – LO
RJ-45 A Pin 3 – HI
RJ-45 A Pin 6 – LO
RJ-45 B Pin 1 – HI
RJ-45 B Pin 2 – LO
RJ-45 B Pin 3 – HI
RJ-45 B Pin 6 – LO
RJ-45 C Pin 1 – HI
RJ-45 C Pin 2 – LO
RJ-45 C Pin 3 – HI
RJ-45 C Pin 6 – LO
RJ-45 D Pin 1 – HI
RJ-45 D Pin 2 – LO
RJ-45 D Pin 3 – HI
RJ-45 D Pin 6 – LO

PGM OUT DIGITAL RJ-45

RJ-45 A Pin 1 – HI
RJ-45 A Pin 2 – LO
RJ-45 B Pin 1 – HI
RJ-45 B Pin 2 – LO
RJ-45 C Pin 1 – HI
RJ-45 C Pin 2 – LO
RJ-45 D Pin 1 – HI
RJ-45 D Pin 2 – LO

Cue Lt Out

Cue Rt Out

PGM B Lt Out

PGM B Rt Out

PGM C Lt Out

PGM C Rt Out

PGM D Lt Out

PGM D Rt Out

PGM A Lt Out

PGM A Rt Out

PGM AES A Out

PGM AES B Out

PGM AES C Out

PGM AES D Out
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Model Aura8ip

Inputs

The WheatNet-IP Aura8ip is fed from a combination of analog and digital inputs 
via two DB-25 or eight RJ-45 connectors.

The WheatNet-IP Aura8ip will accommodate digital inputs having a wide range 
of sample rates. These inputs will be sample rate converted to the system’s chosen 
sample rate of 44.1kHz or 48kHz, which is set via the WheatNet-IP Navigator GUI. 
The GUI also allows you to select input 8 of the digital BLADE, or of any BLADE 
that has a digital input as input 8, to be a primary external reference, and a digital 
input 8 from a different BLADE to be a secondary external reference. Please note 
that the sample rate of a digital input 8 should be the same, either 44.1kHz or 48kHz, 
as the system’s chosen sample rate. If you are using the Aura8ip in a stand-alone 
application, one involving no other BLADEs, and if the outputs from Aura8ip must 
be synchronized to downstream digital equipment, you must use input 8 for your 
external reference, even if you are not using all 8 inputs.

AES sources are by design stereo; if the BLADE is not set to be stereo the appro-
priate Left or Right signal within the AES stream will be applied to the signal path.

Analog 1-4 DB-25

Pin 24 – HI
Pin 12 – LO    Line 1 Lt In 
Pin 25 – SH
Pin 10 – HI
Pin 23 – LO    Line 1 Rt In
Pin 11 – SH
Pin 21 – HI
Pin   9 – LO    Line 2 Lt In
Pin 22 - SH
Pin   7 – HI
Pin 20 – LO    Line 2 Rt In
Pin   8 – SH
Pin 18 – HI
Pin   6 – LO    Line 3 Lt In
Pin 19 – SH
Pin   4 – HI
Pin 17 – LO    Line 3 Rt In
Pin   5 – SH
Pin 15 – HI
Pin   3 – LO    Line 4 Lt In 
Pin 16 – SH
Pin   1 – HI
Pin 14 – LO    Line 4 Rt In 
Pin   2 – SH
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Digital 5-8 DB-25

Pin 24 – HI
Pin 12 – LO    AES 5 In 
Pin 25 – SH
Pin 21 – HI
Pin   9 – LO    AES 6 In 
Pin 22 - SH
Pin 18 – HI
Pin   6 – LO    AES 7 In 
Pin  19 – SH
Pin 15 – HI
Pin   3 – LO    AES 8 In
Pin 16 – SH

Analog 1-4 RJ-45

RJ-45#1 Pin 1 – HI
RJ-45#1 Pin 2 – LO
RJ-45#1 Pin 3 – HI
RJ-45#1 Pin 6 – LO
RJ-45#2 Pin 1 – HI
RJ-45#2 Pin 2 – LO
RJ-45#2 Pin 3 – HI
RJ-45#2 Pin 6 – LO
RJ-45#3 Pin 1 – HI
RJ-45#3 Pin 2 – LO
RJ-45#3 Pin 3 – HI
RJ-45#3 Pin 6 – LO
RJ-45#4 Pin 1 – HI
RJ-45#4 Pin 2 – LO
RJ-45#4 Pin 3 – HI
RJ-45#4 Pin 6 – LO

Digital 5-8 RJ-45

RJ-45#5 Pin 1 – HI
RJ-45#5 Pin 2 – LO
RJ-45#6 Pin 1 – HI
RJ-45#6 Pin 2 – LO
RJ-45#7 Pin 1 – HI
RJ-45#7 Pin 2 – LO
RJ-45#8 Pin 1 – HI
RJ-45#8 Pin 2 – LO

Outputs

Analog 1-4 DB-25

Pin 24 – HI
Pin 12 – LO    Line 1 Lt Out
Pin 25 – SH
Pin 10 – HI
Pin 23 – LO    Line 1 Rt Out
Pin 11 – SH

Line 1 Lt In

Line 1 Rt In

Line 2 Lt In 

Line 2 Rt In

Line 3 Lt  In 

Line 3 Rt In 

Line 4 Lt In

Line 4 Rt In

AES 5 In

AES 6 In

AES 7 In

AES 8 In 
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Pin 21 – HI
Pin   9 – LO    Line 2 Lt Out
Pin 22 - SH
Pin   7 – HI
Pin 20 – LO    Line 2 Rt Out
Pin   8 – SH
Pin 18 – HI
Pin   6 – LO    Line 3 Lt Out
Pin 19 – SH
Pin   4 – HI
Pin 17 – LO    Line 3 Rt Out
Pin   5 – SH
Pin 15 – HI
Pin   3 – LO    Line 4 Lt Out
Pin 16 – SH
Pin   1 – HI
Pin 14 – LO    Line 4 Rt Out
Pin   2 – SH

Digital 5-8 DB-25

Pin 24 – HI
Pin 12 – LO    AES 5 Out
Pin 25 – SH
Pin 21 – HI
Pin   9 – LO    AES 6 Out
Pin 22 - SH
Pin 18 – HI
Pin   6 – LO    AES 7 Out
Pin  19 – SH
Pin 15 – HI
Pin   3 – LO    AES 8 Out
Pin 16 – SH

Analog 1-4 RJ-45

RJ-45#1 Pin 1 – HI
RJ-45#1 Pin 2 – LO
RJ-45#1 Pin 3 – HI
RJ-45#1 Pin 6 – LO
RJ-45#2 Pin 1 – HI
RJ-45#2 Pin 2 – LO
RJ-45#2 Pin 3 – HI
RJ-45#2 Pin 6 – LO
RJ-45#3 Pin 1 – HI
RJ-45#3 Pin 2 – LO
RJ-45#3 Pin 3 – HI
RJ-45#3 Pin 6 – LO
RJ-45#4 Pin 1 – HI
RJ-45#4 Pin 2 – LO
RJ-45#4 Pin 3 – HI
RJ-45#4 Pin 6 – LO

Line 1 Lt Out

Line 1 Rt Out

Line 3 Lt Out

Line 3 Rt Out

Line 4 Lt Out

Line 4 Rt Out
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Digital 5-8 RJ-45

RJ-45#5 Pin 1 – HI
RJ-45#5 Pin 2 – LO
RJ-45#6 Pin 1 – HI
RJ-45#6 Pin 2 – LO
RJ-45#7 Pin 1 – HI
RJ-45#7 Pin 2 – LO
RJ-45#8 Pin 1 – HI
RJ-45#8 Pin 2 – LO

Model MADI

Digital Audio Connections

A pair of 75 ohm BNC connectors are provided on the rear panel for input and output 
connections. All connections should be made with a high quality 75 ohm coaxial cable 
terminated to male BNC connectors. By installing digital video grade coax, cable runs 
of 200M or more can be realized.

BNC IN Pin 1 – HI
BNC IN Pin 2 – SH
BNC OUT Pin 1 – HI
BNC OUT Pin 2 – SH

Optical Fiber Interface

The MADI BLADE supports an optional fiber connection to the 
Bridge Router. The MADI BLADE uses an SFP module interface with 
integral LC connectors.  

Note that the QOT-2001 rear panel on the Bridge router uses SC 
connectors, so to connect to a Bridge MADI card a patch cable fitted 
with LC connectors on one end and SC connectors on the other 
end is required.
Optical Transceiver

Optical Transceivers convert physical signals from elec-
trical to optical (and vice-versa) in a network and couple the 
optical signals into (and out of) optical fiber. Small form factor 
pluggable (SFP) transceivers, used in the MADI BLADE, are 
designed to be hot-swappable in industry standard cages and 
connectors (for easy field repair), and offer high speed and 
physical compactness. 

AES 5 Out

AES 6 Out

AES 7 Out

AES 8 Out

AES In

AES Out

Optical Transceiver
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Connector Type

The high-density LC Duplex connector has a tabbed 
 locking mechanism similar to what you would find on a phone 
jack. This enables secure connectivity and easy removal.

The SC (subscription channel) Duplex connector is a low 
insertion loss connector using a push/pull locking mechanism.
Optical Fiber Cable

The SC-LC optical fiber cable required in this  application 
is a multimode duplex fiber optic patch cable with a core/clad-
ding size 62.5/125 micron suitable for low-to-moderate-speed 
data links (≤100Mbps). The following Fiber  Instrument Sales, 
Inc. part number X2YLM3FISC may be used to reference 
the physical characteristics of the required cable assembly. 
The full-duplex nature of the audio network interface requires 
one fiber for transmit, and one for receive; hence dual zip cables are recommended. 

Optical fiber cables are manufactured with a variety of jacket materials, which 
directly affect cable cost, including Thermoplastic Elastomer (TPE), Kynar® and 
Teflon® FEP. Physical properties of the jacket material determine a cable’s resistance 
to abrasions, flame retardancy, etc. Check local codes to be sure the cable you plan 
on using is compliant in your application.

Model M4IP

Inputs

The M4IP analog mono mic level input (-50dBu nominal) is fed from the fe-
male XLR connector to the internal microphone preamplifier. The mic preamp has 
digitally controlled gain, up to a maximum of 70 dB, and displays remarkably high 
performance and accuracy. Phantom power is available. 

Analog 1-4 XLR

XLR#1 Pin 1 – SH
XLR#1 Pin 2 – HI        Mic 1 In 
XLR#1 Pin 3 – LO
XLR#2 Pin 1 – SH
XLR#2 Pin 2 – HI        Mic 2 In 
XLR#2 Pin 3 – LO
XLR#3 Pin 1 – SH
XLR#3 Pin 2 – HI        Mic 3 In
XLR#3 Pin 3 – LO
XLR#4 Pin 1 – SH
XLR#4 Pin 2 – HI       Mic 4 In
XLR#4 Pin 3 – LO

Optical Fiber Cable
Surface End

LC 
Bridge End

SC 
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Outputs

The output signals are available as analog line level (+4dBu, balanced) on the 
DB‑25 connector, or on the four RJ‑45 (#1 through #4) connectors, and as four digital 
AES formatted outputs on the RJ‑45 (#5 through #8) connectors. 
Analog 1-4 DB-25

Pin 24 – HI
Pin 12 – LO     Line 1 Lt Out
Pin 25 – SH
Pin 10 – HI
Pin 23 – LO     Line 1 Rt Out
Pin 11 – SH
Pin 21 – HI
Pin   9 – LO     Line 2 Lt Out
Pin 22 ‑ SH
Pin   7 – HI
Pin 20 – LO     Line 2 Rt Out
Pin   8 – SH
Pin 18 – HI
Pin   6 – LO     Line 3 Lt Out
Pin 19 – SH
Pin   4 – HI
Pin 17 – LO     Line 3 Rt Out
Pin   5 – SH
Pin 15 – HI
Pin   3 – LO     Line 4 Lt Out
Pin 16 – SH
Pin   1 – HI
Pin 14 – LO     Line 4 Rt Out
Pin   2 – SH

Analog 1-4 RJ-45

RJ‑45#1 Pin 1 – HI
RJ‑45#1 Pin 2 – LO
RJ‑45#1 Pin 3 – HI
RJ‑45#1 Pin 6 – LO
RJ‑45#2 Pin 1 – HI
RJ‑45#2 Pin 2 – LO
RJ‑45#2 Pin 3 – HI
RJ‑45#2 Pin 6 – LO
RJ‑45#3 Pin 1 – HI
RJ‑45#3 Pin 2 – LO
RJ‑45#3 Pin 3 – HI
RJ‑45#3 Pin 6 – LO
RJ‑45#4 Pin 1 – HI
RJ‑45#4 Pin 2 – LO
RJ‑45#4 Pin 3 – HI
RJ‑45#4 Pin 6 – LO

Line 1 Lt Out

Line 1 Rt Out

Line 3 Lt Out

Line 3 Rt Out

Line 4 Lt Out

Line 4 Rt Out

Line 2 Lt Out

Line 2 Rt Out
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Digital 5-8 RJ-45

RJ‑45#5 Pin 1 – HI
RJ‑45#5 Pin 2 – LO
RJ‑45#6 Pin 1 – HI
RJ‑45#6 Pin 2 – LO
RJ‑45#7 Pin 1 – HI
RJ‑45#7 Pin 2 – LO
RJ‑45#8 Pin 1 – HI
RJ‑45#8 Pin 2 – LO

Logic Ports - All Models (except LIO-48)
All models, with exception of the LIO‑48, have two LOGIC I/O RJ‑45 connectors 

that provide 12 Universal logic ports.
LOGIC I/O 1 - 6 RJ-45

RJ‑45 Pin 1 – Digital Ground
RJ‑45 Pin 2 – Logic 1 In/Out
RJ‑45 Pin 3 – Logic 2 In/Out
RJ‑45 Pin 4 – Logic 3 In/Out
RJ‑45 Pin 5 – Logic 4 In/Out
RJ‑45 Pin 6 – Logic 5 In/Out
RJ‑45 Pin 7 – Logic 6 In/Out
RJ‑45 Pin 8 – +5V Digital

LOGIC I/O 7 - 12 RJ-45

RJ‑45 Pin 1 – Digital Ground
RJ‑45 Pin 2 – Logic 7 In/Out
RJ‑45 Pin 3 – Logic 8 In/Out
RJ‑45 Pin 4 – Logic 9 In/Out
RJ‑45 Pin 5 – Logic 10 In/Out
RJ‑45 Pin 6 – Logic 11 In/Out
RJ‑45 Pin 7 – Logic 12 In/Out
RJ‑45 Pin 8 – +5V Digital 

LIO-48 Logic Ports

The rear panel has eight RJ‑45 connectors that have the connections for all 48 ports 
(each RJ‑45 has connections for six ports). Two DB‑25 female connectors duplicate 
the logic port connections. A DB‑9 female connector provides access to +5VDC from 
the BLADE.

LOGIC I/O “A” RJ-45

RJ‑45 Pin 1 – Digital Ground
RJ‑45 Pin 2 – Logic 1 In/Out
RJ‑45 Pin 3 – Logic 2 In/Out

AES 5 Out

AES 6 Out

AES 7 Out

AES 8 Out 

WheatNet-IP / Mar 2014
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RJ-45 Pin 4 – Logic 3 In/Out
RJ-45 Pin 5 – Logic 4 In/Out
RJ-45 Pin 6 – Logic 5 In/Out
RJ-45 Pin 7 – Logic 6 In/Out
RJ-45 Pin 8 – +5V Digital

All “LOGIC RJ PORTS” connectors wired in same manner as the “A” connector 
shown above.

LOGIC I/O “1 - 24” DB-25

Pin 1 – Logic 1 In/Out
Pin 2 – Logic 2 In/Out
Pin 3 – Logic 3 In/Out
Pin 4 – Logic 4 In/Out
Pin 5 – Logic 5 In/Out
Pin 6 – Logic 6 In/Out
Pin 7 – Logic 7 In/Out
Pin 8 – Logic 8 In/Out
Pin 9 – Logic 9 In/Out
Pin 10 – Logic 10 In/Out
Pin 11 – Logic 11 In/Out
Pin 12 – Logic 12 In/Out
Pin 13 – Logic 13 In/Out
Pin 14 – Logic 14 In/Out
Pin 15 – Logic 15 In/Out
Pin 16 – Logic 16 In/Out
Pin 17 – Logic 17 In/Out
Pin 18 – Logic 18 In/Out
Pin 19 – Logic 19 In/Out
Pin 20 – Logic 20 In/Out
Pin 21 – Logic 21 In/Out
Pin 22 – Logic 22 In/Out
Pin 23 – Logic 23 In/Out
Pin 24 – Logic 24 In/Out
Pin 25 – Digital Ground

The “25-48” DB-25 connector wired in same manner as the “A” connector shown above.
+5VDC LOGIC DB-9

Pin 1 – +5V Logic 1
Pin 2 – +5V Logic 2
Pin 3 – +5V Logic 3
Pin 4 – +5V Logic 4
Pin 5 – +5V Logic 5
Pin 6 – +5V Logic 6
Pin 7 – +5V Logic 7
Pin 8 – +5V Logic 8
Pin 9 – Digital Ground

WheatNet-IP / May 2013WheatNet-IP / Mar 2014
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Simplified Blade Logic I/O

Input Logic

Logic Inputs are activated when the input pin is pulled to DGND.

Output Logic

Logic Ouput ports are pulled to DGND when activated.

WheatNet-IP / Feb 2013

X

1

LOGIC OUTPUT
OUTPUT

PIN
EXTERNAL

DEVICE

DGND

BLADE LIO PORT

8 +5VDC

CONTROL
START

GND

OPTO ISOLATED
EXTERNAL DEVICE

V+

START
X

OR

LOGIC OUTPUT

DGND

Output Port Specs

Sink:  • 50mA nom
 • 100mA max

X

1

LOGIC
INPUT

INPUT
PIN

EXTERNAL
CLOSURE

DGND

BLADE LIO PORT

Input Port Specs

• Internally current limited
• No pull up required

BU
U WRJ-45

LIO 1
CT7

COLOR CODES
T568A T568B

WHT/GRN WHT/ORG GNDC1
C2
C3
C4

C5
C6

C7
C8

GRN ORG LIO_RJ_1
WHT/ORG WHT/GRN LIO_RJ_2

BL LU LIO_RJ_3
WHT/BL HT/BLU LIO_RJ_4

ORG GRN LIO_RJ_5
WHT/BRN WHT/BRN LIO_RJ_6

BRN BRN LIO1 +5V
TOP

WheatNet-IP / May 2013WheatNet-IP / Mar 2014
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NOTE: DB-25 audio connections and RJ-45 audio connections are paralleled. Either may be used.

ANALOG INPUTS

LINE 1 LT IN HI

LINE 1 RT IN LO

LINE 2 LT IN HI

LINE 2 RT IN LO

LINE 3 LT IN SH

LINE 3 LT IN HI

LINE 3 RT IN LO

LINE 4 LT IN SH

LINE 4 LT IN HI

LINE 4 RT IN LO

AUDIO GROUND

LINE 1 LT IN LO

LINE 1 RT IN SH

LINE 1 RT IN HI

LINE 2 LT IN LO

LINE 2 RT IN SH

LINE 2 RT IN HI

LINE 3 LT IN LO

LINE 3 RT IN SH

LINE 3 RT IN HI

LINE 4 LT IN LO

LINE 4 RT IN SH

LINE 4 RT IN HI

5

4

3

2

1

17

16
15

14

8

7

6

20

19

18

10

9

23

22

21

13
12

11

25

24

LINE 1 LT IN SH

LINE 2 LT IN SH

1- 4 DB-25

LINE 5 LT IN HI

LINE 5 RT IN LO

LINE 6 LT IN HI

LINE 6 RT IN LO

LINE 7 LT IN SH

LINE 7 LT IN HI

LINE 7 RT IN LO

LINE 8 LT IN SH

LINE 8 LT IN HI

LINE 8 RT IN LO

AUDIO GROUND

LINE 5 LT IN LO

LINE 5 RT IN SH

LINE 5 RT IN HI

LINE 6 LT IN LO

LINE 6 RT IN SH

LINE 6 RT IN HI

LINE 7 LT IN LO

LINE 7 RT IN SH

LINE 7 RT IN HI

LINE 8 LT IN LO

LINE 8 RT IN SH

LINE 8 RT IN HI

5

4

3

2

1

17

16
15

14

8

7

6

20

19

18

10

9

23

22

21

13
12

11

25

24

LINE 5 LT IN SH

LINE 6 LT IN SH

ANALOG INPUTS
5 - 8 DB-25

1
2
3
4
5
6
7
8

RJ-45 #1

LINE 1 LT IN HI 
LINE 1 LT IN LO
LINE 1 RT IN HI

LINE 1 RT IN LO

1
2
3

4
5
6
7
8

RJ-45 #2

1
2
3
4
5
6
7
8

RJ-45 #3

1
2
3

4
5
6
7
8

RJ-45 #4

1
2
3
4
5
6
7
8

RJ-45 #5

1
2
3

4
5
6
7
8

RJ-45 #6

1
2
3
4
5
6
7
8

RJ-45 #7

1
2
3

4
5
6
7
8

RJ-45 #8

LINE 2 LT IN HI 
LINE 2 LT IN LO
LINE 2 RT IN HI

LINE 2 RT IN LO

LINE 3 LT IN HI 
LINE 3 LT IN LO
LINE 3 RT IN HI

LINE 3 RT IN LO

LINE 4 LT IN HI 
LINE 4 LT IN LO
LINE 4 RT IN HI

LINE 4 RT IN LO

LINE 5 LT IN HI 
LINE 5 LT IN LO
LINE 5 RT IN HI

LINE 5 RT IN LO

LINE 6 LT IN HI 
LINE 6 LT IN LO
LINE 6 RT IN HI

LINE 6 RT IN LO

LINE 7 LT IN HI 
LINE 7 LT IN LO
LINE 7 RT IN HI

LINE 7 RT IN LO

LINE 8 LT IN HI 
LINE 8 LT IN LO

LINE 8 RT IN HI

LINE 8 RT IN LO

ANALOG INPUTS

LINE 1 LT OUT HI

LINE 1 RT OUT LO

LINE 2 LT OUT HI

LINE 2 RT OUT LO

LINE 3 LT OUT SH

LINE 3 LT OUT HI

LINE 3 RT OUT LO

LINE 4 LT OUT SH

LINE 4 LT OUT HI

LINE 4 RT OUT LO

AUDIO GROUND

LINE 1 LT OUT LO

LINE 1 RT OUT SH

LINE 1 RT OUT HI

LINE 2 LT OUT LO

LINE 2 RT OUT SH

LINE 2 RT OUT HI

LINE 3 LT OUT LO

LINE 3 RT OUT SH

LINE 3 RT OUT HI

LINE 4 LT OUT LO

LINE 4 RT OUT SH

LINE 4 RT OUT HI

5

4

3

2

1

17

16
15

14

8

7

6

20

19

18

10

9

23

22

21

13
12

11

25

24

LINE 1 LT OUT SH

LINE 2 LT OUT SH

ANALOG OUTPUTS
1- 4 DB-25

LINE 5 LT OUT HI

LINE 5 RT OUT LO

LINE 6 LT OUT HI

LINE 6 RT OUT LO

LINE 7 LT OUT SH

LINE 7 LT OUT HI

LINE 7 RT OUT LO

LINE 8 LT OUT SH

LINE 8 LT OUT HI

LINE 8 RT OUT LO

AUDIO GROUND

LINE 5 LT OUT LO

LINE 5 RT OUT SH

LINE 5 RT OUT HI

LINE 6 LT OUT LO

LINE 6 RT OUT SH

LINE 6 RT OUTHI

LINE 7 LT OUT LO

LINE 7 RT OUT SH

LINE 7 RT OUT HI

LINE 8 LT OUT LO

LINE 8 RT OUT SH

LINE 8 RT OUT HI

5

4

3

2

1

17

16
15

14

8

7

6

20

19

18

10

9

23

22

21

13
12

11

25

24

LINE 5 LT OUT SH

LINE 6 LT OUT SH

ANALOG OUTPUTS
5 - 8 DB-25

1
2
3
4
5
6
7
8

RJ-45 #1

LINE 1 LT OUT HI 
LINE 1 LT OUT LO
LINE 1 RT OUT HI

LINE 1 RT OUT LO

1
2
3

4
5
6
7
8

RJ-45 #2

1
2
3
4
5
6
7
8

RJ-45 #3

1
2
3
4
5
6
7
8

RJ-45 #4

1
2
3
4
5
6
7
8

RJ-45 #5

1
2
3

4
5
6
7
8

RJ-45 #6

1
2
3
4
5
6
7
8

RJ-45 #7

1
2
3
4
5
6
7
8

RJ-45 #8

LINE 2 LT OUT HI 
LINE 2 LT OUT LO
LINE 2 RT OUT HI

LINE 2 RT OUT LO

LINE 3 LT OUT HI 
LINE 3 LT OUT LO
LINE 3 RT OUT HI

LINE 3 RT OUT LO

LINE 4 LT OUT HI 
LINE 4 LT OUT LO
LINE 4 RT OUT HI

LINE 4 RT OUT LO

LINE 5 LT OUT HI 
LINE 5 LT OUT LO
LINE 5 RT OUT HI

LINE 5 RT OUT LO

LINE 6 LT OUT HI 
LINE 6 LT OUT LO
LINE 6 RT OUT HI

LINE 6 RT OUT LO

LINE 7 LT OUT HI 
LINE 7 LT OUT LO
LINE 7 RT OUT HI

LINE 7 RT OUT LO

LINE 8 LT OUT HI 
LINE 8 LT OUT LO
LINE 8 RT OUT HI

LINE 8 RT OUT LO

ANALOG OUTPUTS

1
2
3

4
5
6
7
8

1 - 6 RJ-45 

1
2
3
4
5
6
7
8

7 - 12 RJ-45 

DIGITAL GROUND
LOGIC 1 IN/OUT
LOGIC 2 IN/OUT
LOGIC 3 IN/OUT
LOGIC 4 IN/OUT
LOGIC 5 IN/OUT
LOGIC 6 IN/OUT
+5V DIGITAL

DIGITAL GROUND
LOGIC 7 IN/OUT
LOGIC 8 IN/OUT
LOGIC 9 IN/OUT
LOGIC 10 IN/OUT
LOGIC 11 IN/OUT
LOGIC 12 IN/OUT
+5V DIGITAL

LOGIC I/O

1
2
3
4
5
6
7
8

TX +
TX -
RX +

RX -

N/C
N/C

N/C
N/C

100M RJ-45 

1
2
3
4
5
6
7
8

TRD0 +
TRD0 -
TRD1 +

TRD1 -

TRD2 +
TRD2 -

TRD3 +
TRD3 -

1G RJ-45 ETHERNET

NOT USED 
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NOTE: DB-25 audio connections and RJ-45 audio connections are paralleled. Either may be used.

Digital 88d - Input/Output Pinouts 

DIGITAL INPUTS

AES 1 IN HI

N/C

AES 2 IN HI

N/C

AES 3 IN SH

AES 3 IN HI

N/C

AES 4 IN SH

AES 4 IN HI

N/C

AUDIO GROUND

AES 1 IN LO

N/C

N/C

AES 2 IN LO

N/C

N/C

AES 3 IN LO

N/C

N/C

AES 4 IN LO

N/C

N/C

5

4

3

2

1

17

16
15

14

8

7

6

20

19

18

10

9

23

22

21

13
12

11

25

24

AES 1 IN SH

AES 2 IN SH

1- 4 DB-25

AES 5 IN HI

N/C

AES 6 IN HI

N/C

AES 7 IN SH

AES 7 IN HI

N/C

AES 8 IN SH

AES 8 IN HI

N/C

AUDIO GROUND

AES 5 IN LO

N/C

N/C

AES 6 IN LO

N/C

N/C

AES 7 IN LO

N/C

N/C

AES 8 IN LO

N/C

N/C

5

4

3

2

1

17

16
15

14

8

7

6

20

19

18

10

9

23

22

21

13
12

11

25

24

AES 5 IN SH

AES 6 IN SH

DIGITAL INPUTS
5 - 8 DB-25

1
2
3

4
5
6
7
8

RJ-45 #1

AES 1 IN HI 
AES 1 IN LO

1
2
3

4
5
6
7
8

RJ-45 #2

1
2
3
4
5
6
7
8

RJ-45 #3

1
2
3
4
5
6
7
8

RJ-45 #4

1
2
3

4
5
6
7
8

RJ-45 #5

1
2
3

4
5
6
7
8

RJ-45 #6

1
2
3
4
5
6
7
8

RJ-45 #7

1
2
3
4
5
6
7
8

RJ-45 #8

AES 2 IN HI 
AES 2 IN LO

AES 3 IN HI 
AES 3 IN LO

AES 4 IN HI
AES 4 IN LO

AES 5 IN HI 
AES 5 IN LO

AES 6 IN HI 
AES 6 IN LO

AES 7 IN HI
AES 7 IN LO

AES 8 IN HI
AES 8 IN LO

DIGITAL INPUTS
DIGITAL OUTPUTS

AES 1 OUT HI

N/C

AES 2 OUT HI

N/C

AES 3 OUT SH

AES 3 OUT HI

N/C

AES 4 OUT SH

AES 4 OUT HI

N/C

AUDIO GROUND

AES 1 OUT LO

N/C

N/C

AES 2 OUT LO

N/C

N/C

AES 3 OUT LO

N/C

N/C

AES 4 OUT LO

N/C

N/C

5

4

3

2

1

17

16
15

14

8

7

6

20

19

18

10

9

23

22

21

13
12

11

25

24

AES 1 OUT SH

AES 2 OUT SH

1- 4 DB-25

AES 5 OUT HI

N/C

AES 6 OUT HI

N/C

AES 7 OUT SH

AES 7 OUT HI

N/C

AES 8 OUT SH

AES 8 OUT HI

N/C

AUDIO GROUND

AES 5 OUT LO

N/C

N/C

AES 6 OUT LO

N/C

N/C

AES 7 OUT LO

N/C

N/C

AES 8 OUT LO

N/C

N/C

5

4

3

2

1

17

16
15

14

8

7

6

20

19

18

10

9

23

22

21

13
12

11

25

24

AES 5 OUT SH

AES 6 OUT SH

DIGITAL OUTPUTS
5 - 8 DB-25

1
2
3

4
5
6
7
8

RJ-45 #1

AES 1 OUT HI 
AES 1 OUT LO

1
2
3

4
5
6
7
8

RJ-45 #2

1
2
3
4
5
6
7
8

RJ-45 #3

1
2
3
4
5
6
7
8

RJ-45 #4

1
2
3

4
5
6
7
8

RJ-45 #5

1
2
3

4
5
6
7
8

RJ-45 #6

1
2
3
4
5
6
7
8

RJ-45 #7

1
2
3
4
5
6
7
8

RJ-45 #8

AES 2 OUT HI 
AES 2 OUT LO

AES 3 OUT HI 
AES 3 OUT LO

AES 4 OUT HI 
AES 4 OUT LO

AES 5 OUT HI 
AES 5 OUT LO

AES 6 OUT HI 
AES 6 OUT LO

AES 7 OUT HI 
AES 7 OUT LO

AES 8 OUT HI 
AES 8 OUT LO

DIGITAL OUTPUTS

1
2
3
4
5
6
7
8

TX +
TX -
RX +

RX -

N/C
N/C

N/C
N/C

100M RJ-45 

1
2
3
4
5
6
7
8

TRD0 +
TRD0 -
TRD1 +

TRD1 -

TRD2 +
TRD2 -

TRD3 +
TRD3 -

1G RJ-45 ETHERNET

NOT USED 

1
2
3

4
5
6
7
8

1 - 6 RJ-45 

1
2
3
4
5
6
7
8

7 - 12 RJ-45 

DIGITAL GROUND
LOGIC 1 IN/OUT
LOGIC 2 IN/OUT
LOGIC 3 IN/OUT
LOGIC 4 IN/OUT
LOGIC 5 IN/OUT
LOGIC 6 IN/OUT
+5V DIGITAL

DIGITAL GROUND
LOGIC 7 IN/OUT
LOGIC 8 IN/OUT
LOGIC 9 IN/OUT
LOGIC 10 IN/OUT
LOGIC 11 IN/OUT
LOGIC 12 IN/OUT
+5V DIGITAL

LOGIC I/O
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NOTE: DB-25 audio connections and RJ-45 audio connections are paralleled. Either may be used.

Analog/Digital 88ad - Input/Output Pinouts 

AES 5 IN HI

N/C

AES 6 IN HI

N/C

AES 7 IN SH

AES 7 IN HI

N/C

AES 8 IN SH

AES 8 IN HI

N/C

AUDIO GROUND

AES 5 IN LO

N/C

N/C

AES 6 IN LO

N/C

N/C

AES 7 IN LO

N/C

N/C

AES 8 IN LO

N/C

N/C

5

4

3

2

1

17

16
15

14

8

7

6

20

19

18

10

9

23

22

21

13
12

11

25

24

AES 5 IN SH

AES 6 IN SH

DIGITAL INPUTS
5 - 8 DB-25

AES 5 OUT HI

N/C

AES 6 OUT HI

N/C

AES 7 OUT SH

AES 7 OUT HI

N/C

AES 8 OUT SH

AES 8 OUT HI

N/C

AUDIO GROUND

AES 5 OUT LO

N/C

N/C

AES 6 OUT LO

N/C

N/C

AES 7 OUT LO

N/C

N/C

AES 8 OUT LO

N/C

N/C

5

4

3

2

1

17

16
15

14

8

7

6

20

19

18

10

9

23

22

21

13
12

11

25

24

AES 5 OUT SH

AES 6 OUT SH

DIGITAL OUTPUTS
5 - 8 DB-25

1
2
3
4
5
6
7
8

TX +
TX -
RX +

RX -

N/C
N/C

N/C
N/C

100M RJ-45 

1
2
3
4
5
6
7
8

TRD0 +
TRD0 -
TRD1 +

TRD1 -

TRD2 +
TRD2 -

TRD3 +
TRD3 -

1G RJ-45 ETHERNET

NOT USED 

1
2
3

4
5
6
7
8

1 - 6 RJ-45 

1
2
3
4
5
6
7
8

7 - 12 RJ-45 

DIGITAL GROUND
LOGIC 1 IN/OUT
LOGIC 2 IN/OUT
LOGIC 3 IN/OUT
LOGIC 4 IN/OUT
LOGIC 5 IN/OUT
LOGIC 6 IN/OUT
+5V DIGITAL

DIGITAL GROUND
LOGIC 7 IN/OUT
LOGIC 8 IN/OUT
LOGIC 9 IN/OUT
LOGIC 10 IN/OUT
LOGIC 11 IN/OUT
LOGIC 12 IN/OUT
+5V DIGITAL

LOGIC I/O

ANALOG INPUTS

LINE 1 LT IN HI

LINE 1 RT IN LO

LINE 2 LT IN HI

LINE 2 RT IN LO

LINE 3 LT IN SH

LINE 3 LT IN HI

LINE 3 RT IN LO

LINE 4 LT IN SH

LINE 4 LT IN HI

LINE 4 RT IN LO

AUDIO GROUND

LINE 1 LT IN LO

LINE 1 RT IN SH

LINE 1 RT IN HI

LINE 2 LT IN LO

LINE 2 RT IN SH

LINE 2 RT IN HI

LINE 3 LT IN LO

LINE 3 RT IN SH

LINE 3 RT IN HI

LINE 4 LT IN LO

LINE 4 RT IN SH

LINE 4 RT IN HI

5

4

3

2

1

17

16
15

14

8

7

6

20

19

18

10

9

23

22

21

13
12

11

25

24

LINE 1 LT IN SH

LINE 2 LT IN SH

1- 4 DB-25

1
2
3
4
5
6
7
8

RJ-45 #1

LINE 1 LT IN HI 
LINE 1 LT IN LO
LINE 1 RT IN HI

LINE 1 RT IN LO

1
2
3
4
5
6
7
8

RJ-45 #2

1
2
3

4
5
6
7
8

RJ-45 #3

1
2
3

4
5
6
7
8

RJ-45 #4

1
2
3
4
5
6
7
8

RJ-45 #5

1
2
3
4
5
6
7
8

RJ-45 #6

1
2
3

4
5
6
7
8

RJ-45 #7

1
2
3

4
5
6
7
8

RJ-45 #8

LINE 2 LT IN HI 
LINE 2 LT IN LO
LINE 2 RT IN HI

LINE 2 RT IN LO

LINE 3 LT IN HI 
LINE 3 LT IN LO
LINE 3 RT IN HI

LINE 3 RT IN LO

LINE 4 LT IN HI 
LINE 4 LT IN LO
LINE 4 RT IN HI

LINE 4 RT IN LO

ANALOG / DIGITAL INPUTS

AES 5 IN HI 
AES 5 IN LO

AES 6 IN HI 
AES 6 IN LO

AES 7 IN HI 
AES 7 IN LO

AES 8 IN HI 
AES 8 IN LO

LINE 1 LT OUT HI

LINE 1 RT OUT LO

LINE 2 LT OUT HI

LINE 2 RT OUT LO

LINE 3 LT OUT SH

LINE 3 LT OUT HI

LINE 3 RT OUT LO

LINE 4 LT OUT SH

LINE 4 LT OUT HI

LINE 4 RT OUT LO

AUDIO GROUND

LINE 1 LT OUT LO

LINE 1 RT OUT SH

LINE 1 RT OUT HI

LINE 2 LT OUT LO

LINE 2 RT OUT SH

LINE 2 RT OUT HI

LINE 3 LT OUT LO

LINE 3 RT OUT SH

LINE 3 RT OUT HI

LINE 4 LT OUT LO

LINE 4 RT OUT SH

LINE 4 RT OUT HI

5

4

3

2

1

17

16
15

14

8

7

6

20

19

18

10

9

23

22

21

13
12

11

25

24

LINE 1 LT OUT SH

LINE 2 LT OUT SH

ANALOG OUTPUTS
1- 4 DB-25

1
2
3
4
5
6
7
8

RJ-45 #1

LINE 1 LT OUT HI 
LINE 1 LT OUT LO
LINE 1 RT OUT HI

LINE 1 RT OUT LO

1
2
3
4
5
6
7
8

RJ-45 #2

1
2
3

4
5
6
7
8

RJ-45 #3

1
2
3

4
5
6
7
8

RJ-45 #4

1
2
3
4
5
6
7
8

RJ-45 #5

1
2
3
4
5
6
7
8

RJ-45 #6

1
2
3

4
5
6
7
8

RJ-45 #7

1
2
3

4
5
6
7
8

RJ-45 #8

LINE 2 LT OUT HI 
LINE 2 LT OUT LO
LINE 2 RT OUT HI

LINE 2 RT OUT LO

LINE 3 LT OUT HI 
LINE 3 LT OUT LO
LINE 3 RT OUT HI

LINE 3 RT OUT LO

LINE 4 LT OUT HI 
LINE 4 LT OUT LO
LINE 4 RT OUT HI

LINE 4 RT OUT LO

ANALOG / DIGITAL OUTPUTS

AES 5 OUT HI 
AES 5 OUT LO

AES 6 OUT HI 
AES 6 OUT LO

AES 7 OUT HI 
AES 7 OUT LO

AES 8 OUT HI 
AES 8 OUT LO
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NOTE: DB-25 audio connections and RJ-45 audio connections are paralleled. Either may be used.

1

3

2

XLR-F #1

PIN 1 - MIC 1 IN SH 

PIN 2 - MIC 1 IN HI 
PIN 3 - MIC 1 IN LO

1

3

2

XLR-F #2

PIN 1 - MIC 2 IN SH 

PIN 2 - MIC 2 IN HI 
PIN 3 - MIC 2 IN LO

1

3

2

XLR-F #3

PIN 1 - MIC 3 IN SH 

PIN 2 - MIC 3 IN HI 
PIN 3 - MIC 3 IN LO

1

3

2

XLR-F #4

PIN 1 - MIC 4 IN SH 

PIN 2 - MIC 4 IN HI 
PIN 3 - MIC 4 IN LO

1

3

2

XLR-F #5

PIN 1 - MIC 5 IN SH 

PIN 2 - MIC 5 IN HI 
PIN 3 - MIC 5 IN LO

1

3

2

XLR-F #6

PIN 1 - MIC 6 IN SH 

PIN 2 - MIC 6 IN HI 
PIN 3 - MIC 6 IN LO

1

3

2

XLR-F #7

PIN 1 - MIC 7 IN SH 

PIN 2 - MIC 7 IN HI 
PIN 3 - MIC 7 IN LO

1

3

2

XLR-F #8

PIN 1 - MIC 8 IN SH 

PIN 2 - MIC 8 IN HI 
PIN 3 - MIC 8 IN LO

MIC INPUTS

LINE 1 LT OUT HI

LINE 1 RT OUT LO

LINE 2 LT OUT HI

LINE 2 RT OUT LO

LINE 3 LT OUT SH

LINE 3 LT OUT HI

LINE 3 RT OUT LO

LINE 4 LT OUT SH

LINE 4 LT OUT HI

LINE 4 RT OUT LO

AUDIO GROUND

LINE 1 LT OUT LO

LINE 1 RT OUT SH

LINE 1 RT OUT HI

LINE 2 LT OUT LO

LINE 2 RT OUT SH

LINE 2 RT OUT HI

LINE 3 LT OUT LO

LINE 3 RT OUT SH

LINE 3 RT OUT HI

LINE 4 LT OUT LO

LINE 4 RT OUT SH

LINE 4 RT OUT HI

5

4

3

2

1

17

16
15

14

8

7

6

20

19

18

10

9

23

22

21

13
12

11

25

24

LINE 1 LT OUT SH

LINE 2 LT OUT SH

ANALOG OUTPUTS
1- 4 DB-25

1
2
3
4
5
6
7
8

RJ-45 #1

LINE 1 LT OUT HI 
LINE 1 LT OUT LO
LINE 1 RT OUT HI

LINE 1 RT OUT LO

1
2
3

4
5
6
7
8

RJ-45 #2

1
2
3
4
5
6
7
8

RJ-45 #3

1
2
3
4
5
6
7
8

RJ-45 #4

1
2
3
4
5
6
7
8

RJ-45 #5

1
2
3

4
5
6
7
8

RJ-45 #6

1
2
3
4
5
6
7
8

RJ-45 #7

1
2
3
4
5
6
7
8

RJ-45 #8

LINE 2 LT OUT HI 
LINE 2 LT OUT LO
LINE 2 RT OUT HI

LINE 2 RT OUT LO

LINE 3 LT OUT HI 
LINE 3 LT OUT LO
LINE 3 RT OUT HI

LINE 3 RT OUT LO

LINE 4 LT OUT HI 
LINE 4 LT OUT LO
LINE 4 RT OUT HI

LINE 4 RT OUT LO

N
O

T
 U

S
E

D

ANALOG OUTPUTS

N
O

T
 U

S
E

D
N

O
T

 U
S

E
D

N
O

T
 U

S
E

D

1
2
3
4
5
6
7
8

TX +
TX -
RX +

RX -

N/C
N/C

N/C
N/C

100M RJ-45 

1
2
3
4
5
6
7
8

TRD0 +
TRD0 -
TRD1 +

TRD1 -

TRD2 +
TRD2 -

TRD3 +
TRD3 -

1G RJ-45 ETHERNET

NOT USED 

1
2
3

4
5
6
7
8

1 - 6 RJ-45 

1
2
3
4
5
6
7
8

7 - 12 RJ-45 

DIGITAL GROUND
LOGIC 1 IN/OUT
LOGIC 2 IN/OUT
LOGIC 3 IN/OUT
LOGIC 4 IN/OUT
LOGIC 5 IN/OUT
LOGIC 6 IN/OUT
+5V DIGITAL

DIGITAL GROUND
LOGIC 7 IN/OUT
LOGIC 8 IN/OUT
LOGIC 9 IN/OUT
LOGIC 10 IN/OUT
LOGIC 11 IN/OUT
LOGIC 12 IN/OUT
+5V DIGITAL

LOGIC I/O
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NOTE: DB-25 audio connections and RJ-45 audio connections are paralleled. Either may be used.

Console BLADE 88cb, 88cbe - Input/Output Pinouts 

1
2
3
4
5
6
7
8

TX +
TX -
RX +

RX -

N/C
N/C

N/C
N/C

100M RJ-45 

1
2
3
4
5
6
7
8

TRD0 +
TRD0 -
TRD1 +

TRD1 -

TRD2 +
TRD2 -

TRD3 +
TRD3 -

1G RJ-45 ETHERNET

NOT USED 

1
2
3

4
5
6
7
8

1 - 6 RJ-45 

1
2
3
4
5
6
7
8

7 - 12 RJ-45 

DIGITAL GROUND
LOGIC 1 IN/OUT
LOGIC 2 IN/OUT
LOGIC 3 IN/OUT
LOGIC 4 IN/OUT
LOGIC 5 IN/OUT
LOGIC 6 IN/OUT
+5V DIGITAL

DIGITAL GROUND
LOGIC 7 IN/OUT
LOGIC 8 IN/OUT
LOGIC 9 IN/OUT
LOGIC 10 IN/OUT
LOGIC 11 IN/OUT
LOGIC 12 IN/OUT
+5V DIGITAL

LOGIC I/O

1
2
3
4
5
6
7
8

RJ-45 #1

LINE 1 LT IN HI 
LINE 1 LT IN LO
LINE 1 RT IN HI

LINE 1 RT IN LO

1
2
3
4
5
6
7
8

RJ-45 #2

1
2
3

4
5
6
7
8

RJ-45 #3

1
2
3

4
5
6
7
8

RJ-45 #4

1
2
3
4
5
6
7
8

RJ-45 #5

1
2
3
4
5
6
7
8

RJ-45 #6

1
2
3

4
5
6
7
8

RJ-45 #7

1
2
3

4
5
6
7
8

RJ-45 #8

LINE 2 LT IN HI 
LINE 2 LT IN LO
LINE 2 RT IN HI

LINE 2 RT IN LO

LINE 3 LT IN HI 
LINE 3 LT IN LO
LINE 3 RT IN HI

LINE 3 RT IN LO

LINE 4 LT IN HI 
LINE 4 LT IN LO
LINE 4 RT IN HI

LINE 4 RT IN LO

ANALOG / DIGITAL INPUTS

AES 5 IN HI 
AES 5 IN LO

AES 6 IN HI 
AES 6 IN LO

AES 7 IN HI 
AES 7 IN LO

AES 8 IN HI 
AES 8 IN LO

2

3

1

XLR-M #1

PIN 1 - ST LT OUT SH 
PIN 2 - ST LT OUT HI 

PIN 3 - ST LT OUT LO

2

3

1

XLR-M #1

PIN 1 - CR LT OUT SH 
PIN 2 - CR LT OUT HI 

PIN 3 - CR LT OUT LO

2

3

1

XLR-M #2

PIN 1 - ST RT OUT SH 
PIN 2 - ST RT OUT HI 

PIN 3 - ST RT OUT LO

2

3

1

XLR-M #2

PIN 1 - CR RT OUT SH 
PIN 2 - CR RT OUT HI 

PIN 3 - CR RT OUT LO

STUDIO OUT

CR OUT

1
2
3
4
5
6
7
8

RJ-45 A

PGM A  LT OUT HI 
PGM A  LT OUT LO
PGM A  RT OUT HI

PGM A  RT OUT LO

1
2
3

4
5
6
7
8

RJ-45 B

1
2
3
4
5
6
7
8

RJ-45 C

1
2
3
4
5
6
7
8

RJ-45 D

1
2
3
4
5
6
7
8

RJ-45 A

1
2
3

4
5
6
7
8

RJ-45 B

1
2
3
4
5
6
7
8

RJ-45 C

1
2
3
4
5
6
7
8

RJ-45 D

PGM B  LT OUT HI 
PGM B  LT OUT LO
PGM B  RT OUT HI

PGM B  RT OUT LO

PGM C LT OUT HI 

PGM C LT OUT LO
PGM C RT OUT HI

PGM C  RT OUT LO

PGM D  LT OUT HI 
PGM D  LT OUT LO
PGM D  RT OUT HI

PGM D  RT OUT LO

PROGRAM OUTPUTS
ANALOG DIGITAL

PGM AES D  OUT HI 
PGM AES D  OUT LO

PGM AES C  OUT HI 
PGM AES C  OUT LO

PGM AES B  OUT HI
PGM AES B  OUT LO

PGM AES A  OUT HI
PGM AES A  OUT LO

1
2
3

4
5
6
7
8

RJ-45 

MIC 1 OUT HI 
MIC 1 OUT LO

MIC 2 OUT HI 

MIC 2 OUT LO

MICS OUT

1
2
3
4
5
6
7
8

HDPN LT OUT HI

HDPN LT OUT LO
HDPN RT OUT HI

HDPN RT OUT LO

CUE LT OUT HI
CUE LT OUT LO

CUE RT OUT HI
CUE RT OUT LO

RJ-45 
CUE/HDPN OUT

1

3

2

XLR-F #1

PIN 1 - MIC 1 IN SH 
PIN 2 - MIC 1 IN HI 

PIN 3 - MIC 1 IN LO

1

3

2

XLR-F #2

PIN 1 - MIC 2 IN SH 

PIN 2 - MIC 2 IN HI 
PIN 3 - MIC 2 IN LO

MIC INPUTS

WheatNet-IP / Nov 2012
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1
2
3
4
5
6
7
8

TX +
TX -
RX +

RX -

N/C
N/C

N/C
N/C

100M RJ-45 

1
2
3
4
5
6
7
8

TRD0 +
TRD0 -
TRD1 +

TRD1 -

TRD2 +
TRD2 -

TRD3 +
TRD3 -

1G RJ-45 ETHERNET

NOT USED 

1
2
3

4
5
6
7
8

1 - 6 RJ-45 

1
2
3
4
5
6
7
8

7 - 12 RJ-45 

DIGITAL GROUND
LOGIC 1 IN/OUT
LOGIC 2 IN/OUT
LOGIC 3 IN/OUT
LOGIC 4 IN/OUT
LOGIC 5 IN/OUT
LOGIC 6 IN/OUT
+5V DIGITAL

DIGITAL GROUND
LOGIC 7 IN/OUT
LOGIC 8 IN/OUT
LOGIC 9 IN/OUT
LOGIC 10 IN/OUT
LOGIC 11 IN/OUT
LOGIC 12 IN/OUT
+5V DIGITAL

LOGIC I/O
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NOTE: DB-25 audio connections and RJ-45 audio connections are paralleled. Either may be used.

Vorsis Embedded BLADE Aura8ip - Input/Output Pinouts 

AES 5 IN HI

N/C

AES 6 IN HI

N/C

AES 7 IN SH

AES 7 IN HI

N/C

AES 8 IN SH

AES 8 IN HI

N/C

AUDIO GROUND

AES 5 IN LO

N/C

N/C

AES 6 IN LO

N/C

N/C

AES 7 IN LO

N/C

N/C

AES 8 IN LO

N/C

N/C

5

4

3

2

1

17

16
15

14

8

7

6

20

19

18

10

9

23

22

21

13
12

11

25

24

AES 5 IN SH

AES 6 IN SH

DIGITAL INPUTS
5 - 8 DB-25

AES 5 OUT HI

N/C

AES 6 OUT HI

N/C

AES 7 OUT SH

AES 7 OUT HI

N/C

AES 8 OUT SH

AES 8 OUT HI

N/C

AUDIO GROUND

AES 5 OUT LO

N/C

N/C

AES 6 OUT LO

N/C

N/C

AES 7 OUT LO

N/C

N/C

AES 8 OUT LO

N/C

N/C

5

4

3

2

1

17

16
15

14

8

7

6

20

19

18

10

9

23

22

21

13
12

11

25

24

AES 5 OUT SH

AES 6 OUT SH

DIGITAL OUTPUTS
5 - 8 DB-25

1
2
3
4
5
6
7
8

TX +
TX -
RX +

RX -

N/C
N/C

N/C
N/C

100M RJ-45 

1
2
3
4
5
6
7
8

TRD0 +
TRD0 -
TRD1 +

TRD1 -

TRD2 +
TRD2 -

TRD3 +
TRD3 -

1G RJ-45 ETHERNET

NOT USED 

1
2
3

4
5
6
7
8

1 - 6 RJ-45 

1
2
3
4
5
6
7
8

7 - 12 RJ-45 

DIGITAL GROUND
LOGIC 1 IN/OUT
LOGIC 2 IN/OUT
LOGIC 3 IN/OUT
LOGIC 4 IN/OUT
LOGIC 5 IN/OUT
LOGIC 6 IN/OUT
+5V DIGITAL

DIGITAL GROUND
LOGIC 7 IN/OUT
LOGIC 8 IN/OUT
LOGIC 9 IN/OUT
LOGIC 10 IN/OUT
LOGIC 11 IN/OUT
LOGIC 12 IN/OUT
+5V DIGITAL

LOGIC I/O

ANALOG INPUTS

LINE 1 LT IN HI

LINE 1 RT IN LO

LINE 2 LT IN HI

LINE 2 RT IN LO

LINE 3 LT IN SH

LINE 3 LT IN HI

LINE 3 RT IN LO

LINE 4 LT IN SH

LINE 4 LT IN HI

LINE 4 RT IN LO

AUDIO GROUND

LINE 1 LT IN LO

LINE 1 RT IN SH

LINE 1 RT IN HI

LINE 2 LT IN LO

LINE 2 RT IN SH

LINE 2 RT IN HI

LINE 3 LT IN LO

LINE 3 RT IN SH

LINE 3 RT IN HI

LINE 4 LT IN LO

LINE 4 RT IN SH

LINE 4 RT IN HI

5

4

3

2

1

17

16
15

14

8

7

6

20

19

18

10

9

23

22

21

13
12

11

25

24

LINE 1 LT IN SH

LINE 2 LT IN SH

1- 4 DB-25

1
2
3
4
5
6
7
8

RJ-45 #1

LINE 1 LT IN HI 
LINE 1 LT IN LO
LINE 1 RT IN HI

LINE 1 RT IN LO

1
2
3
4
5
6
7
8

RJ-45 #2

1
2
3

4
5
6
7
8

RJ-45 #3

1
2
3

4
5
6
7
8

RJ-45 #4

1
2
3
4
5
6
7
8

RJ-45 #5

1
2
3
4
5
6
7
8

RJ-45 #6

1
2
3

4
5
6
7
8

RJ-45 #7

1
2
3

4
5
6
7
8

RJ-45 #8

LINE 2 LT IN HI 
LINE 2 LT IN LO
LINE 2 RT IN HI

LINE 2 RT IN LO

LINE 3 LT IN HI 
LINE 3 LT IN LO
LINE 3 RT IN HI

LINE 3 RT IN LO

LINE 4 LT IN HI 
LINE 4 LT IN LO
LINE 4 RT IN HI

LINE 4 RT IN LO

ANALOG / DIGITAL INPUTS

AES 5 IN HI 
AES 5 IN LO

AES 6 IN HI 
AES 6 IN LO

AES 7 IN HI 
AES 7 IN LO

AES 8 IN HI 
AES 8 IN LO

LINE 1 LT OUT HI

LINE 1 RT OUT LO

LINE 2 LT OUT HI

LINE 2 RT OUT LO

LINE 3 LT OUT SH

LINE 3 LT OUT HI

LINE 3 RT OUT LO

LINE 4 LT OUT SH

LINE 4 LT OUT HI

LINE 4 RT OUT LO

AUDIO GROUND

LINE 1 LT OUT LO

LINE 1 RT OUT SH

LINE 1 RT OUT HI

LINE 2 LT OUT LO

LINE 2 RT OUT SH

LINE 2 RT OUT HI

LINE 3 LT OUT LO

LINE 3 RT OUT SH

LINE 3 RT OUT HI

LINE 4 LT OUT LO

LINE 4 RT OUT SH

LINE 4 RT OUT HI

5

4

3

2

1

17

16
15

14

8

7

6

20

19

18

10

9

23

22

21

13
12

11

25

24

LINE 1 LT OUT SH

LINE 2 LT OUT SH

ANALOG OUTPUTS
1- 4 DB-25

1
2
3
4
5
6
7
8

RJ-45 #1

LINE 1 LT OUT HI 
LINE 1 LT OUT LO
LINE 1 RT OUT HI

LINE 1 RT OUT LO

1
2
3
4
5
6
7
8

RJ-45 #2

1
2
3

4
5
6
7
8

RJ-45 #3

1
2
3

4
5
6
7
8

RJ-45 #4

1
2
3
4
5
6
7
8

RJ-45 #5

1
2
3
4
5
6
7
8

RJ-45 #6

1
2
3

4
5
6
7
8

RJ-45 #7

1
2
3

4
5
6
7
8

RJ-45 #8

LINE 2 LT OUT HI 
LINE 2 LT OUT LO
LINE 2 RT OUT HI

LINE 2 RT OUT LO

LINE 3 LT OUT HI 
LINE 3 LT OUT LO
LINE 3 RT OUT HI

LINE 3 RT OUT LO

LINE 4 LT OUT HI 
LINE 4 LT OUT LO
LINE 4 RT OUT HI

LINE 4 RT OUT LO

ANALOG / DIGITAL OUTPUTS

AES 5 OUT HI 
AES 5 OUT LO

AES 6 OUT HI 
AES 6 OUT LO

AES 7 OUT HI 
AES 7 OUT LO

AES 8 OUT HI 
AES 8 OUT LO
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1
2
3
4
5
6
7
8

TX +
TX -
RX +

RX -

N/C
N/C

N/C
N/C

100M RJ-45 

1
2
3
4
5
6
7
8

TRD0 +
TRD0 -
TRD1 +

TRD1 -

TRD2 +
TRD2 -

TRD3 +
TRD3 -

1G RJ-45 ETHERNET

NOT USED 

1
2
3

4
5
6
7
8

1 - 6 RJ-45 

1
2
3
4
5
6
7
8

7 - 12 RJ-45 

DIGITAL GROUND
LOGIC 1 IN/OUT
LOGIC 2 IN/OUT
LOGIC 3 IN/OUT
LOGIC 4 IN/OUT
LOGIC 5 IN/OUT
LOGIC 6 IN/OUT
+5V DIGITAL

DIGITAL GROUND
LOGIC 7 IN/OUT
LOGIC 8 IN/OUT
LOGIC 9 IN/OUT
LOGIC 10 IN/OUT
LOGIC 11 IN/OUT
LOGIC 12 IN/OUT
+5V DIGITAL

LOGIC I/O

INPUT
BNC 

PIN 1 - INPUT HI
PIN 2 - INPUT SH

OUTPUT
BNC

PIN 1 - OUTPUT HI
PIN 2 - OUTPUT SH

FIBER
LC CONNECTOR

WheatNet-IP / Oct 2012
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NOTE: DB-25 analog output connections and RJ-45 analog output connections are paralleled. Either may be used.

LINE 1 LT OUT HI

LINE 1 RT OUT LO

LINE 2 LT OUT HI

LINE 2 RT OUT LO

LINE 3 LT OUT SH

LINE 3 LT OUT HI

LINE 3 RT OUT LO

LINE 4 LT OUT SH

LINE 4 LT OUT HI

LINE 4 RT OUT LO

AUDIO GROUND

LINE 1 LT OUT LO

LINE 1 RT OUT SH

LINE 1 RT OUT HI

LINE 2 LT OUT LO

LINE 2 RT OUT SH

LINE 2 RT OUT HI

LINE 3 LT OUT LO

LINE 3 RT OUT SH

LINE 3 RT OUT HI

LINE 4 LT OUT LO

LINE 4 RT OUT SH

LINE 4 RT OUT HI

5

4

3

2

1

17

16
15

14

8

7

6

20

19

18

10

9

23

22

21

13
12

11

25

24

LINE 1 LT OUT SH

LINE 2 LT OUT SH

ANALOG OUTPUTS
1- 4 DB-25

1
2
3
4
5
6
7
8

TX +
TX -
RX +

RX -

N/C
N/C

N/C
N/C

100M RJ-45 

1
2
3
4
5
6
7
8

TRD0 +
TRD0 -
TRD1 +

TRD1 -

TRD2 +
TRD2 -

TRD3 +
TRD3 -

1G RJ-45 ETHERNET

NOT USED 

1
2
3

4
5
6
7
8

1 - 6 RJ-45 

1
2
3
4
5
6
7
8

7 - 12 RJ-45 

DIGITAL GROUND
LOGIC 1 IN/OUT
LOGIC 2 IN/OUT
LOGIC 3 IN/OUT
LOGIC 4 IN/OUT
LOGIC 5 IN/OUT
LOGIC 6 IN/OUT
+5V DIGITAL

DIGITAL GROUND
LOGIC 7 IN/OUT
LOGIC 8 IN/OUT
LOGIC 9 IN/OUT
LOGIC 10 IN/OUT
LOGIC 11 IN/OUT
LOGIC 12 IN/OUT
+5V DIGITAL

LOGIC I/O

WheatNet-IP / May 2013

1
2
3
4
5
6
7
8

RJ-45 #1

LINE 1 LT OUT HI 
LINE 1 LT OUT LO
LINE 1 RT OUT HI

LINE 1 RT OUT LO

1
2
3
4
5
6
7
8

RJ-45 #2

1
2
3

4
5
6
7
8

RJ-45 #3

1
2
3

4
5
6
7
8

RJ-45 #4

1
2
3
4
5
6
7
8

RJ-45 #5

1
2
3
4
5
6
7
8

RJ-45 #6

1
2
3

4
5
6
7
8

RJ-45 #7

1
2
3

4
5
6
7
8

RJ-45 #8

LINE 2 LT OUT HI 
LINE 2 LT OUT LO
LINE 2 RT OUT HI

LINE 2 RT OUT LO

LINE 3 LT OUT HI 
LINE 3 LT OUT LO
LINE 3 RT OUT HI

LINE 3 RT OUT LO

LINE 4 LT OUT HI 
LINE 4 LT OUT LO
LINE 4 RT OUT HI

LINE 4 RT OUT LO

ANALOG / DIGITAL OUTPUTS

AES 5 OUT HI 
AES 5 OUT LO

AES 6 OUT HI 
AES 6 OUT LO

AES 7 OUT HI 
AES 7 OUT LO

AES 8 OUT HI 
AES 8 OUT LO

1

3

2

XLR-F #1

PIN 1 - MIC 1 IN SH
PIN 2 - MIC 1 IN HI
PIN 3 - MIC 1 IN LO

1

3

2

XLR-F #2

PIN 1 - MIC 2 IN SH
PIN 2 - MIC 2 IN HI
PIN 3 - MIC 2 IN LO

1

3

2

XLR-F #3

PIN 1 - MIC 3 IN SH
PIN 2 - MIC 3 IN HI
PIN 3 - MIC 3 IN LO

1

3

2

XLR-F #4

PIN 1 - MIC 4 IN SH
PIN 2 - MIC 4 IN HI
PIN 3 - MIC 4 IN LO

MIC INPUTS
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NOTE: DB-25 logic connections and RJ-45 logic connections are paralleled. Either may be used.

1
2
3
4
5
6
7
8

TX +
TX -
RX +

RX -

N/C
N/C

N/C
N/C

100M RJ-45 

1
2
3
4
5
6
7
8

TRD0 +
TRD0 -
TRD1 +

TRD1 -

TRD2 +
TRD2 -

TRD3 +
TRD3 -

1G RJ-45 ETHERNET

NOT USED 

LIO-48 / Mar 2014

LOGIC 24 IN/OUT

LOGIC 23 IN/OUT

LOGIC 21 IN/OUT

LOGIC 20 IN/OUT

LOGIC 19 IN/OUT

LOGIC 18 IN/OUT

LOGIC 17 IN/OUT

LOGIC 16 IN/OUT

LOGIC 15 IN/OUT

LOGIC 14 IN/OUT

LOGIC 13 IN/OUT

LOGIC 12 IN/OUT

LOGIC 11 IN/OUT

LOGIC 10 IN/OUT

LOGIC 9 IN/OUT

LOGIC 8 IN/OUT

LOGIC 7 IN/OUT

LOGIC 6 IN/OUT

LOGIC 5 IN/OUT

LOGIC 4 IN/OUT

LOGIC 3 IN/OUT

LOGIC 2 IN/OUT

LOGIC 1 IN/OUT

5

4

3
2

1

17

16
15

14

8

7
6

20

19

18

10

9

23

22

21

13
12

11

25

24

DIGITAL GROUND

LOGIC 22 IN/OUT

LOGIC I/O PORTS
1 - 24 DB-25

25 - 48 DB-25

LOGIC 48 IN/OUT

LOGIC 47 IN/OUT

LOGIC 45 IN/OUT

LOGIC 44 IN/OUT

LOGIC 43 IN/OUT

LOGIC 42 IN/OUT

LOGIC 41 IN/OUT

LOGIC 40 IN/OUT

LOGIC 39 IN/OUT

LOGIC 38 IN/OUT

LOGIC 37 IN/OUT

LOGIC 36 IN/OUT

LOGIC 35 IN/OUT

LOGIC 34 IN/OUT

LOGIC 33 IN/OUT

LOGIC 32 IN/OUT

LOGIC 31 IN/OUT

LOGIC 30 IN/OUT

LOGIC 29 IN/OUT

LOGIC 28 IN/OUT

LOGIC 27 IN/OUT

LOGIC 26 IN/OUT

LOGIC 25 IN/OUT

5

4

3
2

1

17

16
15

14

8

7
6

20

19

18

10

9

23

22

21

13
12

11

25

24

DIGITAL GROUND

LOGIC 46 IN/OUT

2
1

7

6

5
4

3

9
8

+5V LOGIC 5
DIGITAL GROUND

+5V LOGIC 8

+5V LOGIC 6

+5V LOGIC 4

+5V LOGIC 3

+5V LOGIC 2

+5V LOGIC 1

+5V LOGIC 7

+5VDC DB-9

1
2
3
4
5
6
7
8

A RJ-45

1
2
3
4
5
6
7
8

E RJ-45

AUDIO GROUND
LOGIC 1 IN/OUT
LOGIC 2 IN/OUT
LOGIC 3 IN/OUT
LOGIC 4 IN/OUT
LOGIC 5 IN/OUT
LOGIC 6 IN/OUT
+5V DIGITAL

AUDIO GROUND
LOGIC 25 IN/OUT
LOGIC 26 IN/OUT
LOGIC 27 IN/OUT
LOGIC 28 IN/OUT
LOGIC 29 IN/OUT
LOGIC 30 IN/OUT
+5V DIGITAL

LOGIC RJ PORTS

1
2
3
4
5
6
7
8

B RJ-45

1
2
3
4
5
6
7
8

F RJ-45

AUDIO GROUND
LOGIC 7 IN/OUT
LOGIC 8 IN/OUT
LOGIC 9 IN/OUT
LOGIC 10 IN/OUT
LOGIC 11 IN/OUT
LOGIC 12 IN/OUT
+5V DIGITAL

AUDIO GROUND
LOGIC 31 IN/OUT
LOGIC 32 IN/OUT
LOGIC 33 IN/OUT
LOGIC 34 IN/OUT
LOGIC 35 IN/OUT
LOGIC 36 IN/OUT
+5V DIGITAL

1
2
3
4
5
6
7
8

C RJ-45

1
2
3
4
5
6
7
8

G RJ-45

AUDIO GROUND
LOGIC 13 IN/OUT
LOGIC 14 IN/OUT
LOGIC 15 IN/OUT
LOGIC 16 IN/OUT
LOGIC 17 IN/OUT
LOGIC 18 IN/OUT
+5V DIGITAL

AUDIO GROUND
LOGIC 37 IN/OUT
LOGIC 38 IN/OUT
LOGIC 39 IN/OUT
LOGIC 40 IN/OUT
LOGIC 41 IN/OUT
LOGIC 42 IN/OUT
+5V DIGITAL

1
2
3
4
5
6
7
8

D RJ-45

1
2
3
4
5
6
7
8

H RJ-45

AUDIO GROUND
LOGIC 19 IN/OUT
LOGIC 20 IN/OUT
LOGIC 21 IN/OUT
LOGIC 22 IN/OUT
LOGIC 23 IN/OUT
LOGIC 24 IN/OUT
+5V DIGITAL

AUDIO GROUND
LOGIC 43 IN/OUT
LOGIC 44 IN/OUT
LOGIC 45 IN/OUT
LOGIC 46 IN/OUT
LOGIC 47 IN/OUT
LOGIC 48 IN/OUT
+5V DIGITAL
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WheatNet-IP
System Operational Modes

Stand Alone

While no one would think of a single rack space device as a networked audio system,
a single “BLADE” is actually a very handy device. It is essentially a stand alone router
with audio and logic, that can be controlled remotely or from the front panel. Use an 88m
for eight microphone inputs and eight mono (four stereo) outputs, an 88a for up to 16
mono analog inputs and outputs, an 88d for eight stereo digital inputs and outputs, or use
an 88ad for a combination of both analog and digital inputs and outputs, plus A/D and
D/A conversion too. While using an 88cb and Evolution 1 control surface you have a
stand alone studio with analog and digital inputs and outputs to give you maximum
flexibility. This stand alone system can be added to a network as your needs change and
expansion is required. As a stand alone router no network connection or Ethernet switch
is required. If you choose to connect the BLADE to a network, you can do things like set
levels remotely, meter and monitor all inputs and outputs, mix channels, use silence
detection, and make routing changes based on time of day. Quite a lot of features packed
into one rack space.

To use a “BLADE” in stand alone mode is easy. Just connect your audio and logic
inputs and outputs and turn it on. As shipped from the factory, all “BLADEs” start up
initially in “System Wizard” mode. That’s where you tell the BLADE what you want it
to do by means of the front panel encoder and switch. When the device first powers up
it will show the System Wizard start up message on its front panel, and then display
“BLADE ID: DISABLED”

WheatNet-IP / June 2010
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Simply scroll the front panel knob one click for the display to change to
“BLADE ID: 1” and press the front panel switch. The display will change to show the default
IP address; make a note of this address in case you want to use web browser access in the
future, and press the front panel switch again to accept it.

Finally the display will show “I/O TEMPLATE: MONO_IO.” There are three signal
templates for WheatNet-IP 88a, 88ad, and 88d that the BLADE will use for automatically
defining the signals related to the input and output jacks. By turning the knob you can choose
“MONO_IO” to define all 16 inputs and outputs as mono signals, “STEREO_IO” to define
all inputs and outputs as eight stereo pairs, or “CUSTOM,” in which case no signals are
automatically defined. Choose “CUSTOM” only if you need a combination of mono and
stereo signals within the BLADE. You’ll have to do more work and define the signals
yourself.

For WheatNet-IP 88m there are two signal templates available. Choose from
“MONO_MIC” which creates eight microphone inputs and eight mono outputs, or
“STEREO_MIC” which creates eight microphone inputs and four stereo outputs.

For Wheatstone-IP 88cb there are three templates available. Choose the
“Console_Stereo_In” template to create all of the needed signals for your E-1 control surface.
When using this template the input signals are created as stereo sources. This template maps
all of the Program, Headphone, Cue, and Monitors signals.

Choose the “Console_Mono_In” template to create all of the needed signals for your E-1
control surface. When using this template the input signals are created as Mono sources. This
template maps all of the Program, Headphone, Cue, and Monitors signals.

Choose the “Custom” template to create your own layout.

WheatNet-IP / June 2010
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Scroll the knob to the template you want to use and press the front panel switch 
and you’re done. The BLADE will complete its configuration process and display 
the message “WHEATNET-IP” when it’s finished. 

You now have a functioning stand alone audio router. Note: if you chose the 
“CUSTOM” signal template (because you wanted to use both stereo and mono 
signals) you will have to use the Navigator GUI to create sources and destinations 
and define which ones are to be mono or stereo before you can actually make any 
cross connections.

You can use the front panel controls to make crosspoint connections. First turn 
the encoder knob through the menu selections until “OUTPUTS...” is shown. Press 
the switch and the display will show the first audio destination, corresponding to 
the first output jack. If you have not yet given this destination a special 8 character 
name via a web browser or the Navigator GUI, then the default name “BL01D01: 
NO SRC” will be shown in the display. This cryptic shorthand means “BLADE 
01, destination 01 has no source connected to it,” obviously then there will be no 
audio output at destination 1.

Pressing the front panel switch will change the source section of the display to 
show underlines flashing under the source name, indicating that the source can now 
be changed. Scroll the knob until the desired source is shown and press the switch. 
The crosspoint connection will be made and the display will change to indicate the 
destination/source connection. Turning the knob again will change the display to 
the next destination, where the process can be repeated. In this manner, connections 
for all of the destinations can be made. Note, you can connect any source to any 
destination. You can connect the same source to multiple destinations. If you wish 
to break a connection to a particular destination, simple select that destination via 
the encoder, and scroll through the sources until you see “NO SRC” and select it.

In addition to the normal destinations (eight to 16, depending on configuration) 
each BLADE has a special destination corresponding to the front panel headphone 
jack. Like any other destination, you can choose the source connected to it, allowing 
you to monitor any source on a pair of headphones plugged in to the BLADE. To 
control the volume of this headphone output, scroll through the front panel menus 
until you see “HEADPHONE...” and select it. The encoder knob now functions as 

WheatNet-IP / Jan 2013
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a volume control for the headphone jack. The display will show “HDPN LEVEL: 
XX ————” where “XX” is a number from 1 to 10 indicating relative loudness. 
The number of dashes next to these digits also increase to give a “gas gauge” style 
indication of loudness. To change the loudness of the headphone output, momen-
tarily press and release the knob; the level indicators will start flashing and you can 
turn the encoder to increase or decrease the level. To choose which audio channel 
you are monitoring at the headphone jack, scroll the knob until you see the “HDPN 
SOURCE: xxxxxxxx” display (xxxxxxxx represents the name of the previously se-
lected source for the headphone destination), and press the switch. The encoder will 
now let you scroll through the available sources; press the switch when you find the 
one you want. Of course, if desired, the Navigator GUI can also be used to choose 
a source for the headphone destination, just as it can for any other one.

You can use the front panel encoder to set the front panel meter mode for the 
BLADE. There are 16 LED bargraph meters on the front panel. These can show 
either the input signal levels for each source, or the output signal levels for each 
destination. To choose, scroll through the front panel menus until you find “ME-
TERS...” and select it with the switch. The front panel display will change to show 
the current mode, either “INPUTS” or OUTPUTS.” Scroll the knob to select your 
preference and select it with the switch. Note there are front panel mode LEDs that 
indicate whether the meters are showing input levels or output levels. Also, these 
meters show audio levels after any gain trimming has been applied, so if for some 
reason you have the gain for a particular channel cranked down, you may not see 
any meter indication even though audio is there.

Connecting to this stand alone BLADE with the Navigator GUI or web browser 
will allow you to create user defined names for each of the source and destination 
signals, trim their audio levels, meter the audio, define logic, set silence detect pa-
rameters, and a host of other functions. See the WheatNet-IP Navigator GUI chapter 
of this manual for details.

WheatNet-IP / Jan 2013
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Snake

Snake mode (from the term “audio snake,” which refers to a multipair audio cable
meant to connect a number of audio channels simultaneously) is a way to use two
BLADEs to transport up to 16 audio channels from one location to another via a single
CAT-5e cable. Connect the Gigabit Ethernet port of the first BLADE directly to the
Gigabit Ethernet port of the second BLADE. No Ethernet switch is required. Power up
both BLADEs, and at the “BLADE ID: DISABLED” start up screen, scroll the encoder
knob through the various IDs and select “SNAKE A” for the first BLADE. Hint: if you
scroll the knob backwards (counterclockwise) you will get to the “SNAKE A” selection
much quicker. Repeat the process on the second BLADE and select “SNAKE B” for the
second. An indicator LED on the front panel will light up to signify the BLADE is in
snake mode.
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 Once the BLADEs complete their boot up process and  their display shows
“WHEATNET-IP”, the sources from BLADE one are automatically connected to
the destinations from BLADE two and vice versa. In other words, source 1 from
BLADE 1 is connected to destination 1 in BLADE 2, source 2 from BLADE 1 is
connected to destination 2 in BLADE 2, etc. Likewise, source 1 from BLADE 2
is connected to destination 1 in BLADE 1 and so forth for a total of 32 channels
of audio (16 one direction and 16 more the reverse direction) over a single
CAT-5e cable, which, by the way, is much less expensive and easier to manage
than an old 32 channel audio snake would be. Plus the transport mechanism is
digital, which is less susceptible to noise pick up.

WheatNet-IP / Nov 2009
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Network

Network mode is used to create complete audio networks of multiple BLADEs,
control surfaces, and other devices. In this mode every BLADE is a member of the
network and is identified with its name and ID. The BLADE ID is crucial to proper system
operation; each member of the network must have a unique ID number. This number is
a simple decimal number (from ID=1 to ID=99) that is chosen by the user when the
BLADE is first started up.
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The ID number has no special significance, only that it needs be unique. You can
choose any number in any order. For simplicity, and to avoid unintentional dupli-
cates, Wheatstone recommends that you give the first BLADE started up ID=1, the
second, ID=2, and so forth. If you prefer you can create your own numbering scheme
such as the BLADEs in studio 1 are ID=10, ID=11, ID=12, etc., while the BLADEs
in studio 2 are ID=20, ID=21, ID=22, etc. As an aside, each BLADE can also be
given an 8 character name and location to help identify it in the system.

In network mode each BLADE is a member of the network, so of course there
must be a network in the first place. This is the Ethernet LAN (Local Area Network)
created with the Ethernet switch(es) and CAT-5e cable infrastructure. Creating and
managing a LAN is beyond the scope of this manual, but a few things must be taken
into account. First, the WheatNet-IP system uses fixed IP addresses for each
BLADE, therefore your LAN must have the required IP addresses available. Second,
the WheatNet-IP system comes configured with a default IP address scheme to make
it easy to configure; the default addresses are 192.168.87.100 through 192.168.87.199,
corresponding to BLADE ID=1 to BLADE ID=99. Third, to make sure that audio can
be streamed throughout the network without disruption, the bandwidth and traffic
patterns on the network must be carefully controlled. For these reasons, Wheatstone
strongly recommends that the WheatNet-IP system and its various components be
isolated (either physically or virtually) on its own LAN using the default IP
addressing scheme. If this is done, a good sized WheatNet-IP system can be brought
up and streaming audio in less than an hour.

To use network mode, first locate and mount each BLADE where you intend to
use it. Connect the Gigabit Ethernet port on each BLADE to an available Gigabit
Ethernet port in your LAN with a CAT-5e cable. The best practice is to locate your
largest Ethernet switch in a central area such as your TOC or Rack Room. If your
system is fairly small, only a few studios, then a single 1 Gigabit Ethernet switch in
your rack room might be enough. In that case a CAT-5e cable from each BLADE to
this central switch is all you need. Just remember that every device in the system, each
BLADE, control surface, and PC, must have its own Ethernet port available, so a
single central Ethernet switch can get filled up in a hurry. It’s more common to use
small 1 Gigabit Ethernet switches located in each studio as edge switches. In this
case, all of the devices in one studio are connected to its edge switch, and then all of
the edge switches are in turn connected to a central 1 Gigabit Ethernet switch.

In either case, each BLADE must be connected to the network. Power up the first
BLADE, and it will boot up into the System Wizard start up mode showing
“BLADE ID: DISABLED” flashing on the front panel display.
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Scroll the encoder to “1” and press the front panel switch; the front panel display will
show the default IP address of “192.168.87.101”. Once again, press the switch to accept the
IP address.

The display will show “I/O TEMPLATE: MONO_IO.” There are three signal templates
for WheatNet-IP 88a, 88ad, and 88d that the BLADE will use for automatically defining the
signals related to the input and output jacks. By turning the knob you can choose
“MONO_IO” to define all 16 inputs and outputs as mono signals, “STEREO_IO” to define
all inputs and outputs as eight stereo pairs, or “CUSTOM,” in which case no signals are
automatically defined. Choose “CUSTOM” only if you need a combination of mono and
stereo signals within the BLADE. You’ll have to do more work and define the signals
yourself.

For WheatNet-IP 88m there are two signal templates available. Choose from
“MONO_MIC” which creates eight microphone inputs and eight mono outputs, or
“STEREO_MIC” which creates eight microphone inputs and four stereo outputs.

WheatNet-IP / June 2010
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For Wheatstone‑IP 88cb there are three templates available. Choose the “Console_
Stereo_In” template to create all of the needed signals for your E‑1 control surface. 
When using this template the input signals are created as stereo sources. This template 
maps all of the Program, Headphone, Cue, and Monitors signals.

Choose the “Console_Mono_In” template to create all of the needed signals for your 
E‑1 control surface. When using this template the input signals are created as Mono 
sources. This template maps all of the Program, Headphone, Cue, and Monitors signals. 

Choose the “Custom” template to create your own layout.               

Scroll to your desired choice and press the switch to select it.
The BLADE display will show “CONNECTING...” while it completes its configu‑

ration process. That’ all there is to it, you can move on to the next one. 

Once it has configured itself, the display will show the “WHEATNET-IP” message. 

By the time you’ve finished the last BLADE, you will have created a complete 
working audio network system, with all signals defined with their default names.

In network mode, the front panels on each of the BLADEs function much as they 
do in stand alone mode. You can choose input or output meters, you can make/break 
connections, you can use the headphone jack to monitor, etc. And of course, this mode 
is where the value of the Navigator GUI is most apparent, letting you view and control 
the entire system. We will go into more detail about network mode in the next section.

A special note about control surfaces and mix engines. In the WheatNet‑IP system, as 
in Wheatstone’s other networked audio systems, each “input” to a control surface (fader 
1, fader 2, etc.) is defined as a system destination. That way, sources can be crosspoint 
connected to these inputs just like any other destination. Conversely, every mix “output” 
from a control surface (PGM A, PGM B, Cue, etc.) is defined as a system source, again 
so any other system destinations, such as your processors, codecs, and amplifiers can 
be crosspoint connected to these mixes. This makes it very easy to connect any source 
device into a mixer and to pick up the mix at any destination anywhere on the network; 
no Distribution Amplifiers or break out boxes are needed. You can even use one control 
surface as a submixer, say for several microphones in a talk studio, and then pick up 
the mix on a fader on a different control surface.

When you first run the System Wizard on an engine BLADE, a few things happen 
differently. Because there are no physical audio outputs on an engine BLADE, there is 
no signal template to choose. The Wizard will add the engine BLADE into the system 

WheatNet-IP / Jan 2013
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without creating any audio signals. So where do the mixer signals come from?
When you associate the engine BLADE to a particular control surface (this is done
on the network info screen on the control surface; see the control surface manual),
the engine BLADE automatically queries the surface for the number of fader
channels, mixes, etc. that it is configured with and creates the matching source and
destination signals in the engine BLADE. It adds default signal names for all of
these signals, identifying them with the control surface; of course, just like any
other signal, you can rename them as you please.

WheatNet-IP / June 2010
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             WheatNet-IP Front Panel Menu Diagram

WheatNet-IP / June 2010
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WheatNet-IP Networks and What They Do
Let’s look at a WheatNet-IP network in more detail. What exactly is an

“WheatNet-IP network?” Simply put, it is a collection of WheatNet-IP devices and
driver equipped PCs connected together via an Ethernet LAN. In a WheatNet-IP
network, each device is represented as a “BLADE” with a unique BLADE ID.
Each WheatNet-IP rackmount unit is a BLADE, each control surface rackmount
engine is a BLADE, and even each driver equipped PC is a BLADE. The Navigator
GUI gives a Windows Explorer style device tree
system view showing all of the devices currently
connected in the system.

You’ll notice in the example at the right that there
are eight WheatNet-IP rackmount units connected in
this system, with IDs 1 - 8. You’ll notice 3 and 7
control surface engines, with the control surface at
IPs 192.168.87.203 and 192.168.87.207 associated
with them. Finally, you’ll notice PCs with IDs 95 and
96 connected as well; these are typically your Auto-
mation PCs, but in the WheatNet-IP system each is
represented as a PC style BLADE.

This system tree view given by the Navigator GUI
is a very handy tool for monitoring your system. It
sure beats scrolling through a long list of names from
the front panel of a BLADE. It will always show your
system connection status. This is a very important
point and indicates a big feature of the WheatNet-IP
system. Every WheatNet-IP network system is dy-
namic. Devices can be added to it or removed from it
at will, in real time, just like computers in your LAN.
As you add a WheatNet-IP device to the network (by
plugging it in and assigning it a BLADE ID) it’s
associated signals are also automatically added and
made available to the system. They will show up in
the front panel displays of other BLADEs, and insert
themselves into the crosspoint grid of the Navigator
GUI. No complicated configuration or IP management is required; the BLADEs
take care of it all for you.

Should you need to remove a device (say because you want to borrow it to use
elsewhere), no problem. Just unplug it from the network and it and its signals will
automatically “disappear.” Later on, if you want to add it back in, again no
problem. Just plug it back in and use the same BLADE ID it previously had when
it was in the system. It will reappear in the network with all of its old signal names,
logic connections, silence detect settings, etc. The distributed intelligence of the
WheatNet-IP system “knew” it was missing and reserved all of the information for
when it came back. You don’t have to reconfigure anything.

So what does this WheatNet-IP network actually do? Actually, quite a lot of
things. First and foremost, it transports audio from one device to another, or others.
It matters not whether the devices are analog or digital, rackmount BLADEs or
PCs or control surfaces. Once an audio signal is present in the system, it can be

WheatNet-IP / June 2010
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made to appear anywhere else with the scroll of a knob or the click of a mouse. That’s
all there is to it; go to the destination you want the audio to appear at and click on the
source channel you want to appear there and you’re done.

There are some purpose-built extensions to this arrangement. Perhaps you would
like a particular destination, say an air chain, to be protected from unauthorized
connection changes. You can “lock” a connection and password protect it so it can’t
be changed. Control surfaces automatically issue a temporary connection “lock”
whenever they are On-Air, so someone doesn’t disconnect a source while it is
playing out a program channel.

WheatNet-IP / June 2010
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Maybe you want to restrict connection choices in some places. After all, a large
system can have hundreds and hundreds of sources available. Why force your Air
talent to scroll through hundreds and hundreds of names looking for the few choices
he actually needs to have? You can create a “visibility” list  so he sees only what you
want him to. Each of the hundreds of destinations can have its own visibility settings.

WheatNet-IP / June 2010
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Audio connections can also be combined into groups. We call these salvos. A
salvo can be an assortment of up to 120 connections. Once defined, all of these
multiple connection changes can be initiated with a single mouse click. These salvos
can also be programmed to fire from logic connections or control surface buttons,
making it easy to manage large changes. They can even be programmed to fire based
on time of day from the Event Scheduler software.

WheatNet-IP / June 2010
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Audio connections can be mixed, or
combined together. That’s obviously what
a control surface is for. You assign various
sources to the fader channels (in the
WheatNet-IP system, console fader chan-
nels appear as destinations just like physi-
cal outputs do) and combine them into
different buses and/or outputs, which can
then be sent on to other destinations (again,
in the WheatNet-IP system, all of the mix
buses and console outputs appear as
sources, just like physical inputs do). This
is a huge advantage in system design,
because you don’t need to buy physical
inputs or outputs for your consoles, nor do
you need to buy distribution amps to get the same signal to multiple places. You need only
one connection for each physical input or output device (say a microphone or speaker) and
the WheatNet-IP network takes care of the rest.

But control surfaces aren’t the only ways you can combine signals in the WheatNet-IP
system. After all, a control surface can be a fairly expensive proposition if all you need to
do is mix a few channels together. So each rackmount BLADE includes two built Utility
Mixers. Each mixer can select up to eight WheatNet-IP network sources, and provides two
stereo buses which become available throughout the WheatNet-IP network. Each mixer
channel has a separate fader for each bus output in the same mixer. The mixers are
configured with the Navigator GUI, with the mixer inputs showing up in the crosspoint grid
as destinations and the mixer bus outputs showing up as sources. And, for simple summing,
such as combining the left and right channels of a stereo source into a mono destination, the
WheatNet-IP system does that too.

WheatNet-IP / June 2010
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What about when an audio connection 
goes bad? You’ll be pleased to know that 
each physical output destination in each and 
every BLADE has the ability to automati-
cally detect silence and, if need be, switch 
to an alternate source defined by you should 
the silence endure for longer than a specified 
period. Furthermore, it can be programmed to 
automatically switch back when the audio is 
restored. You can use this extensive capabil-
ity to map out multiple levels of automatic 
failover to enhance your system’s reliability. 
If a program output from a control room goes 
away, you can switch to an alternate. If a mix-
minus feed to a remote drops out, you can feed 
him a back up. If your entire network goes 
down, you can have the BLADE that feeds 
your air chain switch to a backup playback 
machine and start it playing. Because every 
output on every BLADE has this capability, 
you can layer as many levels of failover as you care to.

Consult the Navigator GUI section of this manual for specific details on audio signals, 
connections, salvos, mixing, and more.

There’s more that the WheatNet-IP network can do besides transport audio. It can also 
transport logic changes. No modern broadcast facility can operate without logic control. 
This is what lights a warning light when a studio goes On-Air, mutes a speaker when 
a microphone turns on, starts a playback machine when a console button is pushed, or 
starts a recording when a relay is closed. The WheatNet-IP network 
transports logic change information between every BLADE, control 
surface, and PC that is attached to the system, via the same CAT-5e 
LAN connection and Ethernet switch used for audio. You don’t need 
to add anything. Each physical BLADE has 12 general purpose logic 
connections that can be individually mapped as inputs or outputs. 
Each control surface has a number of automatically defined logic 
functions (Start, Stop, On, etc.) for each fader, as well as a num-
ber of programmable buttons and indicators, plus an assortment 
of mutes, tallies, and other functions. Between the jacks on the 
BLADEs for physical connections, plus all of the virtual ones on 
the control surfaces, just about any logic function you need can be 
accomplished. On top of that, Wheatstone can provide dedicated 
switch panels for host and talent locations, some of which contain their own scripting 
language for creating complex conditional logic configurations.

E-6 Surface

GP-4 Panel
GP-16 Panel

WheatNet-IP / Oct 2012
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Logic functions in the WheatNet-IP system
come in a number of different types. First there is
the simple but direct self contained functions that
are typically found in consoles and control sur-
faces. “If this mic channel is on then mute the
control room output” and “if this channel is
turned on then start the timer” are examples of
direct logic. In the WheatNet-IP system, these
functions and many more similar ones are pro-
grammed in the VDIP screens of the control
surfaces.

A second type of logic in the WheatNet-IP
system is audio associated logic. A “START” or
“STOP” command for a playback device or an
“ON” or “OFF” command for a
microphone channel is an example
of audio associated logic. What we
mean by audio associated is that the
particular logic function is “associ-
ated with,” or “belongs to” the au-
dio signal being programmed. For
instance, playback deck 1 of your
Automation PC has a START com-
mand reserved only for deck 1, and
playback deck 2 has a similar
START command reserved for
deck 2. If you make audio connec-
tions between these playback decks
and faders 1 and 2 of a control
surface, how can you use the buttons on the surface to activate the playback? In the
WheatNet-IP system, audio channels can have these common logic functions
“associated” with the audio such that any other device (such as a control surface for
instance) that has matching logic functions associated with it will allow the logic
functions to work as long as there is a crosspoint connection (which is of course
necessary for the audio to flow) between
them. Audio associated logic is very pow-
erful, because the “associations” take care
of most of your common logic functions
without lots of physical wired connections
or undue programming. In the WheatNet-IP
system, as many as 12 logic functions can
be attached to each audio signal.

A third type of logic in the WheatNet-IP
system is discrete logic. In this case you
have some input device somewhere that
needs to control some output device some-
where else. A profanity delay DUMP but-
ton is a good example. This is where the 12
physical logic connections on each BLADE

WheatNet-IP / June 2010
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come in especially handy. In the WheatNet-IP system, you can create a special
class of signal called “LIO only.” These signals appear in the crosspoint matrix as
logic “sources,” i.e. switches, and logic “destinations,” i.e. relays or indicators.
When a logic source is cross connected to a logic destination, via the Navigator
GUI for instance, then the logic state of the source will affect the logic state of the
destination; the switch will fire the relay. No actual logic wiring between the
switch and the relay is required, it all happens (with sub millisecond latency, by
the way) over the LAN.

A fourth type of logic function in the WheatNet-IP system is called “action
logic.” This is where you want some kind of system action to be controlled by a
logic state. An example of this might be switches that are programmed to fire a
salvo, or make a connection, or recall a control surface preset. Action logic is easily
programmed with the Navigator GUI and is described in detail along with the other
logic types in the GUI section of this manual.

One of the most challenging parts of any logic system is getting it all right,
making sure the senses, polarities, timing, and connections are all correct. In the
WheatNet-IP system we provide a number of useful tools to help. First of all, logic
pin outs, functions, and polarities can all be changed with a click of a mouse. You
can also specify what you want a logic connection to do when it’s disconnected (go
to a specific state or retain its last setting), and then change your mind about it later.
Each logic input or output is fully independent and not linked into a scheme or
template that uses them up needlessly. The
physical logic connections on each BLADE
are fully programmable; they can be all inputs,
all outputs, or any combination. Changing
them is simple via the Navigator GUI. The
GUI provides on-screen indication of logic
state changes so you can see that your buttons
are actually triggering the right ports. The
BLADEs themselves have a logic test display
mode that will show the state changes on
every logic input or output. They also have a
front panel indicator (GPIO) that goes off
when any logic state is changed, so you can see
that your logic programming is getting through

WheatNet-IP / June 2010
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to the correct BLADE. Best of all, the WheatNet-IP logic functionality is a completely
integrated part of the WheatNet-IP system itself and does not require the Navigator GUI
or any other PC to be running to make it work. The GUI is needed only for programming.

There is one last feature of a WheatNet-IP audio system that should be mentioned.
Because WheatNet-IP is based on standard network models, the system has SNMP
capability. Simple Network Management Protocol is a standard built into some
networked devices to allow for a third party remote program to query them and retrieve
important information regarding the status and operation of the networked devices.
Depending on its complexity and set up, this remote program can acquire statistics, issue
alarms, and even send email reports of the systems functionality. Consult the “Ethernet
Networks and Switches” chapter of this manual for more information regarding the
SNMP capability of WheatNet-IP systems.

The above descriptions of the functionality of the WheatNet-IP system are a brief
overview of what it can do. For more details about these functions and others, please
read the Navigator GUI section of this manual.

WheatNet-IP / June 2010
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Ethernet Networks and Switches
Overview

The underlying network plays a major role in the successful deployment of your
WheatNet-IP system. In the IP audio world, the Ethernet network is the analog of
the punch block wall in a traditional broadcast plant. As such, careful consideration
should be given to network topology when planning the installation. Because the
size and type of network you design and deploy directly depends on the amount of
WheatNet-IP and surface hardware you are installing, it is wise to build a network
that has reasonable overhead and room to grow as formats and audio distribution
needs change over time.

Gigabit Ethernet Technology
The WheatNet-IP system uses 1000BASE-T gigabit Ethernet technology

exclusively to transport audio and control packets between BLADEs. Because the
WheatNet-IP system uses gigabit connectivity, the possibility of link overload is
drastically reduced when compared to competing 100BASE-TX systems. Each
Gigabit connection is capable of handling literally hundreds of audio streams, along
with associated GPIO, system configuration, and network monitoring capabilities.
Advantageously, the cost of gigabit technology is rapidly decreasing due to
economy of scale benefits gained by cross application use of the technology.

Choosing Ethernet Switches
There are literally hundreds of choices of Ethernet switches on the market today.

Chances are you have a compatible switch in your facility already. However it is
recommended that the WheatNet-IP network be isolated from any existing network
using separate switches or a unique VLAN on existing switches.

The primary design concern you face is whether to use managed or unmanaged
switches, and the amount of Ethernet audio hardware you deploy ultimately drives
this decision. Further reasons for selecting one over the other are described in detail
after the basic feature considerations listed below.

Switch Feature Considerations
• 10/100/1000 Ports - When looking at switches, make sure all the ports support

full-duplex 1000BASE-T connections. Some switch models are touted as
Gigabit, but really only have one or two 1000BASE-T ports.

• Hubs - Packets entering a hub or repeater are broadcast out of every other port
on the device. Gigabit hubs must be avoided because they are a single collision
domain and can slow your GbE audio network to a crawl. If you find a really
good deal on a Gigabit “switch” be sure it is not really a hub.

• Throughput  - Is an important specification when deciding on a Gigabit switch.
Throughput is the amount of cumulative data traffic a switch is capable of
transceiving. Ideally an eight port 1000BASE-T switch should incorporate an
8Gbps non-blocking switch fabric. Low throughput switches typically use
input buffering techniques susceptible to Head-Of-Line blocking which can
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adversely affect the real time performance of medium to large IP audio
networks.

• Rack Mounting - Rack mounting is a useful option for most broadcast
systems.

• Chassis Based - Large enterprise systems may benefit from installing or
expanding existing chassis based managed switch solutions.

Unmanaged vs. Managed Switches
An unmanaged Ethernet switch is a low cost WYSIWYG device and has no

configuration software interface. Most unmanaged switches do not support
IGMP snooping and will therefore act as repeaters to IP audio multicast packets,
effectively flooding all ports with audio packet traffic. Unmanaged switches are
relatively inexpensive, though, so in very small systems this may be a perfectly
acceptable cost vs. performance compromise.

Managed switches, on the other hand, allow users to configure the switch
hardware with a software interface of some kind, such as Telnet, Web, Terminal,
etc. Primary configuration features applicable to your Ethernet audio network are
the ability to configure VLAN’s, IGMP management, built in diagnostics, and
routing. We highly recommend the deployment of managed switches throughout
the network.

Managed switches fall in to several market niches. Low end managed
switches, or “Smart Switches,” offer some configuration, but may not provide the
level of configurability required in a medium to large Ethernet audio network. For
example, these switches may forward IGMP host messages and multicast traffic
but can not act as the IGMP router. In medium to large applications at least one
switch capable of being the IGMP Querier is required. Mid-priced managed
switches are better suited to the task and will provide more configuration
flexibility.

In larger systems it makes sense to employ a “core and edge” model. This type
of system balances the switching horsepower (cost) according to the throughput
requirements at different physical segments of the network. Lighter bandwidth
“edge” segments can use lower cost switches, while central rack room “core”
segments utilize higher performance devices.

Rules of Thumb
The WheatNet-IP system will work with a minimum number of devices on an

unmanaged switch. If the system is to include more than six BLADEs, two
Control Surfaces, and two PC drivers it is recommended that an IGMP compliant,
managed switch be used.

In large systems, careful attention must be paid to the placement of core and
edge switches.

• Each I/O (88a, 88d, 88ad) BLADE requires 36.9Mb/s for eight Stereo
connections.

• Each I/O (88a, 88d, 88ad) BLADE Requires 73.7Mb/s for 16 Mono
connections.
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• Each Engine (e) requires 147.5Mb/s for 32 unique stereo connection streams.
• Each E-6 surface requires a 100Mb/s Ethernet connection.
• Each Surface requires an Engine (e) connected to the same GbE switch.
• Each PC driver requires 19.6Mb/s for eight Stereo outputs.
• An aggregate of eight BLADEs (64 streams) requires roughly 295Mb/s of
bandwidth when each BLADE have eight stereo connections.

The Multicast channels used by the WheatNet-IP System are as follows:
• one per audio source
• one for system announce messages
• one for metering data
• one for Logic messages

What's on the Wire?
The WheatNet-IP system uses the standard 1000BASE-T gigabit Ethernet

hardware infrastructure to distribute audio, logic, and control over copper UTP
CAT-5e or CAT-6 cable. Because the WheatNet-IP system uses a standard, non-
proprietary Ethernet network for connecting devices, the digital audio network
supports the universal suite of Ethernet protocols, including TCP/IP, HTTP, FTP,
Telnet, SNMP, RTP, IGMP, etc.

The WheatNet-IP system software utilizes RFC standards initially developed
for VoIP applications to synchronize and distribute packetized audio between
BLADEs (nodes), control surface processing, and PC's. Specifically, the Internet
Group Management Protocol (IGMP) is used to manage the distribution of
multicast audio packets, which are integral to WheatNet-IP design.
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Designing the WheatNet-IP Network

Where to Start
Before you buy any network equipment, it may be beneficial to sketch out or

formally draw a block diagram of your system. A few typical system block diagrams
are included later in this chapter for your reference. Note the number of Ethernet ports
required, wire length estimates, potential Ethernet switch locations as well as the
number of BLADEs, PC drivers, and control surfaces. Remember this exercise is
intended to give you a general idea on what physical topology might work best in your
facility so it is probably best not to get bogged down in the details. This information will
also help guide you in network hardware purchasing decisions.

Many small Ethernet audio network applications may be assembled without much
preparation or difficulty while medium to large systems will require careful planning
to eliminate potential bottlenecks. When designing your Ethernet audio network it is
useful to consider the following parameters:

• Scope - Does the network design meet current interconnectivity requirements?
• Physical Infrastructure - Topology, switch placement, CAT-5e/CAT-6 cabling.
• Throughput - Is there enough switching throughput?
• Headroom - Is there room for growth built into the network?
• Applications - Will this be an audio only or shared use network?
• Serviceability - What is the maintenance plan?
• Monitoring - What network monitoring software tools are required?
• Remote Access - Is there a secure path to remotely monitor or troubleshoot the
network?

Cabling
The wiring requirements for the WheatNet-IP system follow the specifications for

1000BASE-T set forth in IEEE 802.3ab. That specification calls for UTP CAT-5e or
CAT-6 cabling, jacks, and patch cables to be used throughout the network. When wiring
with CAT-6 cable, use CAT-6 rated RJ-45 connectors that are designed to accommo-
date the thicker wire insulation. Note that unlike common 1000BASE-T/100BASE-TX
Ethernet networks, the 1000BASE-T gigabit networks use all four twisted pairs inside
the cable. This specification requirement makes the system less tolerant of problems
stemming from sub-standard wiring installation. Because Auto-negotiation is part of
the 1000BASE-T specification either straight or crossover cabling may be used. We
recommend that all cables be wired identically simply to avoid potential confusion.

One often overlooked but critical step in the installation of Ethernet networks is
Certification. Poor installation methods can easily degrade your CAT-6 cabling into
CAT-3 performance. It is recommended that all Ethernet audio network cable runs and
patch cords be certified onsite to confirm that wiring patterns, bandwidth, and cable
length all meet specifications. This relatively easy but important step gives you peace
of mind and can save hours of troubleshooting time chasing connectivity and bandwidth
problems.
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GbE Network Cabling Guidelines
• 1000BASE-T Standard - All four twisted pairs are used.
• Use UTP CAT-5e or CAT-6 cable exclusively.
• Use the correct connectors for the cable type.
• Certify all end to end runs and patch cables.
• 100M (328ft) port to port distance limit.
• Auto-MDI/MDI-X supported on GbE switches.
• CAT-6 crossover wiring pattern differs from CAT-5.
• Switches may be linked with fiber using GBIC modules.

1000BASE-T vs. 1000BASE-TX
Note that these very similarly named standards specify different wiring methods.

The prevailing Gigabit Ethernet 1000BASE-T standard uses all four pairs of wire,
while the outdated 1000BASE-TX standard uses only two pairs. To add to the
confusion some products marketed as 1000BASE-TX may actually be 1000BASE-T
designs.

Wireless Connectivity
Wireless routers of the 802.11ab/g/n variety are currently not up to the task of

reliably distributing multicast audio at the data rates required by the system. A
wireless access point could be added to the network for administration, monitoring,
or remote access purposes.

Configuring the Network
The WheatNet-IP system is very friendly when it comes to network configuration.

By default, BLADEs will configure their IP Address and Multicast parameters
automatically based on the BLADE ID number. This auto-configuration method is
similar to the Dynamic Host Configuration Protocol (DHCP) used on many Ethernet
networks to configure PC wired and wireless NIC’s on power up. A provision for user
override of this functionality is provided for customers wishing to manually configure
their network.

Configuring your WheatNet-IP network breaks down into four categories:
• Managed Switch configuration
• BLADE configuration
• Surface configuration
• PC Configuration

Managed Switch Configuration
At first glance, the number of configuration options for a managed switch can be

overwhelming. Luckily, there are only a few parameters that need to be configured on
the managed switch to set it up for WheatNet-IP multicast traffic.
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Default LAN Parameters

• IP Address Settings - set the IP address of the core switch or WheatNet-IP
VLAN to 192.168.87.1.

• Stacking switches - give each subsequent switch an IP address on the same
subnet.

• VLAN’s - modern managed switches allow the user to segment any number
of ports into a VLAN or Virtual Local Area Network. This collection of ports
is identified by a static base IP address and Subnet mask and, more impor-
tantly, constitutes a discrete Broadcast Domain. Segmenting a network into
discrete Broadcast Domains allows you to control which ports send and
receive the Multicast audio packets. VLAN’s may be segmented across
multiple managed switches connected to the core switch. Most switches that
are capable of VLANs come out of the box with a default VLAN configured.
You must assign an IP address to the default VLAN. For Sample Configura-
tion Refer to the “Configuring a Cisco 2960” section in the Appendix 3.

• IGMP - IGMP will need to be enabled on the switches or VLAN’s designated
for the WheatNet-IP system. Settings may vary among switch manufacturers.
When configuring Standard and Advanced IP services always refer to the
switch documentation for setup specifics. For Sample Configuration Refer to
the “Configuring a Cisco 2960” section in the Appendix 3.

• Spanning -Tree Portfast - It is recommended that Portfast be enabled only on
switch ports connecting to a single BLADE. This allows the BLADE to join
the network immediately on power up, bypassing the listen and learn states.

Note: If you enable Portfast on a port connecting another network device such
as a switch, you can create network loops. Use Caution when enabling Portfast.

BLADE Configuration
The Quick Start Guide provides details on quickly setting up a BLADE. Note

that some of the parameters listed below will automatically be created based on the
BLADE ID number you enter.

Important! Before you plug the BLADE into the Network, set a unique
BLADE ID.

The following parameters must be configured on a BLADE.
• BLADE ID number - this device number must be selected and entered by the
user on each BLADE in order to uniquely identify the BLADE in the system.

• IP addressing - all WheatNet-IP devices use dynamic IP addressing based on
their BLADE ID number. Each device is given an IP address in the
192.168.87.xxx scheme, starting at .101 for the box with BLADE ID 1 and
so on.

• You can override the automatic setup and have full control over IP address-
ing.

• Subnet Mask - the default 255.255.255.0 subnet mask will work in most
systems. This allows for 254 devices on the audio network.
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• Gateways - gateways may be employed for remote access and routing
purposes.

• Ports - The system uses the following TCP/IP Ports - See Table Below:

PORT PURPOSE
80 HTTP-Web Configuration Interface
23000 Telnet to Play Service
50000 GUI Connect
50100 Metronome Multicast Stream
51000 Web/XML Multicast Stream
52000 Announce Channel Multicast Stream
52001 Logged Channel Multicast Stream
52002 Meter Multicast Stream
55776 Automation Control Interface
60000 Surface Channel

Surface Configuration
Surface configuration is very easy using a mouse and VGA monitor connected

directly to the control surface. When first powered up, a surface will ask you to
configure its network parameters.
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To configure the network settings for the E-Series
surface select “YES” from the dialog box. The
surface will now display the Options Tab’s Network
Settings screen, where you will set the Mix Engine ID
and IP address of the Engine to which the surface will
connect, along with the Surface IP Address (on the
default 192.168.87.xxx scheme), Subnet Mask, and
Gateway.

If Automatic mode is selected, enter the Mix Engine ID of the WheatNet-IP Mix
Engine to be associated with the surface and remaining settings are configured for
you. You can manually enter this information by pressing the Manual button and
using the numbered keypad on the screen. Pressing NEXT will advance to the next
field.

For convenience, Wheatstone uses the following convention for IP Addressing
in the WheatNet-IP system:

1. The IP Address of a BLADE is equal to the BLADE ID plus 100; i.e.,
BLADE 3 = 192.168.87.103

2. The IP Address of an E-6 control surface is
equal to the Engine BLADE ID plus 200; i.e.,
Engine BLADE = 5, Surface IP Address =
192.168.87.205

When done simply press APPLY to finalize
these settings and the surface will request a reboot.

Select YES from the dialog box and the surface
will reboot.

WheatNet-IP / June 2010
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Once the surface has been rebooted navigate to the Options Tab and select Network
Settings from the drop down menu. If all information was entered properly the
BLADE STATUS will display “CONNECTED.” The E-Series surface has been
successfully configured.

PC Configuration
The WheatNet-IP PC Driver is a WDM driver that supports up to eight Stereo

Output and eight Stereo Input streams. The driver eliminates the need for expensive
sound cards. Each driver Output/Input is displayed in Windows as a unique sound
device and can be controlled using the Windows mixer or any audio application that
accesses sound cards.

Driver Installation - The driver may be installed on any Windows PC running
Windows XP Service Pack 2 and higher. Please refer to the Appendix 6 of the manual
for detailed installation and configuration information.

Network Interface Card (NIC)

It is recommended that a multi-home connection method be used on PCs that need
to be connected to an office LAN while also connecting to the WheatNet-IP network.
This will require a second NIC in the PC. There are many types of Network Interface
Card on the market. While many of them may work for this application there may be
some that do not perform well under such demanding conditions. Intel and Broadcom
cards perform very well in this environment.

WheatNet-IP / June 2010
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There are a few settings that can help improve the performance of many of the
available cards:

• Disable Windows Power management on the Interface card.
• Set the Speed and Duplex to Auto negotiate (Default).
• Disable the Windows firewall.
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                           Typical Medium Network Block Diagram
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                           Typical Large Network Block Diagram
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Network Troubleshooting
A variety of free software based tools can be effective in verifying, maintaining and

troubleshooting network performance and configuration. Some rudimentary network
testing may be done from the Command line in a DOS window using standard Internet
Control Message Protocol (ICMP) commands built into Windows shell. A freeware or
full blown network analysis program can be valuable when troubleshooting medium to
large installations. Many managed switches include built in port traffic analysis using
a web interface to the hardware.

Useful ICMP Commands
• Ping - Use this command to confirm that a device at a specific IP address is actually
“talking” on the network. At the C:\>  prompt  in a command window type ping
xxx.xxx.xxx.xxx where the x's are the IP address of the device.

• TraceRoute - Use this command to find the path a PC takes to get from point a to
b. At the C:\>  prompt  in a command window type tracert xxx.xxx.xxx.xxx where
the x's are the IP address of the destination you are tracing.

• Ipconfig - this is actually a console application in Windows that will display the
network parameters configured for any network interface card installed on the PC.

Software Tools
• WheatNet-IP GUI & Web Interface - These Wheatstone applications access
configuration, status messaging, and error logging of all connected WheatNet-IP
hardware.

• WireShark  - This freeware (GNU) Network Protocol analyzer offers a compre-
hensive look at network traffic down to the packet payload level.

• Telnet - Used to open a Debug portal on a BLADE or surface. Use the built in
Windows Telnet client or any third party client.

• FTP - Used to transfer files to and from surfaces. We recommend using a third party
FTP client like Mozilla's Filezilla.

• SNMP - Third party software can monitor the devices using SNMP. The MIBs
created for the BLADE will allow users to monitor things like last boot time,
Internal Temperature, Network Traffic, etc.

Simple Network Management Protocol (SNMP)
SNMP forms a part of the internet protocol suite defined by the Internet Engineering

Task Force (IETF). Network management systems use SNMP to monitor network
attached devices such as BLADEs for conditions that may require action by the end user.

SNMP uses a manager/agent model that presents the information to the end user. A
software component called the agent runs on the network device and sends the
management information to the managing system. The managing system is the appli-
cation that the end user needs to organize the information. The manager and the agent
use a Management Information Base (MIB) and a small command set to exchange
information.
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The WheatNet-IP system provides information such as Uptime, Transmit
and Receive packets, CPU utilization, and others. This information can be
useful in locating potential issues and correcting the issues before they have an
impact on the performance of the system.

Hardware Status Indicators
Check that your hardware meets the following parameters
• Switch LED's - no link Led’s: check wiring is CAT-5e or better, check
switch port configuration is GbE compliant, patch cables, full duplex,
certify wiring.

• NIC Issues- confirm NIC’s are GigabitE, check IP config on PC.
• BLADE LED indicators- See Table Below.

STATUS LED FUNCTION
Gigabit Link Gigabit Link established with switch
Alarm            Alarm status
WheatNet OK BLADE loaded and functioning
Input Meters Front panel meter monitoring inputs
Output Meters Front panel meter monitoring outputs
System Master BLADE has been voted route master for the

                                                       system
Clock Master BLADE has been voted the master clock

                                                       reference for the system
44.1K 44.1K Sample Rate selected
48K 48K Sample Rate selected
Snake Mode BLADE connected in Snake mode another

                                                       BLADE
GPIO Flashes when there is GPIO activity
Error Trouble with BLADE configuration

WheatNet-IP / Jan 2010
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Error Logs
In the WheatNet-IP system there are several places you can view logs to aid

in troubleshooting. The PC GUI and Web Interface provide system wide logging
to help pinpoint where a problem may exist. The PC GUI also has an “Alarms”
section that displays any message that may require user attention such as silence
detection notification.

PC GUI Log
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Silence Detected on Output

Web Interface Log

Alarms
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WheatNet-IP Navigator GUI

Description
The Navigator GUI is an optional software program designed to administer and

manipulate WheatNet-IP networked audio systems. The use of this program is
strictly optional, however we strongly recommend it because it makes many system
functions much easier. Anyone who has tried to spell out a name via jog wheel and
switch on a video game will appreciate how much easier it is to simply type it —
especially if there are hundreds of names.

To use the Navigator GUI, it must first be installed on a PC running Windows XP.
This program uses substantial computing power, especially in a large system, so we
recommend using a computer with at least a 1.8GHz P4 processor and 1G memory.
Insert the program CD into the drive on the PC and run the installer program. Accept
all of the suggested defaults unless you have experience with this program and have
specific requirements. After the installer has completed its process, it will leave a
shortcut to the Navigator GUI on your desktop. Double-click on the shortcut to
launch the program. Before launching the program, you must make sure that the IP
address of the PC is compatible with the WheatNet-IP system. It must have a fixed
IP address on the .87 subnet.

The first thing the program does after launching is to query the network the PC
is connected to for any WheatNet-IP system present. This is an important thing to
understand. Because WheatNet-IP networks, by their nature, are dynamic, the
Navigator GUI can’t know ahead of time what the network will be; it must inquire
every time it is launched. This process takes anywhere from a few seconds for a
small system up to a minute or so for a larger one. You can actually watch this
process take place as the GUI discovers BLADEs and adds them to its list.

At the end of the discovery process you will see one of two things. First if the GUI
could not find any BLADEs, it means that there is no WheatNet-IP system on its
network. Usually this means that your PC is not actually plugged in to the network,
or that your PC is running on a different subnet than the WheatNet-IP system.
Remember, the default IP settings for BLADEs are all on the .87 subnet; this means
your PC must have a fixed IP address of 192.168.87.xxx where xxx is any number
not used by a BLADE or other member of the network. Wheatstone recommends
192.168.87.20 for the Navigator GUI PC. Go to the TCP/IP properties under the
Network Properties section on the Windows Control Panel and verify/change the
settings.

Secondly, if the PC has been addressed properly, in the left hand pane of the main
GUI window, you will see a list of all the BLADEs the GUI was able to discover.
In the center of the main window will be a password log-on window. Initially the
GUI has no password assigned, so just click OK for now. Later on you can assign
a password to prevent unauthorized modifications.
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Using the Navigator GUI

The main window of the GUI is divided into several parts. Along the left hand 
edge are three smaller panes, one above the other. These three panes show the sys-
tem view, the alarms view, and the details view. Their functions will be described 
shortly, but for now, just note that they are there, and that you can move and resize 
them as you would with many Windows programs.

To the right of the three stacked panes is the main 
program window. Note that it has a number of tabs 
along its top, which when clicked on, will switch the 
main window to a number of different views. Another 
point to note is that the main window’s views are also 
dependant on which part of the system you are looking 
at. To familiarize your self with the action of the various 
views, first click on the WheatNet‑IP System 0 icon in the 
System pane. The main window will show information 
about the overall system, depending on which of the tabs 
in the main window have been selected. 

Before we get into the tabs, take a moment to experi-
ment with the system pane. If you’ve connected properly 
(remember, because WheatNet‑IP networks are dynamic, 
each BLADE must be powered up and plugged into the 
LAN to be visible in the system pane) all of the BLADEs 
in your system will show in the system pane.

Each BLADE is shown with an icon and BLADE 
ID number. If it is the System Master, the designation  
“(Master)” will be shown beside the icon. If it is the 

TITLE BAR

S
Y

S
TE

M
 V

IE
W

MAIN PROGRAM WINDOW

A
LA

R
M

S
 V

IE
W

D
E

TA
IL

S
 V

IE
W



W H E A T N E T - I P  N A V I G A T O R  G U I

page  4 – 5WheatNet-IP / Apr 2009

Clock Master, a BLADE wave image will be overlaid on the icon (more on
System Master and Clock Master later). If the BLADE is a mix engine
BLADE, then the icon will show a control surface icon attached to it, with the
IP address of the corresponding control surface. If the BLADE is a streaming
PC BLADE, say one of your Automation Playback machines, the icon will
change to represent a PC. Note that for a PC to become a part of a
WheatNet-IP system and work with WheatNet-IP audio streams it must first
have the WheatNet-IP PC driver software installed on it. Information about
this is provided in the appendix of this manual.

If there are too many BLADEs in your system to all show at once in the
system pane, you can use a scroll bar on the right side of the pane to move
through the list of BLADEs.

Now take a moment and temporarily unplug the
network connection from one of your BLADEs. You’ll
notice in the system pane window of the GUI, the icon of
that BLADE has been overdrawn with a yellow question
mark. This is to let you know that a BLADE was a
member of your system but has become unavailable. If
you ever see this during normal system operation, look
for an unplugged network cable, or check to see if the
power has been removed from a BLADE or a network
switch. A short time after you plug the network cable
back into the switch, the yellow question mark will
disappear, indicating that the BLADE is available again.

To illustrate the dynamic nature of the WheatNet-IP
system, quit the GUI by clicking in the close box at the
upper right corner of the GUI window (not the system
pane window, please). Unplug one of the BLADEs and
relaunch the Navigator GUI. Once the discovery process
has been completed, if you check the system pane, the
BLADE you unplugged will be missing from the list, as
will all of its sources and destinations. Plug the BLADE
back in, and after a short while, the BLADE and its
sources and destinations will automatically get added
back in. You have a dynamic network.

Now let’s get back to the tabs.
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The first tab is labeled “System Crosspoint.” It shows a grid with
system sources (their eight character names) running horizontally

along the top, and the system destinations (again their eight character names) running
vertically along the left side. The signal names are shown in different colors, matching the
color of their BLADE icon in the system pane. Any connections between sources and
destinations are shown by a dot  at the grid intersection of the source and destination. To make
a connection, click on an intersection. An audio connection will be made and a dot will form
at the intersection. To break a connection, click on the dot and it will disappear, as will the
audio connection. If your system is larger than a couple of BLADEs, then the crosspoint grid
will have scroll bars along the bottom and right sides, allowing you to scroll the grid view
to see every part of your system window. There’s much more you can do here but for now
just understand the basics.

The second tab is labeled “System Salvos/Macros.” If you click
on this tab, you will again see a crosspoint grid except that the words

“Salvo Edit Screen“ are shown in the background and some buttons have appeared above
the grid. This is the screen used to create, edit, and execute Salvos (ganged simultaneous
connections). More on this later.
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The third tab is labeled “System Info.” This is the screen where system
clock rate, date and time, and passwords are set.

The fourth tab is labeled “System LIO Properties.” This screen
is where you can define the states of various logic functions.
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The fifth tab is labeled “System Config Manager.” This screen
is for archiving and restoring system information.

The sixth tab is labeled “System Preferences.” This screen is used
to control the viewing and colors of various parts of the main System

Crosspoint Window. You can specify colors for the dots and highlights, BLADEs and signal
names, salvo indicators, etc.
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The last tab is labeled “System Log.” This screen shows the logging of
various system messages. More on this later.

Experiment with clicking on the various tabs until you become familiar with what they
contain. Now comes the good part. Over on the system pane, click on a BLADE icon. The
main window changes from a system view to a BLADE view, and there are nine new tabs
showing information about the particular BLADE you clicked on. The tabs are “Sources,”
“Destinations,” “Visibilities,” “LIO Info,” “Silence Detect,” “Virtual Mixer,” “Network

WheatNet-IP / Jan 2010
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Info,” “Version Manager,” and “Config Manager.” They provide lots of functions and
information about the particular BLADE. Again, more on this later.

Of course, if you now click on a different BLADE in the system pane, the main
window will show you nine more tabs representing the BLADE you just clicked on.

In this manner you can look at/work on each individual BLADE in the system. Now
go back and click on the system icon in the system pane and select the System
Crosspoint tab. Click on one of the destination signal names along the left side of the
grid and notice the information that appears in the “Details” pane. Essentially
everything you would like to know about that signal appears in the Details pane: what
its name and ID are, what BLADE it’s in, what mode it is, which jacks it uses, what
source is crosspoint connected to it, and more. Each time you click on a source or
destination name, its information is reflected in this Details pane.

Finally note the Alarms pane normally located just below the system pane. The
Alarms pane is a text area that shows a message whenever an alarm function, such as
Silence Detection on a particular output, happens.

The System pane, Alarms pane, and Details pane are all scrollable and resizeable
in typical Windows fashion.
You can also drag and relocate
them on the screen, or dock

them back to their default locations using the dock buttons along the top of the screen.
In addition to the System, Alarms,

and Detail dock buttons, the top of the
screen contains buttons for Set Up View,
XPoint, and About WheatNet-IP. These
buttons activate navigation shortcuts that will take you to some commonly used areas
of the Navigator GUI program.

In the WheatNet-IP system, the mechanism for showing a subset of all of the system
audio signals is called filtering. You can specify certain search criteria or functions, and
the software will restrict the crosspoint grid to show only those signals that fit the
criteria. In a large system with hundreds or even thousands of signals, filtering is a way
to reduce the amount of scrolling you need to do while navigating on the crosspoint
grid. Some common filters might be “show only the signals in BLADEs 2 and 14,” or
“show me only my mono signals,” or “show me only logic signals.” As you might
expect, you can combine the criteria to create a complex search that significantly
reduces the number of signals that meet it.
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Open the “Set Up Crosspoint Views” window by clicking on
the “Set Up View” button at the top of the screen.

In the window you will notice a list of the currently defined filters, along with some
buttons used to create, rename, or delete them. If the list appears empty, then no filters
have yet been defined. Click on the “New” button and a new filter having a default
name is added to the list. Click the Rename button to open a dialog box that allows you
to rename the filter. Type a name that will help you recognize the filter later such as
“BLADE 1” or “Morning Show,” click “OK,” and the window will change to show
you the criteria you can specify for your filter. As you click on various check boxes
to specify criteria, notice how the source and destination signal lists change to reflect
the filter’s effect once you’ve also created a view (see below). Obviously, if you make
your filter too exclusive, the signal count will dwindle to zero and the filter will
therefore be useless. After all, what good is a filter that removes all of the signals from
view, leaving nothing but a blank screen? Don’t hesitate to experiment with defining
a few filters and seeing how they work. You can always delete them later.

Once you have created a filter, you need to assign it to a view before you can use
it. A “View” is simply a collection of one or more
filters, and is useful for combining filters for a
more complex set of criteria.

Initially, as in filters, no views will show in
the list until you have created them. Click on
“New” to create a view; you can use the “Re-
name” button to give it a special name.

Once you have defined one or more views,
click on the view name to highlight it. Then, in
the Filters list, click on the check boxes to enable
the desired filter function(s). Enabling the view
by right clicking on the WheatNet-IP logo on the
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crosspoint grid will give you a new crosspoint grid view with the signals reduced to only
those that meet the criteria.

One final note about filters: If you are having trouble locating a signal on the
crosspoint grid, make sure you haven’t inadvertently enabled a view that excludes it.
Right click on the WheatNet-IP logo and Choose View / No View to be sure.

Clicking on this button opens a crosspoint grid window on a
floating palette. This can be a very handy function when you are
working on a part of the system GUI and need a quick look at the

grid to check on some signal or connection information. You could close down
whatever window you are working on and go to the “System Crosspoint” tab, but that
might mean leaving your work unfinished. Instead, try clicking on the “XPoint” button
and opening this floating grid window. You can position it where you like on the screen
and use it for reference as you continue your work.

Predictably, this button opens a
window displaying the version infor-
mation for the WheatNet-IP Naviga-
tor GUI program.

Now you have learned the basics of navigating around the WheatNet-IP Navigator
GUI. It makes no difference if your WheatNet-IP system has two BLADEs in it or a
hundred, they are all treated the same way.
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An Important Point About WheatNet-IP Systems - The System Master

Because the WheatNet-IP system is dynamic, there needs to be some mechanism
to arbitrate and maintain the specifics of the system con-
figuration from moment to moment. “Somebody has to be
in charge!” In the WheatNet-IP system, we don’t rely on a
PC for this role; the entire system is fully functional
without any PCs. Since all BLADEs are electrically iden-
tical (except for their specific audio I/O ports) the system
has been architected with a distributed intelligence. Each
and every BLADE has enough on-board intelligence to
control the whole system by itself. During initial set up,
one of the BLADEs in the system is automatically selected
to be System Master. It is this System Master BLADE that
gathers all of the information from the BLADEs, control
surfaces, and PCs that belong to the system. The Master
BLADE then redistributes all of this information back to
every BLADE. The Master BLADE and all of the others
keep this information in flash memory so it is not lost when
the power is turned off. What this means is that every
BLADE is fully capable of running the entire system at any
moment. In fact, if the Master BLADE is lost for any
reason, a new BLADE will be elected as Master and
seamlessly take up running the system. The
beauty of this architecture is the depth of backup
and redundancy automatically provided. Es-
sentially there are as many backup hosts in the
system as you have BLADEs; you can never
lose your system because a host controller went
down. The need for archiving is also greatly
reduced, because there is a system copy resid-
ing in every BLADE. It’s like having a RAID
array of hosts. If you look carefully at the list of
BLADEs in the System Pane, you will see one
of them designated as the current System Mas-
ter. There is also a front panel LED indicator
that lights to show that the BLADE is function-
ing as the System Master.

Similarly, the system will also have a Clock Master, responsible for synchronizing
timing throughout the system. If a Clock Master has been designated via the System
Info tab (see later in this chapter) by assigning a Primary External Reference, then that
BLADE will be indicated in the System Pane by the “BLADE wave” icon - see
BLD008 in the example shown. If, however, no such assignment is made, the system
will self-designate a Clock Master and flag it as such in the System Pane. Once again,
a front panel LED lights on the designated BLADE.

Note that in a single BLADE system the one BLADE will serve as both the System
Master and the Clock Master.
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Navigator GUI System Windows in Detail

System Crosspoint Tab

This window is the main crosspoint window for the GUI. It is used to make/break/
view crosspoint connections. In a LAN based audio network, just what is a crosspoint
connection? After all, there is no audio router or patch bay to make audio connections.
Simply put, a crosspoint connection represents a message that a particular destination
(i.e. network address) wants to subscribe to the multicast packets representing a
particular audio stream. The Ethernet switch obliges by forwarding those packets along
to the subscribing device. In the Navigator GUI, this is shown as a dot at the grid
intersection of the source (multicast stream) and destination (subscribing device).

In the most basic view, the System Crosspoint window shows all of the system
sources across the top and all of the system destinations vertically on the left. The default
view has these signals shown first in numerical order of the BLADEs, and alphabetically
by signal name within the BLADE. Furthermore, each BLADE has a color, and the
BLADE’s signals are shown printed in matching color. This is meant to help identify
which signals go with which BLADE.
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SYSTEM CROSSPOINT DETAILS MENU
There are refinements to the basic view that

come in very handy. If you right click on the
WheatNet-IP logo of the system crosspoint win-
dow, a popup window with four sub-menus will
appear.

Choose View
Various filters can be defined to restrict the

crosspoint view of the system. This is useful when
you have a large system with hundreds of signals
and want to work on a small section of it. The filter
manager tool of the GUI (see the SetUp View
button discussion) allows you to define filters
based on BLADE ID, signal type (mono, stereo,
logic only), location, sources, or destinations, and
assemble them into Views. The Choose View
menu allows you to specify any of the views you
have defined, and the crosspoint grid will immediately shrink, removing those signals not
part of your selected view.

Hint:  if you know you have a signal in your system but it is not appearing in the
crosspoint grid, right click on the WheatNet-IP logo and select Choose View / No View.
Chances are your signal will now appear in the grid - your filter setting was excluding it.

Destinations Sort By
This menu allows you to change the order in the crosspoint grid for the destination

signals. The choices are:
BLADE Id - Name - This is the default. The destinations show in order of BLADE ID,
then alphabetically by name.
BLADE Id - Pin  - The destinations show in order of BLADE ID first, then connector
number.
BLADE Id - Location  - The destinations show in order of BLADE ID, then alphabeti-
cally by location name.
Name - BLADE ID - The destinations show alphabetically by name first, then by
BLADE ID. Useful for when you use a name like “CD 1” over and over.
Name - Location - The destinations show alphabetically by name first, then by location
name.
Location - BLADE ID  - The destinations show alphabetically by location name, then
by BLADE ID.
Signal ID - The destinations show in order of their system assigned signal ID.

Sources Sort By
This menu allows you to change the order in the crosspoint grid for the source signals.

The choices are:
BLADE Id - Name - This is the default. The sources show in order of BLADE ID, then
alphabetically by name.
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BLADE Id - Pin  - The sources show in order of BLADE ID first, then connector
number.
BLADE Id - Locatio n - The sources show in order of BLADE ID, then alphabetically
by location name.
Name - BLADE ID - The sources show alphabetically by name first, then by
BLADE ID. Useful for when you use a name like “CD 1” over and over.
Name - Location - The sources show alphabetically by name first, then by location
name.
Location - BLADE ID  - The sources show alphabetically by location name, then by
BLADE ID.
Signal ID - The sources show in order of their system assigned signal ID.

Show
This menu allows you to change the information showing in the grid labels for each

signal. The choices are:
Name - This is the default. Only the eight character name is shown on the grid label.
Name - Location - Both the eight character name and eight character destination are
shown on the grid label.
Signal Id - Name - Both the system assigned signal ID and the eight character name are
shown on the grid label.

DESTINATION DETAILS MENU
You have already learned how to make

and break crosspoint connections from the
grid. Here are some more things you can
do. By right clicking directly over the
name of a destination, you can bring up the
destination details menu.

This menu allows you to access some
very common functions:

Choose View
This is same function as mentioned

previously. Various filters can be defined
to restrict the crosspoint view of the sys-
tem. This is useful when you have a large
system with hundreds of signals and want
to work on a small section of it. The filter
manager tool of the GUI allows you to define filters based on BLADE ID, signal type
(mono, stereo, logic only), location, sources, or destinations and assemble them into Views.
The Choose View menu allows you to specify any of the views you have defined, and the
crosspoint grid will immediately shrink, removing those signals not part of your selected
view.

Hint:  if you know you have a signal in your system but it is not appearing in the
crosspoint grid, right click on the WheatNet-IP logo and select Choose View / No View.
Chances are your signal will now appear in the grid - your filter setting was excluding it.
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Destinations Sort By
This menu allows you to change the order in the crosspoint grid for the destination

signals. The choices are:
BLADE Id - Name - This is the default. The destinations show in order of BLADE
ID, then alphabetically by name.
BLADE Id - Pin  - The destinations show in order of BLADE ID first, then connector
number.
BLADE Id - Location  - The destinations show in order of BLADE ID, then
alphabetically by location name.
Name - BLADE ID - The destinations show alphabetically by name first, then by
BLADE ID. Useful for when you use a name like “CD 1” over and over.
Name - Location - The destinations show alphabetically by name first, then by
location name.
Location - BLADE ID  - The destinations show alphabetically by location name,
then by BLADE ID.
Signal ID - The destinations show in order of their system assigned signal ID.

Show
This menu allows you to change the information showing in the grid labels for each

signal. The choices are:
Name - This is the default. Only the eight character name is shown on the grid label.
Name - Location - Both the eight character name and eight character location are
shown on the grid label.
Signal Id - Name - Both the system assigned signal ID and the eight character name
are shown on the grid label.

Rename Signal
Choosing this function will open up a “Rename Signal” window. You will use this

function a lot to replace the system auto-generated signal names with names that have
more meaning for you. Here you can type a new name, up to eight characters long, for
the signal. As soon as you click on the “OK” button, the new name will be broadcast
throughout the system and get updated everywhere.
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Modify Signal

Choosing this function will open the “Destination Signal Wizard” window. You will
also use this function frequently, at least in the beginning. This wizard is used to attach
logic, map the audio to the connectors, set up silence sensing, and define the signal type
(mono, stereo, etc.). During initial configuration of the BLADE, the System Wizard will
assign default values for these items; Type Info = Mono or Stereo, dependant on which
signal template you chose, Wire Info = in order, i.e. signal 1 will be mapped to connector
position 1, signal 2 will be mapped to connector position 2, etc., Silence Detect, if enabled
via the checkbox, = -40 dBFS threshold and 20 seconds duration, and LIO Info = none.
You can navigate between these functions by clicking on the tabs at the top of the window.

Type Info: The choices are 5.1 Surround, Stereo, Mono, or LIO only (LIO stands for
Logic Input or Output). The first three choices are for various kinds of audio, while the
fourth, LIO only, is for discrete logic
signals as described in the logic section.
You can also use this window to change
the signal name, if desired. Finally, there
is a check box that will enable the Si-
lence Detect function for this destina-
tion signal.

Wire Info:  The actual physical con-
nection of the audio destination signal.
For an all mono BLADE, the first out-
put connection on a BLADE is called
“Wire 1” and the last output connection
is called “Wire 16.” If the BLADE is all
stereo, the first output connection is
called “Wire 1 LT” and the last output
connection is called “Wire 8 RT.” These
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wire numbers correspond to the connection numbers on the wiring diagrams, and also
the rear panel silk screening on the BLADE chassis, and define the connector you need
to plug into to get the signal. The system defaults to the first signal on the first connector,
etc., but you can map them any way you like by selecting the wire in this screen. Note
that if you try to map a destination to a connector that has already been used, the GUI
will alert you to the error.

Silence Detect: This function,
when engaged, continuously moni-
tors the destination signal for audio
content. If the signal falls below the
specified threshold for longer than
the specified duration, then various
things can happen. First, a silence
detect alarm will be issued and shown
in the “Alarms” window of the GUI.

A logic signal can be triggered, and if “Auto Failover” has been selected, a secondary
source you have previously defined will be switched to the destination. Finally, if “Auto
Failback” has been selected, then the destination will be switched back to the original
source if audio has been restored for at least as long as the specified duration. Use this
window to define these parameters. Note that for silence detect to work, it must first be
enabled in the “Type info” window by clicking the check box, and the secondary source
must be defined using the GUI “Silence Detect” tab for the individual BLADE.

LIO Info:  This window shows
the parameters for audio associ-
ated logic for the signal. Up to 12
functions can be defined and at-
tached to the audio signal. To ac-
tivate an audio associated logic
signal, click on the LIO Info tab of
the signal Wizard screen. Select
“Add” from the right side of the
window. Now select the logic port
you wish to configure by clicking
on the appropriate wire. Select the
direction (Input or Output) and
assign a function (machine start,
on tally, etc.) from the drop down
selection. When you are done click
Apply, then Finish. If you find
that your logic works backwards, you can click on the “Invert” check box to reverse the
sense of the logic. You cannot change the settings in a connected signal.

WheatNet-IP / Jan 2010
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Lock Signal
Select this function to “lock” a

source connection to this destina-
tion. Once locked, a connection can-
not be broken without the proper
password access to the Navigator
GUI. A locked connection is shown
on the crosspoint grid as a red line
from the destination across the grid.

SOURCE DETAILS MENU
In a similar fashion, if you right click over

any source name on the crosspoint grid, you
will open the source details window.

This menu allows you to access some very
common functions:

Choose View
This is same function as mentioned previ-

ously. Various filters can be defined to restrict
the crosspoint view of the system. This is useful
when you have a large system with hundreds of
signals and want to work on a small section of
it. The filter manager tool of the GUI allows you
to define filters based on BLADE ID, signal
type (mono, stereo, logic only), location, sources, or destinations, and assemble them into
Views. The Choose View menu allows you to specify any of the filters you have defined,
and the crosspoint grid will immediately shrink, removing those signals not part of your
selected view.

Hint:  if you know you have a signal in your system but it is not appearing in the
crosspoint grid, right click on the WheatNet-IP logo and select Choose View / No View.
Chances are your signal will now appear in the grid - your filter setting was excluding it.

called “Wire 8 RT.”
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Sources Sort By
This menu allows you to change the order in the crosspoint grid for the source

signals. The choices are:
BLADE Id - Name - This is the default. The sources show in order of BLADE
ID, then alphabetically by name.
BLADE Id - Pin  - The sources show in order of BLADE ID first, then connector
number.
BLADE Id - Location  - The sources show in order of BLADE ID, then
alphabetically by location name.
Name - BLADE ID - The sources show alphabetically by name first, then by
BLADE ID. Useful for when you use a name like “CD 1” over and over.
Name - Location - The sources show alphabetically by name first, then by
location name.
Location - BLADE ID  - The sources show alphabetically by location name,
then by BLADE ID.
Signal ID - The sources show in order of their system assigned signal ID.

Show
This menu allows you to change the information showing in the grid labels for

each signal. The choices are:
Name - This is the default. Only the eight character name is shown on the grid
label.
Name - Location - Both the eight character name and eight character location
are shown on the grid label.
Signal Id - Name - Both the system assigned signal ID and the eight character
name are shown on the grid label.

Rename Signal
Choosing this function will open up a “Rename Signal” window. You will use

this function a lot to replace the system auto-generated signal names with names that
have more meaning for you. Here you can type a new name, up to eight characters
long, for the signal. As soon as you click on the “OK” button, the new name will be
broadcast throughout the system and get updated everywhere.



W H E A T N E T - I P  N A V I G A T O R  G U I

page  4 – 22WheatNet-IP / Apr 2009

Modify Signal

Choosing this function will open the “Sources Signal Wizard” window. You will
also use this function frequently, at least in the beginning. This wizard is used to
attach logic, map the audio to the connectors, and define the signal type (mono,
stereo, etc.). During initial configuration of the BLADE, the System Wizard will
assign default values for these items: Type Info = Mono or Stereo, depending on
which signal template you chose; wire info = in order, i.e. signal 1 will be mapped
to connector position 1, signal 2 will be mapped to connector position 2, etc.; and
LIO info = none. You can navigate between these functions by clicking on the tabs
at the top of the window.

Type info: The choices are 5.1 Surround, Stereo, Mono, or LIO only (LIO stands
for Logic Input or Output). The first
three choices are for various kinds of
audio, while the fourth, LIO only, is
for discrete logic signals as described
in the logic section. You can also use
this window to change the signal name,
if desired.

Wire info:  The actual physical con-
nection of the audio destination signal.
For an all mono BLADE, the first input
connection on a BLADE is called “Wire
1” and the last input connection is
called “Wire 16.” If the BLADE is all
stereo, the first input connection is
called “Wire 1 LT” and the last input
connection is called “Wire 8 RT.”
WheatNet-IP / Dec 2009
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These wire numbers correspond to the connection numbers on the wiring diagrams,
and also the rear panel silk screening on the BLADE chassis, and define the
connector you need to plug into to get the signal. The system defaults to the first
signal on the first connector, etc., but you can map them any way you like by selecting
the wire in this screen. Note that if you try to map a source to a connector that has
already been used, the GUI will alert you to the error.

LIO Info:  This window shows the parameters for audio associated logic for the
signal. Up to 12 functions can be defined and attached to the audio signal. To activate
an audio associated logic signal, click on the LIO Info tab of the signal Wizard
screen. Select “Add” from the right side of the window. Now select the logic port you
wish to configure by clicking on the appropriate wire. Select the direction (Input or
Output) and assign a function (machine start, on tally, etc.) from the drop down
selection. When you are done click Apply, then Finish. If you find that your logic
works backwards, you can click on the “Invert” check box to reverse the sense of the
logic. You cannot change the settings on a connected signal.

WheatNet-IP / Jan 2010
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System Salvos/Macros Tab
In the WheatNet-IP system, you can group up to 100 connection states into a

“Salvo” and then trigger the one Salvo instead of the 100 individual connections.
This capability is especially useful for systematic events involving multiple
connection changes. Going from your late night automated set up into your
Morning Drive Show is a good example. It may involve switching out automation
from your air feed, bringing in a control surface, a bunch of mics, switching
headphone feeds, connecting automation playback decks, etc. The good news is
that this set up tends to be the same every day. Go ahead and group all of these
connections into a Salvo, and instead of all the patching and cross connecting you
would have had to do in the old analog days, you can simple click on a menu
selection (or press a button if you map the Salvo to an LIO port) and make these
wholesale changes quickly and reliably. It’s one of the great benefits of having
a networked system in the first place.

Here’s how to do it. Click on the Salvos/Macros tab, and a new window opens.
It shows a crosspoint grid with scroll bars, like you have seen before, but there are
differences. A new button area labeled “Salvos” has appeared on screen between
the system tabs and the crosspoint grid itself. Also, the grid background shows
the legend “Salvo Edit Screen,” and any dots on the grid representing connections
will be in a new color. By the way, the trick you learned earlier about right-
clicking on the WheatNet-IP logo on the crosspoint grid also  works here. It will
bring up some of the same menus that change how the signals are labeled and
sorted on the grid (by name, ID, etc.). Any of the filters you’ve defined for
restricting the crosspoint view will also be usable on the salvo grid.
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In the left part of the salvo button area is a selection window. Initially it will say
“Salvo 1 (empty).” As you define Salvos, their names will appear in this selection
window. Executing a Salvo is simply a matter of scrolling through the list in this
selection window to highlight the desired Salvo, and then clicking on the “Fire”
button. Don’t be alarmed if you don’t see any crosspoint changes on the grid;
remember this is the Salvo Edit Screen. You can click on the System Crosspoint tab
(or use the floating Crosspoint window) to verify that your connection changes
actually happened.

Click back on the System Salvos/Macros tab if you aren’t already there and click
on the “New” button in the salvo button area. A blank grid will appear, and a new
salvo name, “Salvo x” will be added to the salvo selection window where “x” is the
next salvo number available. In the case of the first salvo created, the default name
will be “Salvo 1” and so forth. Click on the button labeled “Editable” to highlight
it. Click on any source - destination connections you want to include in your salvo
and a dot will appear on the appropriate grid intersection. If you have any
destinations you simply want to disconnect and not use, right click on the destination
name and select “Disconnect Destination;” a solid line will be drawn across the grid
at the destination, indicating that there are no sources connected to the destination.
When you are finished, you can click on the button labeled “Rename” if you would
like to overwrite the default salvo name with something more identifiable, say for
instance “Morning Show.” A good name for the salvo is very useful in other parts
of the Navigator GUI, such as the LIO mapping area where you can assign salvos
to buttons. You’ll see a list of salvo names exactly as shown here in the salvo select
window.
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A few final hints about salvos. When you switch to the System Salvos/Macros tab,
the screen will go to the view from the last time the salvo window was opened. Also, if
you find you can’t change connections on the grid, make sure you’ve clicked the
“Editable” button first. We’ve chosen to make the salvo edit process take two steps so
as to avoid inadvertent changes caused by accidental mouse clicks during casual viewing.
Finally, salvos are executed very quickly; however, there is a sequence to them.
Connections changes are made in the order they were created in the salvo, so if the order
is important to you, keep this in mind while creating the salvo.

System Info Tab
Clicking on the System Info tab removes the crosspoint grid from the main part of the

GUI screen and opens a new window. Within this window are four subwindows used for
setting up important system functions.

Clock Master Info
In the WheatNet-IP system, in

order to keep all of the audio chan-
nels in all of the connected BLADEs
and PCs synchronized, one of the
BLADEs is designated as “system
clock master.” This is something that
is normally done automatically by
the system at start up time, but this
window allows you to deliberately
specify the clock master. Why would
you want to do this? In the case where you are trying to synchronize the entire system to
some external AES master clock. By feeding the external clock reference into AES
input 8 of one of your digital BLADEs and selecting that BLADE in the “Primary
External Reference” window, you will force the system to slave off of the timing
reference on input 8 of the designated BLADE. We chose input 8 as the reference input
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because the external clock reference chews up an audio channel, and input 8 seems less
valuable than, say, input 1. Note that you can also specify another BLADE to be a
“Secondary External Reference” for back up. In this case if you provide the same AES
reference signal to the secondary clock master BLADE, the system will stay locked
to the external reference should the primary clock master BLADE loose power or
otherwise go down.

This window also has two buttons to set the system clock rate to be either 44.1K
or 48K. While this selection is not so significant for AES digital input signals because
all AES inputs in BLADEs are equipt with sample rate converters, it does set the
sample rate of all of the system’s AES digital outputs. Most modern digital devices can
accept various sample rates, but there are still some out there (primarily Automation
PCs) that require a specific  sample rate.

Choose the settings you want in this window and click on the “Apply” button to
execute them.

How does this all work? The system will synchronize to the BLADE that is the
primary clock master. This will be indicated in the System Pane of the GUI by a
BLADE wave signal overdrawn on the appropriate BLADE icon. There is also a front
panel LED that will also be lit to show that the BLADE is the primary clock master.
That BLADE will use whatever AES signal that is connected to input 8 as the clock
reference; if there is nothing connected to input 8, or if the device connected to input 8
goes away, it will use its own internal reference. If the primary clock master BLADE
itself should power off, become disconnected, or otherwise cease to function, the
secondary clock master will take over so be sure to connect your external AES
reference signal to input 8 of the secondary clock master too if you need to keep the
system locked to the external reference.

Set Date and Time
This window is used to set up the date and time

of day for the WheatNet-IP system. There are two
modes the system can operate under, manual and
NTP. The mode is chosen with the “Adjustment:”
buttons.

In NTP mode, each BLADE and surface will
subscribe to a network time server and main-
tain date/time synchronization with the net-
work server.
In Manual mode, you have two choices. You
can specify the date and time yourself by
clicking a section in the window and clicking
on the up/down arrows to advance or back-
track the section, or you can take a short cut
and simply click on “use this PC’s time.” In
that case the time settings on the GUI PC will
be distributed to the BLADEs and control
surfaces. It will take a little while after making
your selection for everything to get updated.
The system date and time settings aren’t vis-

ible in the system during normal operation but

WheatNet-IP / Jan 2010
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you should still take the time to set this carefully. Each BLADE maintains a log
which can be useful for checking and troubleshooting problems. This log has a
date and time stamp on it that is derived from the system date/time. Also, each
control surface has a time of day display that is controlled by the system date/time.

Choose the settings you want in this window and click on the “Apply” button
to execute them.

Web Access
Each BLADE runs a web server while operational to allow easy access to

settings from a browser on any PC on the
network. The webserver provides three lev-
els of access, “admin,” “user,” and “guest,”
each of which can have a different password.
To set a password for one of these levels,
scroll the list to select the desired level and
then enter a password.

Once you have completed the settings
you want in this window, click on the “Set
Password” button to execute them. Users
attempting to log into a BLADE via their browser will be prompted for a password
which will restrict their access to the level you’ve specified. Default passwords
are identical to the User ID; that is, the default password for user admin is admin,
etc.

Front Panel Passcode
In a similar vein, you can restrict access to

all front panel functions of the BLADEs with
passwords, such as REBOOT, FACTORY
RESET, IP ADDRESS, etc. These are the
functions that can significantly alter the func-
tionality of a BLADE, so their access can be
controlled with passwords. The passwords
are all numbers because users will use the front panel encoder to enter them. Use
the up/down arrows or else type the numbers in directly to specify the password.
Useable values are in the range 0 - 255.

Once you have completed the settings you want in this window, click on the
“Set Passcode” button to execute them. Users attempting to log into the sensitive
areas of a BLADE via the front panel will be prompted for a password which will
prevent  their access unless entered correctly.

GUI Access Passcode Window
Here you can specify a passcode to be used to

allow system access from the GUI. When it is first
launched, the GUI opens a dialog box asking for a
password. If the correct password is not entered,
then system access is denied. The default is no
password.
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System 3rd Party Devices Tab
There are a number of products in the WheatNet-IP system 

that must be added to the System 3rd Party Devices tab in the 
Wheatstone WheatNet-IP Navigator program (aka the  Navigator 
GUI) to utilize their complete set of features. Such devices 
include certain Control Surfaces, Audio Processors, and some 
other control devices and system components.

You will need to know the IP address of the device being 
added, so you will want to find that out before you start.

With the Navigator GUI and with System 0 selected in the 
System pane you will see something like this:

Now, to the right of the System pane, select the System 3rd Party Devices tab.

Click the Add button to bring up the Add 3rd Party Device dialog:
Type in a convenient Name and insert the IP  Address 

of the device being added. Leave the TCP Port at the 
default setting of 60021. From the Host Blade drop 
down select the Blade that you want to associate the 
3rd Party device with. Click Ok.

This completes the process of adding the device to 
the System 3rd Party Devices tab. The added device 
should show up in the System pane under the Blade 
you added it to. If it does not show up, or if it shows 
up but has a yellow question mark on it, then there 
is either a network issue that needs attention, or the 
device is not connected to the network at all, or one or 
more steps have been omitted or done incorrectly in 
the configuration process.
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System LIO Properties Tab

This screen is used to set certain logic output function properties. The logic system
in WheatNet-IP works by using crosspoint connections between  logic inputs and
logic outputs to establish a logic path. If a logic source, for instance a switch,  is
crosspoint connected to a logic destination, say relay #1, and they both have been
defined with the same function (start, remote on, user 23, etc), then the switch will
trigger relay #1 as long as the crosspoint connection is maintained. If that connection
is broken and, instead, a connection is made to a different logic destination, say
relay #2, then the switch will trigger relay #2. The question then becomes “How
should a logic output behave when it is disconnected from a logic input?” The
Navigator GUI allows you to specify this behavior separately for each logic function
(starting with function User 1). This capability can be very useful with some types of
machines that also have front panel controls. These controls may not function if the
remote control logic ports of the machine are held in the wrong state. The choices for
the disconnected state of a logic output are:

High - When the output is disconnected from a logic input it will go high.
Low - When the logic output is disconnected from a logic input it will go low. This
is the default.
Last State - When the logic output is disconnected from a logic input, it will stay
in whatever state it was last in.
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To change from the default, select the logic function
desired from the scrolling list. Its disconnect state will appear
in the “Unconnected state:” window. Click on the button to
make your choice, then click on “Apply.”

The LIO Property: section of the window also has a
“Shared” check box. It is rather easier to explain the use of this
check box by first explaining what we mean by the opposite
term, “not shared.” The factory defined logic functions all
work in a “not shared” mode. This is best described using a
specific example from a system that includes one or more
surfaces.

Let’s say that you have a CD player signal with an
associated “Machine Start” logic output. This would typically
be the case when you want the CD player to begin playing a
cut when a surface fader’s ON button is pressed. But what
happens when that same CD player also gets assigned to a different fader, say
on another surface in a different studio? We normally would not want an ON
button press on this second fader to fire the Machine Start logic while the cut
is playing, possibly on air, on the first surface, since it might restart the cut,
or switch to a new cut. In fact, using the factory defined functions, like
“Machine Start,” we lock out control from additional faders when the first
fader is turned on, rather than “share” the logic signal.

Having said that, checking the “Shared” check box for a user defined
logic signal allows the signal to be shared among users of the signal. In the
above example, with both faders on, either fader’s ON button could fire a
shared user defined function at any time.
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System Config Manager Tab

This screen allows you to specify a directory on the GUI PC to be used to
Archive system information, to back up data to the directory, or restore data to the
system from the directory. As in any digital system, it’s a good idea to back up
critical information regularly.

In the WheatNet-IP system, there are two classes of data for archiving, system
data such as salvos, clock, date, and password information, LIO properties, and so
forth, and BLADE data such as signals, names, silence detect parameters, logic
port mapping, etc. The System Config Manager window has three sub windows:
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Config Folder
In this window you choose the specific

directory for the Archive. The default direc-
tory is shown in the box, or you can click on
the “...“ button to open another window to
browse for a different directory. If you decide
to change the default directory, browse for
and highlight the new one in the box and then
click the “Default” button.

Backup System Configuration
This window is quite simple. Click on the

“Backup...” button and the system informa-
tion will be sent to a new, automatically
named, directory created in the directory speci-
fied in the “Config Folder” window.

Restore System Configuration

This window is used for restoring data from the Archive back to the WheatNet-IP
system. In the right hand pane you select a directory to restore from. You are given four
choices of data in the “Restore:” section, Salvos, LIO Properties, Clock Settings, and
Date and Time Settings. Click on the check boxes to select any or all of these. In the
BLADEs section you can click any or all BLADEs to be stored.

Once you have made your selection, click on the “Restore” button.
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System Preferences Tab

This window is used to change the look and feel of the Navigator GUI. Within
it are several sections that control a number of default settings of the program. Click
on the System Preferences tab to open this window and you’ll note the selections:

Default View
Clicking in this box opens a drop down window listing all of your defined views.

Chose one of them to be the default and this view will automatically be applied every
time you open the GUI, showing the subset of the system as specified by the view.
This function can be useful if you regularly run the system in a partial state. Some
examples might be if you have a TV - Radio combined system and don’t want your
radio staff distracted by the TV half and vice versa. Or perhaps you are in a total
rebuild situation with some studios active and on-air while others are still under
construction; a situation all too common these days. Be cautious about applying a
default view as you can easily overlook the
parts of the system masked by the view. The
normal default view setting is “No View.”

Default Grid Labels
Clicking in this box will open a drop

down window with choices to set the information displayed as the crosspoint grid
labels. The three choices are:

Name - The signals are identified on the crosspoint grid by their eight character
user defined name.
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Name - Location - The signals are identified on the crosspoint grid by both their
eight character name and the eight character user defined location. Including the
location information helps keep track of the signals, especially if you have chosen
to use the same name for different signals.
Signal ID - Name - The signals are identified on the crosspoint grid by both their
signal ID and their eight character name. This mode is especially useful during set
up as each signal is clearly identified by its ID. These are set by the system and
absolutely unique. This setting is automatically selected when the GUI is installed.

Default Sort Order
This next section of the screen allows you to

specify a default sort order for the way sources and
destinations are displayed. The choices are:

BLADE Id - Name - This is the default. The
signals show in order of BLADE ID then alpha-
betically by name.
BLADE Id - Pin - The signals show in order of
BLADE ID first, then connector number.
BLADE Id - Location  - The signals show in
order of BLADE ID, then alphabetically by
location name.
Name - BLADE ID - The signals show alphabetically by name first, then by
BLADE ID. Useful for when you use a name like “CD 1” over and over.
Name - Location -  The signals show alphabetically by name first, then by location
name.
Location - BLADE ID  - The signals show alphabetically by location name, then
by BLADE ID.
Signal ID - The signals show in order of their system assigned signal ID.

Colors
The remaining sections of the System Preferences window have to do with

customizing the visual presentation of the crosspoint grid. Begin by making sure that
the “Use Style Sheet” check box has been checked. This tells the software to use richer,
more colorful graphics for the grid at the penalty of slightly slower performance. If this
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check box had not been checked, you will
have to restart the Navigator GUI soft-
ware after you change it. Most of the color
functions are disabled when the “Use Style
Sheet” box is unchecked. If you find that
your GUI doesn’t display colored win-
dows as have been shown in this manual,
chances are the “Use Style Sheet” box is
unchecked.

Clicking on any of the feature boxes
opens up a Select Color window, giving
you the opportunity to customize the fea-
ture color as you see fit. You have mil-
lions of colors to choose from.

By manipulating the colors of the
crosspoint grid you can radically change
the look of the GUI, from a bright, bold, hard to miss look
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to a soft, subtle, easy on the eyes look.

There are lots of possibilities, its all up to you.
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A Final Word About Colors

The Navigator GUI has been designed to simplify
the organization of large complex systems. To that end,
the system will automatically assign a different color
for each BLADE and its associated signals. That is to
say, as soon  as a BLADE is brought into the system, it
is given a color and the BLADE’s name will be listed
in the System Pane printed in this color. Additionally,
the BLADE’s source and destination names will ap-
pear in the crosspoint grid in this same color. This color
coding makes it easy to quickly identify visually which
signals go with which BLADE.

Now comes the good part. Because the System
Preferences window allows you to customize these
colors, you can set up your own color schemes for
identifying the signals. Because a WheatNet-IP system
can be brought up so quickly, you might have a little
extra time for organizing the GUI with colors. Here are
some suggestions:

Make each station’s part of your complex a differ-
ent color as in WXXX air, production, and talk
studios are all red, WYYY’s are all blue, WZZZ’s
are all green, and the common signals in your rack
room are all teal. You can further enhance the
presentation by making the different studios in the
station different shades of the same color, with the
Air studio brightest.
You can key your color scheme to physical location, such as all the BLADEs on
the first floor are one color, all the BLADEs on the second floor a second color,
and all the BLADEs in the rack room a third color. Again you can use degrees
of these colors to further distinguish them.
Another possibility is to use colors to designate functions, say, all analog
BLADEs are blue, all digital BLADEs are red, all analog/digital BLADEs are
purple, and all engine BLADEs are green.
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System Log Tab

In a large complex system, it is always a good idea to have some method of
viewing the sequence of recent system events. It can be very helpful for reviewing
and troubleshooting, especially during system installation and set up when the
system is unfamiliar and you’re not sure if your LAN set up is correct, etc. The
Navigator GUI provides a log window for viewing this information. This log is
accumulated until the number of entries matches the setting in the “buffer”
window, after which the earliest entries are discarded as new ones are received.

Because this log is continually being updated, it can be difficult to read. In that
case, click on the “save” button and a “save log as text file” window will open,
allowing you to give the log a name and save it to a directory. You can then review
the saved copy  without the hassle of lines scrolling out of view as you are trying
to read them. For saving a partial section of the log, you can drag over the section
to highlight it and then click on the “copy” button. The selected section of the log
will be copied to the clipboard and can subsequently be pasted into a text editor,
email, etc.
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Navigator GUI BLADE Windows in Detail
Earlier, when we were looking at the system pane, we noted that we could see an

icon for each BLADE connected in the system. If we left click on one of these icons
to select it, the GUI switches to the BLADEs info view and a whole new set of tabs
appear in the main window. These tabs are for functions and settings not at the system
level, but localized to the individual BLADEs. If you click on several different BLADE
icons you will see the same set of tabs appearing over and over, but the detailed
information within each tab changes from BLADE to BLADE. So the process becomes
one of clicking on a BLADE icon, verifying or modifying the settings for that BLADE,
clicking on the next BLADE icon, verifying its settings, and so forth until you’ve
looked at every BLADE. Because there are more tabs than fit across the top of the
window, horizontal scroll buttons appear at the right end of the row of tabs in the
BLADE info view, allowing you to scroll and view all of the tabs.
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BLADE Sources Tab

The first tab is the BLADE “Sources” tab. It is used for viewing and modifying
settings for the local audio inputs in the BLADE. The Sources window has three
main parts. Along the bottom of the window is an array of 16 bargraph meters and
individual level and balance controls for each source (Mono sources do not have
balance controls). These meters and controls are used to monitor the level and set
gain on the 16 inputs (or eight stereo pairs, etc.) coming into the BLADE. In the
upper left area of the main window is a section labeled “Source Signals:” and to the
right is the “Free Resources:” section. The Source Signals: section is where the
eight character input signal name and eight character input location names can be
seen and modified from their defaults. The Free Resources: section is where the
input signal characteristics (mono, stereo, logic, etc.) can be seen.

Source Signals
In this section you can see two columns; the first column, labeled “Name” is the

source name and the second matching column, labeled “Location,” is the source
location. Depending on whether the BLADE has been designated as a stereo or
mono BLADE at initial set up, there will be eight or 16 names in the columns. (If
the BLADE was originally set up as a custom BLADE, there will actually be no
source or location names showing until you first define the mono and stereo signals
you want — more on that later). If the BLADE is an engine BLADE, there will be
names for every available control surface input and monitor channel (depending on
the size of the associated control surface this can be as many as 32 or more).

WheatNet-IP / Jan 2010



W H E A T N E T - I P  N A V I G A T O R  G U I

page  4 – 42WheatNet-IP / Apr 2009

Assuming you are looking at BLADE 1 and you’ve
chosen the stereo signal template, the Source Sig-
nals section will look as shown here:

The first signal in the list (representing input #1)
is named “BL01S01” and its location is named
“Blade01.” These are the system default names and
they can be simply decoded. The “BL01” part of the
name is just shorthand for “Blade 1,” and the “S01”
is shorthand for “Source 1.” Thus the auto gener-
ated system name means “the first input in Blade 1.”
Likewise, “BL01S02” means “the second input in
Blade 1,” and “BL23S07” means “the seventh input
in Blade 23.” It’s not exactly Rocket Science and, in
fact, you can just leave things as they are and go with
the system default names if you like. But you can do
better. If you double click on a signal name, the
name becomes highlighted and you can retype it to
be anything you like. “BL01S01” becomes
“Guest 1,” or “Zephyr,” or “Rick,” or “Enco 1” -
you get the idea. As soon as you type a new name for
the signal, it appears everywhere in the system
under this new name. In other BLADEs, on the
crosspoint grid, on control surface displays, every-
where.

Likewise, the “Location” column has default
location names which are even more easily de-
coded; “Blade01” obviously means “Blade 1.” You
can leave these as they are because that pretty much
tells you the location of the signal, but if you want,
you can change the location to “ WXYZ Air” or
“rackroom” or whatever suits your fancy. Edit the
Location just as you did the Name, by double
clicking on it.

Free Resources
Resources to a BLADE mean audio and logic

signals. This section of the “Sources” window shows
the remaining available resources within the BLADE.
The first three line entries in this section indicate the
number of surround 5.1, stereo, and mono signals
sources, respectively, that have not yet been allo-
cated to the system, and are hence available for
allocation. Remember, each BLADE has a maxi-
mum total of 16 mono audio channels plus 12 logic
ports available. If you have used a standard mono or
stereo signal template when you first initiated the
BLADE, then all of the signals will have been
allocated automatically by the Startup Wizard to

WheatNet-IP / Jan 2010
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match the template, and the number available will show as zero. This is one of the special
features of the WheatNet-IP system; it can take care of all of this signal allocating and
defining automatically, saving you a lot of work.

If, however, you chose the Custom template, no signals will have been allocated, and
all will show as available in the resources list. As you define a new signal, the resources
available will decrease. Thus you can tell by looking at the resources list what additional
signals you could define for this particular BLADE.

Defining a new signal is easy. Click the “Add” button and the “Source Signal Wizard
- Add Signal” screen pops up. On the Type Info tab enter the Name, and optionally the
Location. Select the Signal Type
and accept the Packet Type as au-
tomatically selected. Next, switch
to the Wire Info tab. Highlight the
desired wire number (you must
pick one that is not already as-
signed), then click “Finish.” The
new signal name will now appear
throughout the system.

The same is true for the logic
ports. The default configuration
makes no automatic assignment of
logic ports, so all 12 are initially
available and show as LIOs. As
you allocate  logic ports for func-
tions, the resources decrease cor-
respondingly. The “available re-
sources” list, then, allows you to see at a glance how many ports you’ve used.

OK, so how do you modify the logic resources? Click on a signal name or location in
the Source Signals: area, then click on the “Edit” button. This opens a “Source Signal
Wizard - Edit Signal” window where you can redefine the audio signal type or, in this case,
add or change logic signals associ-
ated with the audio. Use of this
form has already been covered in
the Source Details Menu section
of this chapter under the topic
“Modify Signal.” The “LIO Info”
tab of this form is where you de-
fine the logic associated with the
audio signal.

The “Delete” button completes
the signal modification tools. High-
light a signal and choose “Delete”
and an “Are you sure?” window
opens. If you click on yes, then the
selected signal is removed from
the system, adding those resources
back to the Free Resources: list.

WheatNet-IP / Jan 2010
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It all sounds more complicated than it is, but most folks will just use the automatic
system defaults and not bother with any of this initially, at least until they need to define
some logic signals. Don’t be afraid to experiment with defining signals. You can always
edit back any changes you make, and if you really get things out of whack, you can just
rerun the System Startup Wizard for the BLADE and start over.

Meters

The bottom portion of the “Sources” tab window, as mentioned before, shows the
input channel meters and gain settings. The 16 individual baragraph meters show audio
levels for the individual channels color coded over a 40dB range, with the highest level
being “+20” VU, corresponding to +24dBu, 0dBFS, and the onset of clipping. These
meters show the actual input signal level as modified by the input gain setting. The
bouncing bar at the top shows the peak audio level while the solid column shows the short
term average audio level using VU time constants.

Below the baragraph meters are individual slider controls for adjusting each
channel’s gain or loss over a range of +/-18dB. The slider handle, or knob, moves to
indicate a relative gain setting as you drag it with your mouse, and the text box below
the slider updates with the specific gain value. If you prefer, you can drag your cursor
over the number in the text box to highlight it and type in the gain value you want. The
gain adjustment is made in real time and will reflect instantly on the bargraph meters.
The system rounds off gain settings to the nearest 1/10th dB.

If the signal is defined as stereo a balance control will be displayed to the right of the
level control. This control allows you to adjust the balance of the left and right stereo
signal. The adjustments can be made by left clicking and holding the control while
moving the cursor in a circular motion. If you prefer, the arrow keys can also be used to
make this adjustment. Like the level control, you can highlight the number in the text box
and set the balance level with “0” being center. The balance adjustments are also made
in real time and will reflect instantly on the bargraph meters.

Please note that any gain modifications you make to a source signal will affect the
level of that signal everywhere in the system it appears. If you are making a gain
adjustment to compensate for one particular destination only, it might be better to make
a destination gain adjustment (more on this in the next section) and leave the source gain
alone for correct use in other parts of the system. Source gain adjustments are best used
for input signals known to be too hot or too low, to bring them to the nominal system
signal level of 0VU, +4dBu, -20dBFS.

WheatNet-IP / Jan 2010
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BLADE Destinations Tab

The second tab is the BLADE “Destinations” tab. It is used for viewing and
modifying settings for the local audio outputs from the BLADE. The Destinations
window has three main parts. Along the bottom of the window is an array of 16
bargraph meters and individual level and balance controls for each source (Mono
sources do not have balance controls). These meters and controls are used to monitor
the level and set gain on the 16 outputs (or eight stereo pairs, etc.) going out of the
BLADE. In the upper left area of the main window is a section labeled “Destination
Signals:” and to the right is the “Free Resources:” section. The Destination Signals:
section is where the eight character output signal name and eight character output
location names can be seen and modified from their defaults. The Free Resources:
section is where the output signal characteristics (mono, stereo, logic, etc.) can be
seen.

Destination Signals
 In this section you can see two columns; the first column, labeled “Name” is the

destination name and the second matching column, labeled “Location,” is the
destination location. Depending on whether the BLADE has been designated as a
stereo or mono BLADE at initial set up, there will be eight or 16 names in the columns.
(If the BLADE was originally set up as a custom BLADE, there will actually be no
destination or location names showing until you first define the mono and stereo
signals you want — more on that later).

WheatNet-IP / Jan 2010
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Assuming you are looking at BLADE 1 and you’ve
chosen the stereo signal template, the Destination Sig-
nals section will look as shown here:

The first signal in the list (representing output #1) is
named “BL01D01” and its location is named “Blade01.”
These are the system default names and they can be
simply decoded. The “BL01” part of the name is just
shorthand for “Blade 1,” and the “D01” is shorthand for
“Destination 1.” Thus the auto generated system name
means “the first output in Blade 1.” Likewise,
“BL01D02” means “the second output in Blade 1,” and
“BL23D07” means “the seventh output in Blade 23.”
You can just leave things as they are and go with the
system default names if you like. But you can do better.
If you double click on a signal name, the name becomes
highlighted and you can retype it to be anything you
like. “BL01D01” becomes “Speaker,” or “CoDec,” or
“Studio 1,” or “Enco Rec” - you get the idea. As soon
as you type a new name for the signal, it appears
everywhere in the system under this new name. In other
BLADEs, on the crosspoint grid, on control surface
displays, everywhere.

Likewise, the “Location” column has default loca-
tion names which are even more easily decoded;
“Blade1” obviously means “Blade 1.” You can leave
these as they are because that pretty much tells you the
location of the signal, but if you want, you can change
the location to “WXYZ Air” or “Rackroom” or what-
ever suites your fancy. Edit the Location just as you did
the Name, by double clicking on it.

Free Resources
Resources to a BLADE mean audio and logic sig-

nals. This section of the “Sources” window shows the
remaining available resources within the BLADE. The
first three line entries in this section indicate the number
of surround 5.1, stereo, and mono signal destinations,
respectively, that have not yet been allocated to the
system, and are hence available for allocation. Remem-
ber, each BLADE has a maximum total of 16 mono
audio channels plus 12 logic ports available. If you have
used a standard mono or stereo signal template when
you first initiated the BLADE, then all of the signals
will have been allocated automatically by the Startup
Wizard to match the template, and the number available
will show as zero. This is one of the special features of
the WheatNet-IP system; it can take care of all of this
signal allocating and defining automatically, saving you a lot of work.

WheatNet-IP / Jan 2010
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If, however, you chose the Custom template, no signals will have been allocated,
and all will show as available in the resources list. As you define a new signal, the
resources available will decrease. Thus you can tell by looking at the resources list
what additional signals you could define for this particular BLADE.

Defining a new signal is easy. Click the “Add” button and the “Destination Signal
Wizard - Add Signal” screen pops up. On the Type Info tab enter the Name, and
optionally the Location. Select the Signal Type and accept the Packet Type as
automatically selected. Next,
switch to the Wire Info tab. High-
light the desired wire number (you
must pick one that is not already
assigned), then click “Finish.” The
new signal name will now appear
throughout the system.

The same is true for the logic
ports. The default configuration
makes no automatic assignment
of logic ports, so all 12 are ini-
tially available and show as LIOs.
As you allocate  logic ports for
functions, the resources decrease
correspondingly. The “available
resources” list, then, allows you
to see at a glance how many ports
you’ve used.

OK, so how do you modify the logic resources? Click on a signal name or location
in the Destination Signals: area, then click on the “Edit” button. This opens a
“Destination Signal Wizard - Edit Signal” window where you can redefine the audio
signal type or, in this case, add or
change logic signals associated
with the audio. Use of this form
has already been covered in the
Destination Details Menu section
of this chapter under the topic
“Modify Signal.” The “LIO Info”
tab of this form is where you
define the logic associated with
the audio signal.

The “Delete” button com-
pletes the signal modification
tools. Highlight a signal and
choose “Delete” and an “Are you
sure?” window opens. If you click
on yes, then the selected signal is
removed from the system, adding
those resources back to the Free
Recources: list.

WheatNet-IP / Jan 2010
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Most folks will just use the automatic system defaults and not bother with any of
this initially, at least until they need to define some logic signals. Don’t be afraid to
experiment with defining signals. You can always edit back any changes you make,
and if you really get things out of whack, you can just rerun the System Startup Wizard
for the BLADE and start over.

Meters

The bottom portion of the “Destinations” tab window, as mentioned before, shows
the output channel meters and gain settings. The 16 individual baragraph meters show
audio levels for the individual channels color coded over a 40dB range, with the highest
level being “+20” VU, corresponding to +24dBu, 0dBFS, and the onset of clipping.
These meters show the actual output signal level as modified by the output gain setting.

Below the baragraph meters are shown individual slider controls for adjusting each
channel’s gain or loss over a range of +/-18dB. The slider handle, or knob, moves to
indicate a relative gain setting as you drag it with your mouse, and the text box below
the slider updates with the specific gain value. If you prefer, you can drag your cursor
over the number in the text box to highlight it and type in the gain value you want. The
gain adjustment is made in real time and will reflect instantly on the bargraph meters.
The system rounds off gain settings to the nearest 1/10th dB.

If the signal is defined as stereo a balance control will be displayed to the right of
the level control. This control allows you to adjust the balance of the left and right
stereo signal. The adjustments can be made by left clicking and holding the control
while moving the cursor in a circular motion. If you prefer, the arrow keys can also be
used to make this adjustment. Like the level control, you can highlight the number in
the text box and set the balance level with “0” being center. The balance adjustments
are also made in real time and will reflect instantly on the bargraph meters.

Please note that any gain modifications you make to a destination signal will affect
the level of that output for all sources feeding it. If you are making a gain adjustment
to compensate for a systematic gain problem, it might be better to make a source gain
adjustment, and leave the destination gain alone. Destination gain adjustments are best
used for output signals known to be too low or too hot, such as those feeding
headphones or amplified speakers with no gain control of their own, to bring them to
the correct listening level.

WheatNet-IP / Jan 2010
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BLADE Visibilities Tab

The third tab is the BLADE “Visibilities” tab. The settings available on this tab are
used to limit or control the choices that can be made for connecting sources to the local
audio destinations in the BLADE. The default settings of the WheatNet-IP system allow
any source to be connected to any destination, but there are some good reasons to restrict
this capability in specific places. A good sized system can have hundreds and hundreds
of sources available. To locate and select any particular one from the front panel control
on a BLADE might involve a lot of scrolling! If you can limit the number of choices
available it becomes less confusing and much easier. In many cases it makes practical
sense to restrict the source choices. For example, if one of the destination outputs from
a BLADE is being used as a headphone feed to a guest location in a talk studio for
WXYZ, why would that guest ever need to select the audition mix output of a production
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studio in WZZZ? Another good reason for restrictions is that you might never want
a connection such as the feed from your processor to your air chain to be
inadvertently changed. In many cases you can greatly restrict the source choices
available for a destination, sometimes even to as few as one. In the WheatNet-IP
system, we use the “visibilities” property to control these choices, and it’s very
easy to do. Essentially, we allow you to edit the list of names that are “visible” to
the user on a destination by destination basis, so that every audio output in the
system can have a unique setting. Note that we are not actually restricting the
connection possibilities; you can at any time choose any source you want using the
Navigator GUI or by firing a salvo, etc. We are only restricting which choices are
visible to a user sitting in front of the BLADE and scrolling the front panel knob.

Clicking on the Visibilities tab opens a new window showing two columns.
The left hand column, labeled “Controllers:” shows a list of every local destination
defined for the BLADE. The right hand column shows a hierarchal view (typical
Windows Explorer tree style) of every source defined in the system.

To set visibility for a destination, first make sure the desired destination is
actually a member of the BLADE you are currently viewing. You can check on the
label for the visibility tab; it will read “BLDxxx - Visibility” where “xxx” is the
BLADE ID number. If this is not the correct BLADE, then just click on the correct
icon in the system pane window  to get to the correct visibility tab.

Examine the list of destinations in the left hand window and left click on the
desired destination to highlight it. The right hand window shows a list of all of the
BLADEs in the system, with a check box beside the name of the BLADE.

If you know that none of the sources in a particular BLADE should be visible
to the destination, click on the check box to uncheck it. In this manner, go through
the list of BLADEs and uncheck any that should not be visible. Continue on and
click on the expand box for any BLADE that you want visibility to some, but not
all, of its signals. The list expands in tree fashion to show the individual signals
within the BLADE, each with their own check boxes. Uncheck the signals that
should not be visible, and repeat this process for any other BLADEs to set them.

When you have completed working on the list for the selected destination, you
can click on another destination in the left hand window and set visibilities for it.
After setting visibilities for all of the destination signals, click on the “Apply”
button at the bottom of the window and your choices will be instantly forwarded
to each BLADE in the system.

As you no doubt have noticed by now, this process can be somewhat time
consuming. Fortunately, the WheatNet-IP GUI has some built in shortcuts that can
be very useful. The “Select All” and Clear All” buttons in the upper left corner of
the visibility window  allow you to check or uncheck groups of signals at once,
assuming that the common selections are suitable for each member of the group.
You can accept these common selections, or then drill down through the menu and
make individual tweaks without having to repeat the selections that were in
common.
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BLADE LIO Info Tab

The fourth  tab is the BLADE “LIO Info” tab. This tab brings up a screen you can 
use to program and control the operation of the 12 physical Logic Input/Output ports 
on each BLADE. These ports are available on the two RJ-45 jacks on the rear of the 
BLADE. Each of these 12 ports can be individually defined as 
a logic input or a logic output, and can be mapped to a number 
of different functions.

The LIO info tab is arranged as a table, with logic ports listed 
along the left side, and attributes listed across the top. Each 
row, or line, therefore shows the logic settings for a particular 
logic port. Recall that each BLADE has twelve ports available; 
they are named LIO 1 pin 2 through LIO 1 pin 7, representing 
the six logic ports available on the first RJ-45 rear panel logic jack, and LIO 2 pin 2 
through LIO 2 pin 7, representing the six logic ports available on the second RJ-45 rear 
panel logic jack. The logic port names not so subtly reflect the physical pin number 
of the logic jack, so it is easy to correlate the GUI functions with the corresponding 
physical connection. These pin numbers have been chosen so they mate up with some 
common Wheatstone auxiliary switch panels; when they are used for logic outputs, 
power is available on pins 1 & 8.

The logic functions that have been programmed will appear in this table, giving 
you an at-a-glance summary of the physical logic ports on the BLADE. In the row for 
a particular port you will see whether it has been programmed as an input or an output, 
the name of the logic function configured for the port (if one has programmed), the eight 
character name (the one that appears on the crosspoint grid) you’ve given to the logic 
signal, the salvo it has been programmed to fire, or the temporary XPoint connection it 
has been programmed to trigger. Note that the three possible uses of the logic port are 
mutually exclusive; a logic port can be programmed as a logic only signal for use in 
connecting to other logic signals on the grid, or it can be programmed to fire a salvo, 
or it can be programmed to trigger a connection. It can only do one of these things. 

The LIO Info tab shows which programming options have been set for each of the 
12 physical ports. If nothing has programmed, the info will be shown as “<none>.” 
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An especially handy feature of this window is that each logic port has an
associated indicator with it. These are the circles shown in the input or output
columns next to the logic port name. When the logic port is triggered, these indicators
will light up in color for as long as the port stays triggered. This makes it easy to trace
out your wiring to the ports; if you wire up a switch as an input to the logic port, the
associated indicator will turn color as long as you hold the switch button down.
Conversely, if you’ve wired up a logic port as an output to drive a relay, lamp, or other
device, the associated indicator will turn color as long as the logic output is activated
by whatever you intend to drive this output with (presumably a console logic signal,
another switch panel somewhere, or so forth).

BLADE Silence Detect Tab
The fifth tab is the BLADE “Silence Detect” tab. One of the very powerful

features of the WheatNet-IP system is that every single audio output channel can be
programmed with a silence detection and auto-
matic switch over function. This capability can
go a long way to maintaining smoother, more
reliable operation to your radio stations when an
unexpected problem happens. Careful planning
of alternate and back up audio paths for crucial
connections can keep you on the air.

While the silence detect function is available
for every destination signal in each BLADE, it is
not automatically enabled. Many of the signals
in a typical system do not need this function. To
enable silence detect for a particular destination
signal, you must click on the Destinations tab for
the BLADE in which the signal is located, click
on the desired signal to highlight it, and then
click on the Edit... button to open the familiar
“Destination Signal Wizard” window. You will
notice the Silence Detect check box; if it has not
been checked, silence detection will not be en-
abled for this audio channel.
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When you click on the silence detect check box and finish the signal wizard, several
things happen.

First, the silence detect function is enabled. Second the silence detect alarm logic
signal (default name is “XXXL” where XXX is the name of the destination signal you
are working on) is automatically created as a Source Signal to generate messages in the
“Alarms” pane of the GUI and to allow connection to a physical logic output port to
activate an alarm device. Finally, a new audio destination signal is automatically added
into the BLADE (and the system). This signal is created with a default name of “XXXB”
(where XXX is the name of the signal you are working on) and represents the secondary
audio path that can be used for automatic failover of your source connection upon
detecting  silence. Create a back up signal path by making a source connection from your
back up source to this secondary “B” connection (it will show on the crosspoint grid).

Clicking on the silence detect tab for a BLADE opens up a three part window.

Destination Signals
The upper left hand window part is labeled “Destination Signals” and shows a list

of any destinations that have been set up for silence detection. The upper right hand
window part is labeled “Settings” and shows the particular level and duration param-
eters that have been chosen (or the standard default settings). The bottom window part,
called “Status” shows details about the current state of the silence detect function.

To experiment with the silence detect function, click on one of the destinations in the
“Destination Signals” list. The “Settings” and “Status” areas of the window will change
to show the particulars for the selected destination signal. If there are no destinations
shown in the list, that means silence detection has not been enabled yet for any of the
signals in the BLADE. In the right hand “settings” area you can modify the default
settings or leave them as the defaults.
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Settings
You can review the effect of the settings in the 

“Status” area of the window. These settings are:
Detector Threshold - This is the signal level 

threshold for silence detection. Any time the audio 
signal at the destination falls below this threshold, 
the BLADE will start to keep track of how long the 
signal stays below this threshold level. This setting 
should be adjusted to match your station’s format. 
Not to be obvious, but a Hot format most likely never 
expects to have a low signal level, while a classical 
format might frequently do so.

Failed Duration - This is the acceptable length 
of time for the signal to be below threshold. It is 
only applied when the “Auto Failover” check box 
has been set. Again, this setting is very dependant 
on your format. If your program material has few, 
if any, pauses, and your Talent voices are energetic, you can set the duration as 
low as several seconds. Conversely, if your programs have frequent quiet passages 
and your Talent voices are relaxed you may need to set the duration as high as the 
maximum duration of 45 seconds. 

The Navigator GUI can be helpful in arriving at the optimum settings for thresh-
old and duration. In the Status area of the Silence Detect window are two round 
indicators labeled “L” and “R.” These are audio indicators that show the left and 
right channels of the destination. They will be shown in green when the audio level 
is above the threshold setting, and in red when it is below the threshold setting. If 
you leave the auto failover box unchecked, you can watch these indicators as you 
alter the threshold without danger of losing the audio connection due to a silence 
detect triggered failover. Monitor how frequently and for how long the audio is be-
low threshold, add some extra time margin for insurance purposes, and that’s your 
settings. Just remember, if your programming or Talent changes, these settings may 
need to be readjusted.

Failback Duration - This setting can be very useful. It is only applied when the 
“Auto Failback” check box has been set, and represents how long the BLADE will 
wait to restore the original source connection. It will monitor the original source 
for level, and, if it stays above the threshold for the specified time, will switch back 
to the original source. This is useful in situations where the primary connection is 
intermittent; by specifying a duration over which the primary connection must “prove 
itself good” you can avoiding a premature switch back  before the connection is solid.

The other two controls in the “Settings” area of the silence Detect tab are the 
previously mentioned check boxes for “Auto Failover” and “Auto Failback.” Check 
the “Auto Failover” box if you would like to have an automatic source connection 
change to your specified secondary source when silence detect is triggered. Check 
the “Auto Failback” box if you would like to have an automatic source connection 
changed to your primary source when the silence detect function is released.

Finally, you must click on the “Apply” button at the bottom of the window before 
any of your changes will take effect.

WheatNet-IP / Feb 2013
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Status
The “Status” area of the silence

detect tab shows at a glance infor-
mation about the silence detect func-
tion for the destination signal. The
primary and secondary connection
paths are labeled and indicated, and
the “L” and “R” audio level indica-
tors will flicker in the presence of
audio. Note that the currently active
signal path shows in green and the
inactive signal path shows in black. You can click on the button to force a connection
change to the alternate signal path and a dialog window will open asking you to
confirm the change. Warning; clicking “Yes” on the dialog box will instantly change
the audio connection. This button is meant to be used for initial set up and testing and
for manual failover in cases where automatic failover is not desired, or when the
failover is needed for reasons other than the loss of audio signal.

Logic
Enabling Silence Detection on a Destination automatically creates a new Logic

Only source signal. This signal will appear in the crosspoint grid with a name of
“XXXL” where XXX is the name of the destination using silence detection. This logic
signal also has an ID# of XXXXX4XX where XXXXX_XX is the signal ID of the
destination.

To use this logic signal to trigger a physical alarm, create a new Logic Only
destination signal on the BLADE you will use for the physical alarm (light, buzzer,
etc.) logic connection. Map the particular logic pin that you want to use and select the
“SDet Failure” function from the drop down list.

One you have defined the new Logic Only destination signal, make a new
crosspoint connection between the auto generated silence alarm source logic signal
and your new alarm destination signal. On detecting silence, the SDet Failure logic
function will trigger your destination alarm signal for as long as the silence persists.

WheatNet-IP / Jan 2010
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Utility Mixer Tab

The next tab is “Utility Mixer.” Each BLADE can optionally have a built in audio
mixer capability (this tab will be grayed out if it is not available on the BLADE).
Clicking on this tab will open the Utility Mixer window, which shows a graphic
representation of an 8 x 2 mixer, complete with faders, meters, and ON switches. There
are two different 8 x 2 mixers available on this tab. With each of these mixers, two
separate mixes of up to eight audio sources can be created and manipulated. Further-
more, each one of these two 8 x 2 mixers has a separate Automation Control Interface,
or ACI, providing for external control of the mixer by a third party program such as an
Automation system. Lastly, every physical BLADE in the system can have these two
mixers enabled on it simultaneously, so the number of mixes available to you is limited
only by how many BLADEs you have.

Enabling the Utility Mixer will add (4) new sources in the BLADE, labeled
BL04UMXA, BL04UMXB, BL04UMXYA, & BL04UMXYB, representing the A & B
output channels for each mixer. Also added will be (16) new destinations, labeled
BL04UMX1 - BL04UMX8, representing the eight fader input channels of the first
mixer and BL04UMY1 - BL04UMY8 for the eight fader input channels of the second
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mixer. These new sources and destina-
tions will appear in the system
crosspoint grid, allowing you to con-
nect various system resources, mix them
as required, and distribute these mixes
to other system destinations.

To operate the Utility Mixer, first
be sure it is enabled by clicking on the
Enable check box. You can separately
enable mixer number 1, number 2, or
both. This will cause the BLADE to
autogenerate the required new signals.
Then assign the signal sources needed
to fader channels by using the system
crosspoint grid. To mix the audio sig-
nals, bring up the fader channels to a
desired mix output bus by dragging
with the your mouse and clicking on
the channel “ON” button. Adjust the
mix by dragging the individual and mix
faders up or down. The radio buttons
beside each fader provide for auto-
matic “Fade up” or Fade down” with a variety of speeds. You can monitor the mix by
watching the on screen meters, and/or by listening to the mix output on any speaker or
headphone output destination. The front panel headphone jack on the BLADE is a good place
to do this.

The Utility mixer is handy for a variety of functions. You can use it to premix some
standard signals, provide for late night automated operation, set up mix minus feeds, create
an intercom system, or even run a small remote.

Network Info Tab
The next tab is the “Network Info” tab.

This tab is where the BLADE’s network
settings are displayed and can be modified. If
you have used the System Wizard to auto-
matically set up the BLADEs initially, all of
the system configured network settings are
shown here. Wheatstone recommends leav-
ing these settings unchanged unless you have
strong reasons to change the default addresses
and are experienced in LAN set up, and have
created an address plan for the system.

The upper part of the window shows the
BLADE’s hardware address information. Ev-
ery networkable device is built with a unique
physical hardware address (called the MAC
address) that cannot be changed. This MAC
address, along with the BLADE’s type and ID
information, are displayed for information
purposes only in non-editable boxes.
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The lower part of the window shows the BLADE’s software address information.
This is the IP address information created by the System Wizard, and takes the form of
the familiar IP address, Subnet, and Gateway. This address information is described in
detail in the Networks chapter of this manual; it is sufficient to note that these boxes can
be edited to change the BLADE’s software address.

Note that modifying this address information improperly will cause the BLADE to
cease operating on the WheatNet-IP network and potentially become invisible to the
WheatNet-IP Navigator GUI. In other words, if you mess this up you may not be able
to get back without rerunning the System Wizard from the front panel of the BLADE.

The one setting that you might consider changing is the BLADE name. This is the
name that will identify the BLADE in the System Pane and elsewhere. The system
default name for the BLADE is “BLADEXX” where “XX” is the BLADE ID number.
You can leave the BLADE name as the default, or change it to any eight character name
by dragging or double clicking on the name and typing a new one. Just remember that
each BLADE needs a unique name to let you identify it in the system. Click on the
“Apply” button in order to save any changes.

Version Manager Tab

The next tab is the “Version Manager” tab. Clicking on this tab opens an information
window showing the current software and firmware versions running on the BLADE.
As the WheatNet-IP system evolves over time, there will no doubt be future updates that
increase or improve functionality of the BLADE. This tab is a convenient way to keep
track of the current versions on the BLADE. It also can be used to update the BLADE
with new versions.
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The “Versions:” section in the upper part of the Versions Manager window
shows the current versions running. Note that even after loading a newer version of
software on the BLADE, this window will still show the older version until the
BLADE is rebooted and the newer version is launched.

The “Release Folder:” section in the middle part of the window is used during
software updating. Assuming you have downloaded a new version of software onto
your GUI PC, click on the “...” button to the right of the window to browse to the
directory on your PC that contains the version you wish to upload to the BLADE.
If desired, click on the “Default” button to make this directory path the default.

The “Select a file to install on BLADE:” section in the lower part of the window
will show a list of all the available files in the chosen directory. Older software
versions from previous updates will appear in this list unless you have specifically
deleted them in the past. Click on a file name to highlight it and then click on the
install button. The file will be uploaded to the BLADE. Note that the BLADE must
be rebooted in order for the new software file to actually run on the BLADE. Either
power cycle the BLADE or chose “Reboot” from its front panel menu.

After uploading and rebooting, check in the “Versions:” window to make sure
the desired software version is running.

Config Manager Tab
The last BLADEs tab is the “Config Manager”

tab, which gives access to backup or restore the
BLADE’s specific configuration information. All
of the BLADE’s signal ID’s, names, format, logic
settings, silence detect settings, etc., can be saved to
a directory on the GUI PC. Likewise, all of this
information can be retrieved from the PC and re-
stored to the BLADE.

The “Configuration Folder:” section of the win-
dow is used to specify the directory path on the GUI
PC to be used for the backup and restore functions.
The currently specified path will show in the text
box in this section. To specify another folder, click
on the browse button next to the text box. A standard
Windows dialog box will open allowing you to
specify the desired directory. If desired, you can
assign this directory as the default location for
configuration files by clicking on the “Default”
button.

The “Backup BLADE Configuration” section
of the window is even simpler. All it contains is a
“Backup” button which, when clicked, will write all
of the configuration information to the specified
directory. First a subdirectory is created, and is
named “cfg_YYYY-MM-DD_HH-MM-SS_BL”
where YYYY-MM-DD is the current date and HH-MM-SS is the current time. This
automatic naming convention makes it easy to keep track of your backup files. Click
“Yes” on the ensuing dialog box to proceed (clicking “No” will cancel the
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operation). A file will be created with a name of
the form “full_BLADE_config_XXXX” where
“XXXX” is the BLADE ID number.

The last section of this tab shows the “Re-
store BLADE Configuration” section. Here
you can scroll through the list of available
configuration directories and  files, click on
one to highlight it, and then click on the “Re-
store” button to send the information to the
BLADE. A restore dialog box will open show-
ing the selected file and asking you if you are
sure. Clicking “Yes” will again show a progress
bar as the information is uploaded to the
BLADE.

A Word About Backup and Restore
Because of the distributed intelligence of the WheatNet-IP system, the

backup function is mainly intended for archival purposes. Since all of the
system’s information is concurrently saved in flash memory on multiple BLADEs,
it is extremely unlikely that it all would be lost. So why then do we need to perform
backups? It would take a catastrophic event, such as a direct lightning strike or
massive flooding that simultaneously wipes out all of the BLADEs, in order for
all of this information to be lost. Maintaining a regular schedule of backups is a
good way to mitigate against this unlikely but still possible scenario.

Because the Navigator GUI is so powerful, Wheatstone has provided in the
WheatNet-IP system for up to four copies to be running at the same time. You can
be running a copy in your TOC, running another copy down the hall, and even run
a copy from your home if you have provided for external access into your system.
This functionality can be handy for managing connection, silence detection, and
logic functions. Be aware, however, that the backup and restore functions work
in concert with the directories on a particular PC, so to avoid confusion it is best
to restrict these activities to only one PC.
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More on the System Pane
Popup menus are available when a BLADE’s icon or name is right-clicked in the

System Pane. Additionally, the view in the main window area changes as if the icon
or name was left-clicked.

If the BLADE type is any of the hardware BLADEs, the popup menu allows you
to choose any of the tabs in the main view, This is most handy when you want to
change to a tab that’s currently not visible and would require use of the tab scroll
buttons to make that tab show before selecting it. With the right-click method you
don’t need to use the tab scroll buttons.

There are two additional entries in the popup menu for a hardware BLADE. At
the top is a choice to “Go to Crosspoint,” which changes the main view to the System
Crosspoint tab. At the bottom of the menu is a choice to “Reboot BLADE.” This
should be used with caution, since the BLADE will be out of commission for the
reboot time, and any audio in the BLADE will be lost to the system until reboot is
done. The main reason for providing “Reboot BLADE” is to allow you to reboot a
BLADE when updating its software without having to physically travel to where the
BLADE is located.

If the BLADE is a PC type, the popup menu once again lists the tabs for that
BLADE as choices, and also sports the “Go to Crosspoint” choice. There is,
however, no “Reboot BLADE” choice.

You can also right-click on the System icon or name to bring up a similar menu.
Since one of the choices is already the System Crosspoint tab, there is no need to
have the “Go to Crosspoint” choice, so that item is omitted from the list. And the
bottom choice is not “Reboot BLADE” but, instead, is “Reboot All BLADEs.”
Once again, this choice needs to be used with caution.
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Configuring Control Surfaces for  
Use in WheatNet-IP Systems

Wheatstone makes a number of different model control surfaces. Not all of these are 
compatible with the WheatNet‑IP system. Currently supported are the Evolution series 
E‑4, E‑5, and E‑6 control surfaces. 

In order to use an Evolution control surface with the WheatNet‑IP system it must be 
properly configured. There are two parts to this configuration. First, the control surface 
must be equipped with the correct version of WheatNet‑IP specific software. If you have 
ordered your control surface as a part of a WheatNet‑IP system, this will be taken care 
of automatically. If you are moving an Evolution control surface purchased previously, 
its software may need to be updated. The Evolution series control surfaces can be used 
with other Wheatstone products and may be equipped with software specific to other 
applications. Consult with Wheatstone Technical Support; they can assist you with any 
required software updates.

The second part of the configuration is to mate a specific control surface to its mixing 
engine BLADE within the WheatNet‑IP system. This mate up process is actually done at 
the control surface itself. To complete this process successfully, the control surface and 
its intended WheatNet‑IP engine must be powered up and connected to the same LAN. 

First, be sure that you know the BLADE ID and IP address of the intended WheatNet‑IP 
engine BLADE. This BLADE must be available and unassociated with any other con‑
trol surface. You can confirm this information via the front panel controls on the engine 
BLADE, or from the WheatNet‑IP Navigator GUI. 

At the control surface click on the “Options” tab and then the “Network Settings” menu.
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Enter the WheatNet-IP ID and IP address in the boxes provided, and verify that
the IP address of the control surface is correct (it must be on the same subnet as the
BLADEs). While you are at it, it is highly recommended that you use the IP address
number convention for the control surface IP address. This convention makes it easier
to understand and trouble shoot your system architecture. Simply take the ID number
of the engine BLADE and add 200 to it. Thus Engine
BLADE ID=03 would have IP address 192.168.87.103
and the mating surface would have IP address
192.168.87.203.

Reboot the control surface. After the surface has
booted up, the new settings should now be visible in the
“Options”/”Network Settings” tab of the control sur-
face VGA display.

Once the control surface has been associated with a
WheatNet-IP engine, the BLADE will query the sur-
face for its configuration information and then auto-
matically generate the required source and destination
signals. A control surface icon (showing its IP address)
will be added to the WheatNet-IP Navigator GUI
system view, attached to the mating engine BLADE.

The specific signals created and their default names are a function of the model
and size of the associated control surface. The following is a listing of a typical set of
signals for a XX fader E-Series control surface. Of course, just as with any other
signals, you can rename these however you choose; if you’ve done so, the names on
your system may not exactly match the ones on the following list.
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Sources

Spare01 Logic signal associated with programmable button #1
Spare02 Logic signal associated with programmable button #2
Spare03 Logic signal associated with programmable button #3
Spare04 Logic signal associated with programmable button #4
Spare05 Logic signal associated with programmable button #5
Spare06 Logic signal associated with programmable button #6
Spare07 Logic signal associated with programmable button #7
Spare08 Logic signal associated with programmable button #8
Spare09 Logic signal associated with programmable button #9
Spare10 Logic signal associated with programmable button #10
Spare11 Logic signal associated with programmable button #11
Spare12 Logic signal associated with programmable button #12
Spare13 Logic signal associated with programmable button #13
Spare14 Logic signal associated with programmable button #14
E6Aux1 Aux 1 audio mix
E6Aux2 Aux 2 audio mix
E6Aux3 Aux 3 audio mix
E6Aux4 Aux 4 audio mix
E6BM01 Bus minus 1 audio mix (for fader 1)
E6BM02 Bus minus 2 audio mix (for fader 2)
.....
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E6BMxx Bus minus 1 audio mix (for last fader)
E6CtrlRm Control room monitor audio mix
E6Cue1 Cue monitor audio mix
E6HDPN Headphone monitor audio mix
E6MM1 Mix Minus 1 audio mix
E6MM2 Mix Minus 2 audio mix
E6MM3 Mix Minus 3 audio mix
E6MM4 Mix Minus 4 audio mix
E6PgmA Program A audio mix
E6PgmB Program B audio mix
E6PgmC Program C audio mix
E6PgmD Program D audio mix
E6Stud1 Studio 1 monitor audio mix
E6Stud2 Studio 2 monitor audio mix
E6Tally Mute/tally logic signals
E6Timer Timer logic signals
E6WCMix1 Source for Control room/headphone/studio monitors

Destinations

E6CRx External input for Control room monitor
E6HDPNx External input for Headphone monitor
E6In1 Input to first fader channel
E6In2 Input to second fader channel
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.....
E6Inxx Input to last fader channel
E6Stu1x External input for Studio 1 monitor
E6Stu2x External input for Studio 2 monitor
E6TkBack Input for talkback channel
E6WldCrd Input for switchable meters

Once these signals have been auto-generated, the control surface is now ready for
use. You can make connections to the fader channels either with the Navigator GUI,
or through the control surface front panel controls, and begin mixing. One thing you
will notice is that, as soon as a fader channel is turned on, the system automatically
locks the connection (as shown by the red line on the GUI screen) to prevent someone
else from breaking your connection while you are on air.

Remember, you must also make connections from the mixer signals to actual
audio destinations before the mixes are routed through the WheatNet-IP system. Use
the GUI to make these connections and lock them if necessary.

Lastly, you can continue setting up control surface options, for logic, mutes,
signal visibility, and others. Consult the proper Evolution series manual for details.
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Cisco 2960G Configuration for WheatNet-IP

Overview
Let’s take a look at what needs to be done to get your Cisco 2960G ready for the

installation of your WheatNet-IP system. Properly configuring your switch allows
you to take advantage of the “management” capabilities to control network traffic and
allows the network to operate at its highest potential. This becomes necessary to
prevent overloading the network as the system size increases.

In this setup process you will setup switch ports according to the type of device
connecting to that port. You will be setting things like VLAN access, Trunking,
Speed, etc. Each section below gives you the exact commands needed to get your
Wheatnet-IP network up running.

Below is a chart that gives you some information about the command you will be
using to complete the setup. This can be a quick reference for you as

   Command                                      Purpose

   Configure Terminal   Enter Global configuration mode on switch

   Interface   Enter interface configuration mode

   Switchport mode access   Configures the port as an access port

   Switchport mode Trunk   Configures port for trunking to other switches

   Switchport nonegotiate   Prevents DTP frames from being generated

   Spanning-tree portfast   Enables portfast on the switch port

   Show running-config   Show the current running configuration

   Write memory   Writes the configuration to memory on the switch

   IP igmp snooping querier   Enables IGMP querier

   IP igmp snooping querier timer expiry   Set the length of time until the IGMP querier expires

This document will explain the initial configuration of the Cisco 2960G switch.
To get started you will need the blue console cable that came with your switch. Go
ahead and connect the console cable to the serial port on your pc and the RJ-45 to the
console port on the switch. If your pc is not equipped with a serial port you will need
a USB to Serial converter.

Next let’s get your pc ready to communicate. You will need a terminal program
such as HyperTerminal to finish this portion of the setup. HyperTerminal is an
application you can use in order to connect your computer to other remote systems.
These systems include other switches, routers, other computers, and Telnet sites.

HyperTerminal is located under the Start menu of your Windows 2000/XP PC.
If you are using Windows Vista or Windows 7 you will need to install a similar
terminal program to complete the setup.

WheatNet-IP / Dec 2009
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To get started, open HyperTerminal and start a
new connection. The terminal session should be
setup using 9600Baud, 8 bit, no Parity, and no Flow
control.

For those who are familiar with the Cisco IOS you
may wish to jump ahead to the commands. For the
rest, keep reading and we’ll walk you through it step
by step.

Along the way we’ll even explain why we use the
commands below so that you have some basic under-
standing of what you are doing. Hopefully you will
walk away with some new found knowledge.

Privileged EXEC Mode
Now that we are connected to the switch let's login. When logging into a Cisco switch

under the default configuration, you are in user EXEC mode (level 1). In EXEC mode,
you have limited access to the status of the switch. However, you can't make any changes
or view the running configuration file.

Because of these limitations, you need to type enable to get out of user EXEC mode.
By default, typing enable takes you to “Privileged” EXEC mode (Level 15). In the Cisco
IOS, this level is equivalent to having root privileges in UNIX or administrator
privileges in Windows. In other words, you have full access to the switch.

Let’s get started on the configuration of your switch. Type “enable” command at the
prompt. When prompted, enter the password and press Enter again. If no password has
been defined just press Enter.

NOTE:  The command prompt now ends with “#” indicating you are now at the
Privileged EXEC mode (Level 15).

Global Configuration Mode
To enter the IP address and Subnet Mask for the VLAN or configure the switch ports

you must first enter the configuration mode. To enter the global configuration mode on
the 2960G type “Config T” and press enter. This places the switch in Global
configuration mode and will allow configuration from the terminal window for the
selected interface. You should now have the switch (config)# prompt.

Configuring the VLAN Interface

A VLAN is a switched logical network that is segmented based on the function or
application. VLANs are virtual LANs but have the same attributes as the physical LAN.
VLANs allow a user to create a virtual broadcast domain in which traffic can be isolated
to keep it reaching unwanted destinations. Any switch port can belong to a VLAN, and
unicast, broadcast, and multicast packets are forwarded only to those end stations
assigned to that VLAN.
WheatNet-IP / Dec 2009
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Now that you are in the Global configuration mode you need to select the interface
that you would like to configure. We’ll start with the default VLAN.

The switch will come with a default VLAN enabled. In the default configuration all
ports on the switch have been assigned to VLAN1. The command below selects the
default VLAN for configuration to segment network traffic on the switch. If you are
adding an additional VLAN to existing hardware, substitute that VLAN number in place
of 1.

Enter the following commands (“XXX” = the actual network IP address)
interface Vlan1interface Vlan1interface Vlan1interface Vlan1interface Vlan1
ip address 192.168.87.XXX 255.255.255.0ip address 192.168.87.XXX 255.255.255.0ip address 192.168.87.XXX 255.255.255.0ip address 192.168.87.XXX 255.255.255.0ip address 192.168.87.XXX 255.255.255.0
endendendendend

Let’s look at what you just setup. By typing “interface Vlan1” you are entering the
configuration for that VLAN. The “IP Address” Command simply sets the IP address
of the VLAN1 interface for remote management purposes. The IP address must be
unique on the network.

IGMP Snooping Querier Configuration
By default, IGMP is enabled globally on the switch. To setup IGMP Snooping

Querier on the switch you must be in the Global configuration mode. To enter the
configuration mode once again type “Config T” and press enter.

Enter the following commands:

ip igmp snooping querierip igmp snooping querierip igmp snooping querierip igmp snooping querierip igmp snooping querier
ip igmp snooping querier max-response-time 25ip igmp snooping querier max-response-time 25ip igmp snooping querier max-response-time 25ip igmp snooping querier max-response-time 25ip igmp snooping querier max-response-time 25
ip igmp snooping querier timer expiry 205ip igmp snooping querier timer expiry 205ip igmp snooping querier timer expiry 205ip igmp snooping querier timer expiry 205ip igmp snooping querier timer expiry 205
endendendendend

By default IGMP Snooping is globally enabled on the switch. It is enabled on
VLANs by default. Global IGMP snooping takes precedent over VLAN IGMP
Snooping. If globally disabled you cannot enable IGMP Snooping on a per VLAN basis.

The commands above simply enable the querier on the switch and set a few values
for maximum response time and the expiration duration for the querier.

Configuring Gigabit Ports Connecting to WheatNet-IP I/O Blades
and PC Drivers

Configuring the ports on the Cisco 2960G is a key step in ensuring optimal
performance of the Wheatnet-IP network. This section will guide you in the setup of
each port used for Wheatnet-IP I/O Blades.

Switch ports operate in one of three modes, dynamic, trunk, or access mode.
Switch ports connecting to Wheatstone-IP devices must be in Access mode. Access

mode places the port in static access mode and gives it access to the default VLAN. The
switchport nonegotiate command disables the Dynamic Trunking Protocol and tells the
port not to generate DTP frames.
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 To setup ports on the switch you must also be in the Global Configuration mode. To
enter the configuration mode once again type “Config T” and press enter.

Enter the following commands
Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)
switchport mode accessswitchport mode accessswitchport mode accessswitchport mode accessswitchport mode access
switchport nonegotiateswitchport nonegotiateswitchport nonegotiateswitchport nonegotiateswitchport nonegotiate
speed 1000speed 1000speed 1000speed 1000speed 1000
spanning-tree portfastspanning-tree portfastspanning-tree portfastspanning-tree portfastspanning-tree portfast
endendendendend

Ports on the 2960G can be configured individually or in a “Range.” If range is desired
type Interface range gig1/0/1 - 24 using the desire number of ports.

Configuring Gigabit Ports Connecting to Wheatnet IP Control
Surfaces, GP Panels, and XY Controllers

Enter the following commands
Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)
switchport mode accessswitchport mode accessswitchport mode accessswitchport mode accessswitchport mode access
switchport nonegotiateswitchport nonegotiateswitchport nonegotiateswitchport nonegotiateswitchport nonegotiate
speed 100speed 100speed 100speed 100speed 100
spanning-tree portfastspanning-tree portfastspanning-tree portfastspanning-tree portfastspanning-tree portfast
endendendendend

Ports on the 2960G can be configured individually or in a “Range.” If range is desired
type Interface range gig0/1 - 24 using the desired number of ports.

Configuring Ports for Linking to Other Network Switches
Trunk mode is used when connecting another switch to the port.
To set a specified port to trunk mode when connecting to another network switch the

port needs to be set for trunk mode. To setup Gigabit ports on the switch you must also
be in the Global Configuration mode. To enter the configuration mode once again type
“Config T” and press enter.

Enter the following commands.
Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)
switchport mode trunkswitchport mode trunkswitchport mode trunkswitchport mode trunkswitchport mode trunk
switchport nonegotiateswitchport nonegotiateswitchport nonegotiateswitchport nonegotiateswitchport nonegotiate
endendendendend
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Checking and Saving the Switch Configuration
When you are done, check the switch configuration by typing the following command

from the command prompt.
show running-configshow running-configshow running-configshow running-configshow running-config

Once you are sure you have the correct configuration you need to save it. You can save
the configuration by typing one of the following commands

copy running-config startup-configcopy running-config startup-configcopy running-config startup-configcopy running-config startup-configcopy running-config startup-config
or

write memorywrite memorywrite memorywrite memorywrite memory

Below is a diagram that shows you what a typical configuration might look like.

WheatNet-IP / Dec 2009 page  A – 16.3
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Cisco 3750G and 3560G Configuration for WheatNet-IP

Overview
Let’s take a look at what needs to be done to get your Cisco 3750G/3560G ready

for the installation of your Wheatnet-IP system. Properly configuring your switch
allows you to take advantage of the “management” capabilities to control network
traffic and allows the network to operate at its highest potential. This becomes
necessary to prevent overloading the network as the system size increases.

In this setup process you will setup switch ports according to the type of device
connecting to that port. You will be setting things like VLAN access, Trunking,
Speed, etc. Each section below gives you the exact commands needed to get your
Wheatnet-IP network up running.

Below is a chart that gives you some information about the command you will be
using to complete the setup. This can be a quick reference for you as

   Command                                      Purpose

   Configure Terminal   Enter Global configuration mode on switch

   Interface   Enter interface configuration mode

   Switchport mode access   Configures the port as an access port

   Switchport mode Trunk   Configures port for trunking to other switches

   Switchport nonegotiate   Prevents DTP frames from being generated

   Spanning-tree portfast   Enables portfast on the switch port

   Show running-config   Show the current running configuration

   Write memory   Writes the configuration to memory on the switch

   IP igmp snooping querier   Enables IGMP querier

   IP igmp snooping querier timer expiry   Set the length of time until the IGMP querier expires

This document will explain the initial configuration of the Cisco 3750G/3560G
switch. To get started you will need the blue console cable that came with your switch.
Go ahead and connect the console cable to the serial port on your pc and the RJ-45
to the console port on the switch. If your pc is not equipped with a serial port you will
need a USB to Serial converter.

Next let’s get your pc ready to communicate. You will need a terminal program
such as HyperTerminal to finish this portion of the setup. HyperTerminal is an
application you can use in order to connect your computer to other remote systems.
These systems include other switches, routers, other computers, and Telnet sites.

HyperTerminal is located under the Start menu of your Windows 2000/XP PC. If
you are using Windows Vista or Windows 7 you will need to install a similar terminal
program to complete the setup.
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To get started, open HyperTerminal and start a
new connection. The terminal session should be
setup using 9600Baud, 8 bit, no Parity, and no Flow
control.

For those who are familiar with the Cisco IOS you
may wish to jump ahead to the commands. For the
rest, keep reading and we’ll walk you through it step
by step.

Along the way we’ll even explain why we use the
commands below so that you have some basic under-
standing of what you are doing. Hopefully you will
walk away with some new found knowledge.

Privileged EXEC Mode
Now that we are connected to the switch let's

login. When logging into a Cisco switch under the
default configuration, you are in user EXEC mode
(level 1). In EXEC mode, you have limited access to
the status of the switch. However, you can't make any
changes or view the running configuration file.

Because of these limitations, you need to type enable to get out of user EXEC
mode. By default, typing enable takes you to “Privileged” EXEC mode (Level 15).
In the Cisco IOS, this level is equivalent to having root privileges in UNIX or
administrator privileges in Windows. In other words, you have full access to the
switch.

Let’s get started on the configuration of your switch. Type “enable” command
at the prompt. When prompted, enter the password and press Enter again. If no
password has been defined just press Enter.

NOTE:  The command prompt now ends with “#” indicating you are now at the
Privileged EXEC mode (Level 15).

Global Configuration Mode
To enter the IP address and Subnet Mask for the VLAN or configure the switch

ports you must first enter the configuration mode. To enter the global configuration
mode on the 3750G/3560G type “Config T” and press enter. This places the switch
in Global configuration mode and will allow configuration from the terminal
window for the selected interface. You should now have the switch (config)#
prompt.

Configuring the VLAN Interface

A VLAN is a switched logical network that is segmented based on the function
or application. VLANs are virtual LANs but have the same attributes as the physical
LAN. VLANs allow a user to create a virtual broadcast domain in which traffic can
be isolated to keep it reaching unwanted destinations. Any switch port can belong
to a VLAN, and unicast, broadcast, and multicast packets are forwarded only to
those end stations assigned to that VLAN.
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Now that you are in the Global configuration mode you need to select the interface
that you would like to configure. We’ll start with the default VLAN.

The switch will come with a default VLAN enabled. In the default configuration
all ports on the switch have been assigned to VLAN1. The command below selects the
default VLAN for configuration to segment network traffic on the switch. If you are
adding an additional VLAN to existing hardware, substitute that VLAN number in
place of 1.

Enter the following commands (“XXX” = the actual network IP address)
interface Vlan1interface Vlan1interface Vlan1interface Vlan1interface Vlan1
ip address 192.168.87.XXX 255.255.255.0ip address 192.168.87.XXX 255.255.255.0ip address 192.168.87.XXX 255.255.255.0ip address 192.168.87.XXX 255.255.255.0ip address 192.168.87.XXX 255.255.255.0
endendendendend

Let’s look at what you just setup. By typing “interface Vlan1” you are entering the
configuration for that VLAN. The “IP Address” Command simply sets the IP address
of the VLAN1 interface for remote management purposes. The IP address must be
unique on the network.

IGMP Snooping Querier Configuration
By default, IGMP is enabled globally on the switch. To setup IGMP Snooping

Querier on the switch you must be in the Global configuration mode. To enter the
configuration mode once again type “Config T” and press enter.

Enter the following commands:

ip igmp snooping querierip igmp snooping querierip igmp snooping querierip igmp snooping querierip igmp snooping querier
ip igmp snooping querier max-response-time 25ip igmp snooping querier max-response-time 25ip igmp snooping querier max-response-time 25ip igmp snooping querier max-response-time 25ip igmp snooping querier max-response-time 25
ip igmp snooping querier timer expiry 205ip igmp snooping querier timer expiry 205ip igmp snooping querier timer expiry 205ip igmp snooping querier timer expiry 205ip igmp snooping querier timer expiry 205
endendendendend

By default IGMP Snooping is globally enabled on the switch. It is enabled on
VLANs by default. Global IGMP snooping takes precedent over VLAN IGMP
Snooping. If globally disabled you cannot enable IGMP Snooping on a per VLAN
basis.

The commands above simply enable the querier on the switch and set a few values
for maximum response time and the expiration duration for the querier.

Configuring Gigabit Ports Connecting to WheatNet-IP I/O Blades
and PC Drivers

Configuring the ports on the Cisco 3750G and 3560G is a key step in ensuring
optimal performance of the Wheatnet-IP network. This section will guide you in the
setup of each port used for Wheatnet-IP I/O Blades.

Switch ports operate in one of three modes, dynamic, trunk, or access mode.
Switch ports connecting to Wheatstone-IP devices must be in Access mode. Access

mode places the port in static access mode and gives it access to the default VLAN. The
switchport nonegotiate command disables the Dynamic Trunking Protocol and tells
the port not to generate DTP frames.
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 To setup ports on the switch you must also be in the Global Configuration mode.
To enter the configuration mode once again type “Config T” and press enter.

Enter the following commands
Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)
switchport mode accessswitchport mode accessswitchport mode accessswitchport mode accessswitchport mode access
switchport nonegotiateswitchport nonegotiateswitchport nonegotiateswitchport nonegotiateswitchport nonegotiate
speed 1000speed 1000speed 1000speed 1000speed 1000
spanning-tree portfastspanning-tree portfastspanning-tree portfastspanning-tree portfastspanning-tree portfast
endendendendend

Ports on the 3750G and 3560G can be configured individually or in a “Range.” If
range is desired type Interface range gig1/0/1 - 24 using the desire number of ports.

Configuring Gigabit Ports Connecting to Wheatnet IP Control
Surfaces, GP Panels, and XY Controllers

Enter the following commands
Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)
switchport mode accessswitchport mode accessswitchport mode accessswitchport mode accessswitchport mode access
switchport nonegotiateswitchport nonegotiateswitchport nonegotiateswitchport nonegotiateswitchport nonegotiate
speed 100speed 100speed 100speed 100speed 100
spanning-tree portfastspanning-tree portfastspanning-tree portfastspanning-tree portfastspanning-tree portfast
endendendendend

Ports on the 3750G/3560G can be configured individually or in a “Range.” If range
is desired type Interface range gig0/1 - 24 using the desired number of ports.

Configuring Ports for Linking to Other Network Switches
Trunk mode is used when connecting another switch to the port.
To set a specified port to trunk mode when connecting to another network switch

the port needs to be set for trunk mode. To setup Gigabit ports on the switch you must
also be in the Global Configuration mode. To enter the configuration mode once again
type “Config T” and press enter.

Enter the following commands.
Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)Interface gig 0/x (X=the Ethernet port being configured)
switchport trunk encapsulation dot1qswitchport trunk encapsulation dot1qswitchport trunk encapsulation dot1qswitchport trunk encapsulation dot1qswitchport trunk encapsulation dot1q
switchport mode trunkswitchport mode trunkswitchport mode trunkswitchport mode trunkswitchport mode trunk
switchport nonegotiateswitchport nonegotiateswitchport nonegotiateswitchport nonegotiateswitchport nonegotiate
endendendendend

WheatNet-IP / Feb 2010 page  A – 16.7
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Checking and Saving the Switch Configuration
When you are done, check the switch configuration by typing the following

command from the command prompt.
show running-configshow running-configshow running-configshow running-configshow running-config

Once you are sure you have the correct configuration you need to save it. You can
save the configuration by typing one of the following commands

copy running-config startup-configcopy running-config startup-configcopy running-config startup-configcopy running-config startup-configcopy running-config startup-config
or

write memorywrite memorywrite memorywrite memorywrite memory

Below is a diagram that shows you what a typical configuration might look like.

WheatNet-IP / Dec 2009 page  A – 16.8
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HP Procurve 2810 Configuration for WheatNet-IP

Overview
Let’s take a look at what needs to be done to get your HP Procurve 2810 switch

ready for the installation of your WheatNet-IP system. Properly configuring your
switch allows you to take advantage of the “management” capabilities to control
network traffic and allows the network to operate at its highest potential. This
becomes necessary to prevent overloading the network as the system size increases.

In this setup process you will setup switch ports according to the type of device
connecting to that port. You will be setting things like VLAN access, Trunking,
Speed, etc. Each section below gives you the exact commands needed to get your
WheatNet-IP network up running.

Below is a chart that gives you some information about the commands you will
be using to complete the setup. This can be a quick reference for you as proceed
through the configuration.

   Command                                      Purpose

   Configure Terminal   Enter Global configuration mode on switch

   Interface   Enter interface configuration mode

   Show running-config   Show the current running configuration

   Write memory   Writes the configuration to memory on the switch

   IP igmp querier   Enables IGMP querier

This document will explain the initial configuration of the HP Procurve 2810
switch. To get started you will need the HP provided console cable that came with
your switch. Go ahead and connect the console cable to the serial port on your PC and
the RJ-45 to the console port on the lower left corner on the front panel of the switch.
If your PC is not equipped with a serial port you will need a USB to Serial converter.

Next let’s get your PC ready to communicate. You will need a terminal program
such as HyperTerminal to finish this portion of the setup. HyperTerminal is an
application you can use in order to connect your computer to other remote systems.
These systems include other switches, routers, other computers, and Telnet sites.

HyperTerminal is located under the Start menu of your Windows 2000/XP PC.
If you are using Windows Vista or Windows 7 you will need to install a similar
terminal program to complete the setup.
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To get started, open HyperTerminal and start a new
connection. The terminal session should be setup using
9600Baud, 8 bit, no Parity, and no Flow control.

For those who are familiar with the HP Procurve
switches you may wish to jump ahead to the commands.
For the rest, keep reading and we’ll walk you through it
step by step.

Along the way we’ll even explain why we use the
commands below so that you have some basic under-
standing of what you are doing. Hopefully you will walk
away with some newfound knowledge.

Privileged EXEC Mode
Now that we are connected to the switch let’s login.

When logging into an HP Procurve switch under the
default configuration, there are two privilege level modes.
These modes are Operator and Manager. Operator level
will allow you to see configuration information without
being able to modify any of the current settings. You also have limited access to the status
of the switch. But again, you can’t make any changes to the running configuration file.

Because of these limitations, you need to type enable to get out of Operator Privilege
mode. By default, typing enable takes you to “Manager Privileges” mode. Under Manager
Privilege there are three additional levels of access, Manager, Global Configuration,
Context Configuration.

Let’s get started on the configuration of your switch. Type “enable” at the prompt.
When prompted, enter the password and press Enter again. If no password has been
defined just press Enter.

NOTE:  The command prompt now ends with “#” indicating you are now at the
Manager level mode.

ProCurve#_ProCurve#_ProCurve#_ProCurve#_ProCurve#_

Global Configuration Level
To enter the IP address and Subnet Mask for the VLAN or configure the switch ports

you must first enter the configuration level. To enter the global configuration level type
“Config T” and press enter. This places the switch in Global configuration mode and will
allow configuration from the terminal window for the selected interface. This level is
equivalent to having root privileges in UNIX or administrator privileges in Windows. In
other words, you have full access to the switch.

You should now have the ProCurve(config)# prompt.

Configuring the VLAN Interface

A VLAN is a switched logical network that is segmented based on the function or
application. VLANs are virtual LANs but have the same attributes as the physical LAN.
VLANs allow a user to create a virtual broadcast domain in which traffic can be isolated
to keep it from reaching unwanted destinations. Any switch port can belong to a VLAN,
and unicast, broadcast, and multicast packets are forwarded only to those end stations
assigned to that VLAN.
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Now that you are in the Global configuration mode you need to select the interface that
you would like to configure. We’ll start with the default VLAN.

The switch will come with a default VLAN enabled. In the default configuration all
ports on the switch have been assigned to VLAN1 (DEFAULT_VLAN). The command
below selects the default VLAN for configuration to segment network traffic on the
switch. If you are adding an additional VLAN to existing hardware, substitute that VLAN
number in place of 1.

Enter the following commands (“XXX” = the actual network IP address)
Vlan1Vlan1Vlan1Vlan1Vlan1
ip address 192.168.87.XXX 255.255.255.0ip address 192.168.87.XXX 255.255.255.0ip address 192.168.87.XXX 255.255.255.0ip address 192.168.87.XXX 255.255.255.0ip address 192.168.87.XXX 255.255.255.0
endendendendend

Let’s look at what you just setup. By typing “Vlan1” you are entering the configuration
for that VLAN. The “IP Address” Command simply sets the IP address of the VLAN1
interface for remote management purposes. The IP address must be unique on the
network.

IGMP Querier Configuration
By default, IGMP is disabled globally on the switch. To setup IGMP Multicast

filtering on the switch you must be in the Global configuration mode. To enter the
configuration mode once again type “Config T” and press enter.

Enter the following commands:

ip igmpip igmpip igmpip igmpip igmp
ip igmp querierip igmp querierip igmp querierip igmp querierip igmp querier
endendendendend

The commands above simply enable IGMP on the default VLAN and the querier on
the switch.

Configuring Gigabit Ports Connecting to WheatNet-IP I/O Blades
and PC Drivers

Configuring the ports on the HP Procurve Series 2810 is a key step in ensuring optimal
performance of the WheatNet-IP network. This section will guide you in the setup of each
port used for WheatNet-IP I/O Blades.

 To setup ports on the switch you must also be in the Global Configuration mode. To
enter the configuration mode once again type “Config T” and press enter.

Enter the following commands
Interface X (X=the Ethernet port being configured)Interface X (X=the Ethernet port being configured)Interface X (X=the Ethernet port being configured)Interface X (X=the Ethernet port being configured)Interface X (X=the Ethernet port being configured)
speed 1000-FULLspeed 1000-FULLspeed 1000-FULLspeed 1000-FULLspeed 1000-FULL
endendendendend

Ports on the HP Procurve can be configured individually or in a “Range.” If range is
desired type Interface 1 - 24 (for example), using the desire number of ports.
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Configuring Gigabit Port Connecting to WheatNet-IP Navigator PC

The Navigator PC port can be left in the default mode. Speeds will vary depending
on the type of network card installed in the PC. It is recommended that a Gigabit card
be installed in the PC, however it is not mandatory.

Configuring Gigabit Ports Connecting to WheatNet-IP Control
Surfaces, GP Panels, and XY Controllers

Enter the following commands
Interface X (X=the Ethernet port being configured)Interface X (X=the Ethernet port being configured)Interface X (X=the Ethernet port being configured)Interface X (X=the Ethernet port being configured)Interface X (X=the Ethernet port being configured)
speed 100-FULLspeed 100-FULLspeed 100-FULLspeed 100-FULLspeed 100-FULL
endendendendend

Once again, the ports on the HP Procurve can be configured individually or in a
“Range.” If range is desired type Interface 1 - 24 (for example), using the desired
number of ports.

Configuring Ports for Linking to Other Network Switches
Trunk mode is used when connecting another switch to the port.
To set a specified port to trunk mode when connecting to another network switch

the port needs to be set for trunk mode. To setup Gigabit ports on the switch you must
also be in the Global Configuration mode. To enter the configuration mode once again
type “Config T” and press enter.

Enter the following commands.
Interface X (X=the Ethernet port being configured)Interface X (X=the Ethernet port being configured)Interface X (X=the Ethernet port being configured)Interface X (X=the Ethernet port being configured)Interface X (X=the Ethernet port being configured)
trunktrunktrunktrunktrunk
endendendendend

Checking and Saving the Switch Configuration
When you are done, check the switch configuration by typing the following

command from the command prompt.
show running-configshow running-configshow running-configshow running-configshow running-config

Once you are sure you have the correct configuration you need to save it. You can
save the configuration by typing one of the following commands

copy running-config startup-configcopy running-config startup-configcopy running-config startup-configcopy running-config startup-configcopy running-config startup-config
or

write memorywrite memorywrite memorywrite memorywrite memory
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Below is a diagram that shows you what a typical configuration might look like.



page  A – 17WheatNet-IP / Apr 2009

A P P E N D I C E S

 Contents

WheatNet-IP / Feb 2013

Appendix 4

WheatNet-IP Logic Functions and Examples ............................A-18
Category 1: Direct Logic ...........................................................................................A-18

   VDip Function .........................................................................................................A-18

   Programmable Buttons ..........................................................................................A-21

Category 2: Audio Associated Logic .........................................................................A-26

Category 3: Discrete Logic ...................................................................................... A-29b

Category 4: Action Logic ...........................................................................................A-33



A P P E N D I C E S

page  A – 18WheatNet-IP / Apr 2009

WheatNet-IP  Logic Functions and Examples
As described in this manual, the WheatNet-IP system provides for certain logic (i.e.

non audio) related functions and controls. The messaging structure for these functions is
entirely contained within the WheatNet-IP hardware itself, and distributed over the same
LAN connection as is the audio. No PCs are required, other than to use the WheatNet-IP
Navigator GUI application to make the configurations and programming needed.

There are many different logic functions and controls available in the WheatNet-IP
system; these can be sorted into four different categories. This appendix will provide
specific examples in these categories to demonstrate the category as well as provide step
by step instructions on how to program the function with the Navigator GUI software.

Category 1: Direct Logic
This type of logic function acts directly on and controls the operation of certain control

surface features. Direct logic operation is independent of any BLADEs and/or physical
logic ports. Direct logic functions are available on the Evolution series of control surfaces
(E-4, E-5, E-6), and are further classed as to control surface functions and programmable
buttons.

VDip Function

Direct logic control surface functions are programmed on the control surface itself
under the Main>Options>VDIP window. These VDIP (Virtual Dip Switch) functions
affect how the control surface works, and can be set to act either globally, for all input
sources, or differently depending on the source.
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The following functions are available:
PFL/Cue Drop Out: Any fader channel that has been placed in Cue will
automatically be removed from Cue when the channel is turned ON.
EFS: Moving a fader up from full off will automatically trigger a START logic
command.
Program D Pre Fader: Sets the PGM D bus to be pre fader.
Program D Pre ON: Sets the PGM D bus to be ON independent of the ON/OFF
switch.
Timer Restart: Forces a return to 0 and start counting on the Timer display when
a fader channel is turned ON.
Fader Cue: Pulling a fader all the way down automatically puts the channel into
Cue.
Remote Ready: Forces the fader channel OFF indicator to be driven by an external
READY logic signal.
Studio 1 Mute: Mutes the studio 1 output when the fader channel is turned ON.
Studio 2 Mute: Mutes the studio 2 output when the fader channel is turned ON.
HP Mute: Mutes the headphone output when the fader channel is turned ON.
CR Mute: Mutes the control room output when the fader channel is turned ON.
Cue Mute: Mutes the cue output when the fader channel is turned ON.
Studio 1 Tally: Activates a tally 1 signal when the fader channel is turned ON.
Studio 2 Tally: Activates a tally 2 signal when the fader channel is turned ON.
Studio 3 Tally: Activates a tally 3 signal when the fader channel is turned ON.
Studio 4 Tally: Activates a tally 4 signal when the fader channel is turned ON.
Bus Minus Pre Fader: Sets the particular bus minus output signal to be pre fader.
Bus Minus Pre On: Sets the particular bus minus output signal to be pre ON.

As a programming example, let’s use the CR Mute function. This function is
commonly used to mute the control room speaker outputs while the talent microphones
are turned on to avoid feedback from occurring if the amplified microphone signal is
passed out the speakers and then picked back up by the microphone. The intention is
that whenever a microphone channel that happens to be located close to the control
room speakers is turned ON, the speakers are automatically turned OFF to prevent the
feedback. Once the microphone channel is turned OFF the control room speakers are
automatically turned back ON.

To enable this function, first identify the microphone source(s) that is(are) located
near the control room speakers. These are the source signals that could cause feedback.
In this situation you would normally want this logic action (mute the speakers) to
happen only with these particular source signals.

Open the VDIP form on the control surface by using the Options menu on the Main
tab of the control surface VGA display. This menu can be password protected so you
must have access privileges before you can modify these settings.
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Once the VDIP form is open, click on the SIGNAL button to change the VDIP
mode from the default global to per source, and then scroll through the INPUT
SIGNAL LIST until you highlight and double click the name of the audio source
(the mic signal) you wish to activate the muting. The source name should appear
in the SIGNAL window. Click on the CR Mute check box and hit the APPLY
button. The control surface has now been programmed to automatically mute the
control room output signal whenever any fader channel that has the mic signal
routed to it is turned ON. A caveat: this feature does not actually mute the speakers,
but only mutes the control room output signal. If, as is normal, you have connected
the speakers to an amplifier whose input is connected to the control room output
signal, this feature will work as expected; however, if for some reason the speakers
are connected to some other output signal, they will not be muted.

Repeat the process for any other mic signals that could cause feedback with the
control room speakers.

In similar fashion you can activate any of the other VDIP functions as you see
fit. Some of these, such as the mutes and tallys, may need to be set on a per signal
basis, while others, such as Timer Restart or PFL/Cue Drop Out, are better suited
to the default Global (i.e. for any signal) setting.
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Programmable Buttons

The evolution series control surfaces can be equipped with a number of switches
whose operational functions can be programmed by the user. These are located in two
different areas of the control surface panels. Possibilities include a pair of switches
located above each fader on the input panels, and a number of switches located on the
main monitor panel. Note that different models of these panels may have some or all of
these switches removed.

The programmable buttons on the fader panels are meant for enabling higher level
audio functions such as EQ or Dynamics on an as-needed basis. The functions available
are:

Take a Source: Automatically select a specific source signal for the fader channel.
Take a Preset: Select a previously saved set of processing functions (a Preset) and
apply them to the fader channel.
Toggle EQ In/Out: Change the current in/out mode of the EQ settings on the
channel.

WheatNet-IP / Nov 2009
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Toggle Low Pass Filter: Change the current in/out mode of the low pass filter.
Toggle High Pass Filter: Change the current in/out mode of the high pass filter.
Toggle Compressor: Change the current in/out  mode of the compressor.
Toggle Expander: Change the current in/out mode of the expander.
Toggle Left Phase: Change the input polarity setting for the left audio channel.
Toggle Right Phase: Change the input polarity setting for the right audio channel.
Change Mode: Step through the input channel signal modes: stereo,  mono, left only,
right only.
Clear Button Programming: Remove any previously set up button programming.

As an example, lets program the left programmable button on fader #1 of an E-6
control surface to be an EQ IN/OUT switch. Again, these functions are password
protected so you must have access privileges to program them. Also, not all surfaces will
have all functions available so the list of functions may be less than is shown here.

First press the SET button for fader #1 on the input panel. The E-6 VGA screen will
switch to settings for fader #1. If not already visible, click on the INPUT tab. In the
PROGRAMMABLE section of the window, left click on the appropriate display
window (top window for left button, bottom window for right button); a drop down list
of functions will appear. Select the TOGGLE EQ IN/OUT function.

WheatNet-IP / Nov 2009
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The left hand button on fader channel #1 will now function as an EQ In/Out switch.
In a like manner, other functions and other input channel buttons can be programmed.

To remove any programming from a button, choose CLEAR BUTTON PRO-
GRAMMING as the function, the button will now do nothing.

The programmable buttons on the main monitor panel have different functions tied
to more general control surface functions rather than input specific functions. Selecting
the Options>Programmable Buttons menu item on the main screen of the control
surface VGA display (this is password protected so you must have access privileges)
opens a drop down window listing the monitor panel programmable buttons (up to 14
max, the number will vary with the control surface model). For each button there is a
drop down window displaying its current operating mode. The default mode is
MOMENTARY/SURFACE LED.

The available programmed mode functions are:
Momentary/Surface LED: Causes the button function to be momentary and the
button LED indicator to be activated directly by the button’s position.
Tally LED:  The button LED indicator becomes an available logic output to be
controlled externally.
Toggle: The button functions as an alternate action; push ON, push OFF switch.
Momentary/LIO LED:  Causes the button function to be momentary and the
button LED indicator controlled externally.
Automation LIO:  Causes the button to work with, and the LED indicator to be
controlled by, an external 3rd party device such as automation.
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Software Controlled: Enables a list of functions to choose for the button to activate.
Load an Event: Loads a previously saved event
(a show or set of control surface settings).
PFL Clear: Deactivates any PFL or Cue func-
tions.
Show Main window: Switches the VGA display
to the main window.
Show Input Source screen: Switches the VGA
display to the input source select view.
Show EQ screen: Switches the VGA display to
the EQ settings view (some surfaces may not be
equipped with this function).
Show Dynamics screen: Switches the VGA dis-
play to the Dynamics settings view (some sur-
faces may not be equipped with this function).

Let’s choose a couple of examples for the monitor
panel programmable buttons. First let’s enable button #1
to switch the control surface settings to your morning
show. Before you can do this, you must of course have
saved a set up for your morning show in the first place.
If you haven’t already done this consult your control surface operator’s manual for
details, but in brief you must set up the surface exactly as you want it to be. This includes
source selection, channel assignments, EQ/Dynamics settings, etc.; in short, just how
you want the control surface to be running during the show. Save these settings as an
event with the name “Morning” or “Zoo” or whatever else you want to call it.

From the control surface VGA dis-
play screen main page choose
Options>Programmable buttons. For
button #1 choose SOFTWARE CON-
TROLLED from the drop down list,
and the EDIT button will illuminate.
Click on the EDIT button to open the
functions list and double click on
LOAD AN EVENT. This opens the
Events list; select “Morning” or what-
ever the name of your desired event is
and then click APPLY. Button #1 will
now recall the “Morning” event set up
whenever it is pressed.

For the second example let’s make
button #2 perform a talkback function
to a remote location, say destination #5
in BLADE 2. We will make this work
by making a temporary crosspoint con-
nection of our talkback signal (typi-
cally the talent mic), which in our
example is source #3 in BLADE 1, to
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destination #5 in BLADE 2. A temporary connection in the WheatNet-IP system is
where a destination’s normal audio source connection is temporarily removed
(normally for as long as a button is held down) and a secondary connection is
substituted. Once the button is released, the secondary connection is removed and
the original one is restored.

From the control surface VGA display screen main page choose
Options>Programmable buttons. For button #2 choose MOMENTARY/SURF
LED which is the default. This tells the control surface that you want programmable
button #2 to act as a momentary switch (it stays engaged for only as long as the button
is held down) and the switch indicator LED is to be illuminated directly by the
surface for as long as the button is held down.

We’ve told the surface how we want the button to act; we must now tell it what
we want it to do. If not already running, we must connect and start the Navigator GUI
software, because this is where we’ll program the crosspoint connections.

In the System Pane view, click on the engine BLADE for our control surface to
display the BLADE tabs and click on LIO info tab. The LIO properties window will
open, showing a listing of all the available logic signals for the control surface. Select
“Spare Btn2” from the list to choose our button and double click on the MOMEN-
TARY CONNECTION box; the LIO CONFIGURATION window will open. Click
on the MOMENTARY CONNECTION check box to enable it.

In the DESTINATIONS window, double click to bring up the destinations list
and scroll to BL02D05 or whatever you’ve named it.

In the SOURCES window, double click to bring up the sources list and scroll to
select BL01S03 or whatever you’ve named the 3rd source in BLADE 1, which is
your talkback signal. Finally, click OK and the momentary connection information
will be displayed on the "Spare Btn2" line.

That’s all there is to it; whenever you press programmable button #2 on the
monitor panel of the control surface, destination #5 in BLADE 2 will receive audio
from source #3 in BLADE 1 (the talent mic signal) until the button is released.

In a like manner all of the programmable buttons on the control surfaces can be
programmed for any of the available functions. As a final note, once you have
completed your programming, please be aware that Wheatstone can provide custom
laser etched buttons with whatever labels you specify - a very handy way to dress
up your control surfaces. Contact Wheatstone Sales or Customer Support if you wish
to order custom buttons.
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Category 2: Audio Associated Logic
There are many logic functions that are associated with or tied to specific audio

signals. You may have a START or a STOP logic function that associates with a
specific CD player or Automation machine, or ON and OFF logic functions that
associate with a control surface fader channel. In the good old days you would have
to wire a multi-conductor control cable from the logic ports on the machine to the
logic ports on your console. Once you were done, those logic connections would
only work for that one machine and one fader channel; if you patched your audio
to a different channel, the logic wouldn’t work right anymore. For this reason (and
to make it easier to set it all up in the first place), general practice was to wire all
of these connections up to punch blocks so connections could be changed via punch
downs rather than rewiring complicated multi-pin connectors.

It’s much easier with the WheatNet-IP system. First of all, many devices
(including Wheatstone control surfaces) now support logic control directly over
Ethernet connections, so separate logic wiring isn’t needed. For that equipment
that still requires physical logic connections, WheatNet-IP devices provide 12
available logic connections on every BLADE, and the system provides for audio
associated logic. That means the only physical wiring you’ll need for these devices
is a direct connection from the device logic connector to the RJ-45 jacks on a
BLADE.

Here’s how it works. Each audio signal within the WheatNet-IP system - that’s
every source and every destination including control surfaces - can have up to 12
different logic functions (from a list of 500 different types) associated with it.
Whenever an audio crosspoint connection is made between a source and a
destination, the system looks for matching logic functions (for example START
and STOP). For every matching function, a virtual logic connection is established
such that the logic input will control the logic output. If the audio connection is
changed, the system looks for matching functions in the new connection. In this
manner the logic functions are associated with or attached to the audio devices, and
hence follow with whatever audio connections are made.

This makes it easy to enable complex logic functionality without a lot of
physical wiring, and minimizes the need for punch blocks or other cross connect
and fan out wiring devices.

For an example, let’s set up our system so that a control surface ON button will
start a Denon DNC620 CD player. This machine has a D-sub 25 logic connector,
with a START function located on pin #9 and Command Common located on
pin #23. A momentary connection between pins 9 and 23 will cause the machine
to begin playback. Let’s assume that the CD player is located in our Air studio,
which has an E-6 control surface and e engine BLADE #4, and 88a analog
BLADE #5. We’ll say that the CD’s stereo audio output is connected to stereo
input 7 on BLADE #5 and we have given this source signal the obvious name
“CD.” Let’s further assume that we have already used the first logic port
connection on this BLADE for our ON-AIR warning light, so we want to use the
second logic port connection, pin #3, to START the DNC620. Your system will
likely have different BLADE and port numbers than these in the example; just
substitute your ID #s as necessary.
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First we need to wire the logic ports, connecting pin #3 and #1 of the first logic connec-
tor on BLADE #5 to pins #9 and #23 respectively on the DB-25 connector of the DNC620 
machine. That’s all the physical wiring we will need to do for this function.

In the WheatNet-IP Navigator GUI, we need to locate the audio signal that represents the 
CD audio; that is BL05S07 which we have subsequently named “CD.” On the crosspoint 
grid we can search until we see the source signals for BLADE #5, and then locate “CD.” 

Right click on the source signal name “CD” which opens the signal edit window and 
choose “Modify Signal...” from 
the popup. Click on the LIO Info 
tab of the Source Signal Wizard 
to open the LIO info view. Click 
on the “ADD” button to open 
the “ASSIGN an LIO” window. 
Click and select pin 3. In the Di-
rection: box choose Output as we 
want to create a logic output to fire 
the Denon machine. Finally, in the 
Function: window scroll down 
and select Machine Start. This 
is the all-important function that 
the system will attempt to match 
up to create our virtual logic con-
nection. It doesn’t matter what 
the function name actually is, it’s 
only necessary for there to be a 
match on the destination side. It 



page  A – 28WheatNet-IP / Apr 2009

A P P E N D I C E S

WheatNet-IP / Feb 2013

makes sense to use the function Machine Start, however, one, because it’s a clear, easily un-
derstood name, and two, more importantly, the control surface automatically has a Machine 
Start function mapped on each fader. Click Apply and your LIO tab should look like this. 

Click Close to close the Edit window. Then click Finish to exit the Source Signal Wizard. 
In this fashion, you can map up to 12 different logic functions with each audio signal. Notice 
also, that you could have mapped this function to a physical logic port in a different BLADE 
by using the signal tree on the left side of the window. This feature is very useful when you 
need more than the 12 physical logic ports in the BLADE; just map the logic signals onto 
another BLADE and wire your logic connections to it. For audio associated logic, the audio 
signal and the physical logic port can be in different BLADEs.

A further note about logic functions: Just because we have used the Machine Start 
function here doesn’t mean it’s all used up and can’t be used elsewhere; the complete set 
of over 500 functions are available for every signal, so you can use Machine Start over and 
over again. In fact that’s what makes audio associated logic so powerful - any signal that 
has the Machine Start function defined will automatically create the virtual logic connection 
anytime it is cross connected to any destination signal (say a fader channel) that also has 
the Machine Start function defined. Just as you need only the one physical wire to connect 
to the machine logic connector, you need only the one Machine Start function definition to 
allow any channel of any surface anywhere in the system to exercise Machine Start logic 
control of the Denon.

To continue with the example: we’ve wired up the logic connection to the machine 
and mapped and defined the Machine Start logic function. Let’s move over to our control 
surface and pick a fader channel, say fader #3. Check the source name display above the 
fader indicating which audio source is currently connected to the destination FADER 3 of 
the control surface. Make sure it is not the Denon machine. Pushing the channel ON button 
will turn the fader channel on, but will do nothing as far as the Denon machine is concerned. 
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In the WheatNet-IP Navigator GUI, locate the destination signal for fader 3 of the 
control surface and right click on it and choose modify signal to get to the LIO info tab 
for this signal. You will notice that there is already defined the logic function Machine 
Start, among others. For future reference, you might want to make note of all of the 
functions used. By the way, this information is also visible in the Details Pane. Close 
the window and go back to the crosspoint grid.

Make an audio connection between the source signal “CD” (the Denon audio sig-
nal) and the destination FADER 3 on your control surface. You can use the crosspoint 
grid, or use the source selector knob on the control surface; it doesn’t matter as long 
as you make the connection.

Now turn on fader channel #3 and the CD player will start playing! Manually 
STOP the CD player by pressing its front panel switch. Break the audio connection 
between the CD player and fader 3 and make a new audio connection between “CD” 
and fader #5 and turn that channel on. The CD player STARTs playing audio again, 
this time over fader #5. This is the power of associated logic; a single physical con-
nection can provide transparent system-wide logic functionality.

You’ll notice that turning the fader channel OFF did not stop the Denon machine; 
that’s why you had to do it manually. This is because we have only defined the Ma-
chine Start function. We will leave the definition of the STOP function as an exercise. 
Remember, each audio signal can have up to 12 associated logic functions, so there’s 
plenty of room for STARTs and STOPs and ON TALLYs, etc.

Many of the logic functions needed in a typical radio environment are associated 
with audio signals. You’ll find the associated logic functionality of the WheatNet‑IP 
system very useful in these situations.

Logic Function definitions: A large number of function names are defined in the 
WheatNet-IP system. The functions available at the time of this writing are shown in 
groups 1 through 7 below, along with descriptions of where and how they are used.

1. These functions are used with audio associated logic. The audio source they are as-
sociated with is expected to connect to a surface fader (example: E6In01), which will 
have a matching pre-programmed function.

Machine Start – logic output used to start a machine, such as a CD player, when 
a surface fader is turned on – by default the Machine Start function is a latched 
signal, but can be made to provide a pulse by selecting the Machine Start Pulsed 
VDip option for the associated audio signal in the control surface VDip settings 
(see the manual for the control surface type you are using)
Machine Stop – logic output used to stop a machine, such as a CD player, when 
a surface fader is turned off
Ready LED – logic input used to control the lighting of the OFF button on the 
fader to advise the operator of a condition such as a CD player being cued up and 
ready to play – the machine usually provides an alternating on and off signal so 
that the OFF button flashes on and off 
On Tally – logic output used to provide a tally of the fader’s ON button to a remote 
location
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Off Tally – logic output used to provide a tally of the fader’s OFF button to a re-
mote location
Remote On – logic input used to turn the fader on from a remote location
Remote Off – logic input used to turn the fader off from a remote location
Cough – logic input used to unassign the fader from its output bus while a switch 
at a remote location is pressed, allowing talent at a microphone the chance to cough 
(or make some other sound) without it being heard on air
Talk Back – logic input used to assign the fader to the surface cue audio while a 
switch at a remote location is pressed, so talent at a microphone can talk directly 
to the board operator

2. These functions are programmed on logic-only destinations to control the timer on 
a surface. The logic-only destination must be routed to the surface source signal (ex-
ample: E6TIMER on an E-6) that has the timer logic pre-programmed on it.

Start Timer – logic input to start a surface timer from a remote location
Stop Timer – logic input to stop a surface timer from a remote location
Reset Timer – logic input to reset (set to zero) a surface timer from a remote location
Hold Timer – logic input to hold a surface timer at its current setting from a remote 
location

3. These functions are programmed on logic-only destinations to interface with the 
Silence Detect functions. The logic-only destination must be routed to the logic signal 
that is automatically created when an output is enabled for Silence Detect. See the sec-
tion on Silence Detect starting on page 4-52 of this manual for more details.

SDet Failure – logic output to indicate when an output set for Silence Detect is in 
a failed state; that is, when the primary source fails to provide audio to that output
SDet Mux Pos – logic output to indicate when an output set for Silence Detect is 
using its backup audio source
SDet Force Pri – logic input to force an output with Silence Detect enabled to its 
primary source
SDet Force Sec – logic input to force an output with Silence Detect enabled to its 
backup source

4. These functions are currently undefined.
Take Preset n (where n = any integer between 1 and 10 inclusive) 

5. These functions are programmed on logic-only destinations to indicate when certain 
sources on the surface have their fader on. The logic-only destination must be routed 
to the surface source signal (example: E6TALLY on an E-6) that has the tally logic 
pre-programmed on it. Sources that will trigger the surface tallies are set in the surface 
VDip settings (see the manual for the control surface type you are using).

Studio n In-Use (where n = any integer between 1 and 12 inclusive) – logic output – 
the numbers 1, 2, 3, and 4 correspond to tallies 1, 2, 3, and 4, respectively – use of 
the remaining values for n is currently undefined
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6. These functions are programmed on logic-only destinations to use with program-
mable (spare) buttons on a surface. The logic-only destination must be routed to the 
surface source signal that has the logic for the desired spare button pre-programmed 
on it. On an E-6, for example, there are 14 such sources, named (by default) Spare1, 
Spare2, and so on, through Spare14. Other surfaces may have fewer buttons, and thus 
fewer sources.

Switch n (where n = any integer between 1 and 14 inclusive) – logic output to read 
a spare button. No matter which spare button is used, the function must be Switch 1; 
use of the remaining values for n is currently undefined.
Switch LED n (where n = any integer between 1 and 14 inclusive) – logic input 
to light the LED in a spare button. No matter which spare button is being lit, the 
function must be Switch LED 1; use of the remaining values for n is currently 
undefined.

7. These functions are by design undefined, to be used in any manner desired. They 
may be associated with audio signals or programmed on logic-only signals as needed, 
and may be used with input or output logic as required. Keep in mind the master rules 
of system logic: (1) a logic input must connect to a logic output; and (2) a common 
function name must be used at both ends of a logic connection.

User n (where n = any integer between 1 and 500 inclusive)

Category 3: Discrete Logic
A third class of logic functions available in WheatNet-IP systems is discrete logic. 

These are logic functions that work on their own, with no specific association to any 
audio signals. Typical of these is a situation where a button press in one area lights a 
light in another, or a satellite receiver detects a tone and closes a relay that is to be used 
to start a record machine. The WheatNet-IP system can handle this type of logic func-
tion very easily. As in the associated logic case, you need only to wire the specific logic 
connections on your devices to the logic ports on any conveniently located BLADE. All 
of the control communications between BLADEs happens over the LAN connection.

As an example let’s take the case of a profanity delay DUMP control. We’ll assume 
we have a switch panel located by our talent microphone and we have an airTools-6000 
Delay unit located in our rack room. BLADE #5, located in the studio, has available 
logic ports, as does BLADE #19 located in the rack room. We’ll use LIO #3 in BLADE 
#5 and LIO #1 in BLADE #19. Your system will likely have different BLADE and logic 
port numbers than these in the example; just substitute your BLADE ID#s as necessary.

To activate the DUMP function the airTools Delay unit requires a momentary clo-
sure on pins #7 and #13 of its DB-25 GPIO control connector. First, in the rack room, 
wire the Delay unit GPIO connector pins 7 and 13 to the first RJ-45 logic connector 
on BLADE #19, pin #1 and #2 respectively. In the studio you will need to wire the 
normally open contacts of the DUMP switch to the BLADE #5 pins #1 and #4. 
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In the WheatNet-IP GUI, you will need to define two new signals for the logic
function. You will need a logic source signal, representing the button, and a logic
destination signal, representing the DUMP connections on the airTools Delay unit. First
click on BLADE #5 in the System Pane of the GUI to open the tab windows for
BLADE #5. Click on the Sources tab to open the sources window, and click on the ADD
button to open the Signal Definition Wizard. Click on LIO only as the signal type and give
this new signal a convenient name such as “Dump Sw.”

On the LIO Info tab of the Wizard, click on the ADD box. Click on the “LIO 1 pin 4,”
and then select Input in the Direction: box as the logic direction (the DUMP switch will
be a logic Input). Finally open the logic function drop down menu and choose a logic
function. As mentioned
previously, the logic func-
tion chosen is unimpor-
tant, the requirement is
that the device you wish
to control must also use
the same function. In this
case choose “User 1” as
the function; you can re-
name it as “DUMP” if you
like. Click Apply, click
Close, then click Finish,
and the new logic source
signal definition is com-
plete.

Click on the System
icon and Crosspoint tab to
open the crosspoint grid;
you should see your new
“Dump Sw” signal source.
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Similarly you need to define a new logic destination signal in BLADE #19. Click on
the BLADE #19 icon in the System Pane and select the Destinations tab. As before, click
on ADD, then select LIO only, to make the new signal, and name it something like
“Dump Dev.” On the LIO Info tab of the Signal Definition Wizard, click Add, select
“LIO 1 Pin 2” to map the logic pin. In the Direction: box select Output for the direction,
and finally select “User 1” as the logic function (this is where the logic function must
match what you’ve previously defined for the DUMP switch; if these functions do not
match, then the logic connection will not work).

Click Apply, then Close, then Finish on the Wizard, and your new logic destination
signal will appear in the crosspoint grid.



A P P E N D I C E S

page  A – 32WheatNet-IP / Apr 2009

To activate and make this logic function operational, you must make a crosspoint
connection on the grid between the source "Dump Sw" and the destination “Dump Dev.”
Once this has been done, pressing the DUMP switch will create a closure on the logic
port of BLADE #19, triggering the DUMP function in the airTools Delay unit. Hint: you
can use the WheatNet-IP Navigator GUI to trouble shoot this logic connection. Click
on the BLADE #5 icon in the System Pane and click on the LIO Info tab. The window
that opens will show the logic signals as they have been defined for the BLADE; you
should see your “Dump Sw” shown on line 3. If you have wired and mapped this
correctly, the circular indicator in the INPUT column for LIO #3 will change color every
time you press the switch. This tells you that the logic input has been wired correctly
and is working.

Likewise, if you click on the BLADE #19 icon and LIO Info tab, you should see the
“Dump Dev” logic signal shown on line 1. Again, if defined correctly and crosspoint
connected to the “Dump Sw” signal, the circular logic status indicator will change color
when you press the DUMP switch, showing activation of the logic signal at the output
port on the BLADE.

All discrete logic functions are defined and configured the same way. Once you’ve
made a few of them work to get comfortable with the process, it’s easy. Just remember
the fundamentals:

• Define the source and destination signals and map them to the logic ports you’ll use.
• Choose a matching pair of logic functions.
• Make a crosspoint connection between the source and destination signals (note, if

you want to, you can lock this connection just as you can audio signals).
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Category 4: Action Logic
This fourth class of logic function in the WheatNet-IP system includes system

events such as Salvos and Momentary Connections. Action logic is intended to
force crosspoint connection changes. Perhaps you have an Air studio that
undergoes a major change in signal connections when the morning show finishes.
Instead of having the talent go through and change all the source and destination
connections individually at each shift change, you could create a Salvo that makes
all of the required changes at once. Furthermore, you can use a logic connection
to a button to fire the Salvo itself, so all that your operator needs to know is to push
the button at shift change. What could be easier?

For an example, let’s assume you have created a Salvo to change out your
studio configuration from Morning Drive to your 10 o’clock show, and you’ve
cleverly called it “10AM.” You are planning to use a switch panel in your studio
to fire the Salvo, and you’re going to wire the “10AM” switch on the switch panel
to logic port #4 on BLADE #5.

Here’s how to do it: First wire up the normally open terminals of the switch to
pins #1 and #5 on the first RJ-45 logic port of BLADE #5. In the WheatNet-IP
Navigator GUI, click on the icon for BLADE #5 in the System Pane, and then click
on the LIO Info tab. On LIO #4 (the 4th line) double click on the Fire Salvo box
to open the window and click on the “Fire Salvo” check box. In the drop down
window, scroll and select the “10AM” Salvo and click on the OK button.

To test this out, switch to the crosspoint grid view of the GUI and watch the
cross-points switch on the grid as you press the switch (be sure to do this at a safe
time as you will actually be switching audio and can mess up a show On - Air).

You can also use action logic to make a crosspoint change (hint: use a Salvo
of one signal) that switches the source for a destination, or to make a temporary
crosspoint change that substitutes a source to a destination for as long as the button
is held down. The latter is particularly useful in Talkback/Intercom types of
situations.
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External Controllers
The WheatNet-IP audio networking system has been designed to work with a

growing family of external hardware and software controllers. These controllers allow
for a wide range of control functions, from making a single crosspoint to complex
condition control scripts. There are hardware based controllers such as the Wheatstone
HBX8 hot-button controller, the Wheatstone XYC xy controller, and the GP-8P and
GP-16P programmable controllers. There are software controllers such as PC-XY and
the Event Scheduler, and control applications by various Automation System providers
ranging for Enco and OMT to Crestron and AMX.

All of these controllers integrate with WheatNet-IP by means of an Ethernet
connection to the system; no physical GPI/GPO or serial cable wiring is required.

Wheatstone provides a separate software utility called the WheatNet-IP XYC
control GUI for setting up and configuring the hardware controllers provided by
Wheatstone. This password protected application allows you to set up the controller,
map it to the desired control destination(s), set up its operating modes, and organize the
signal visibility for the controller.

This image shows a typical set up screen from the control GUI.

The WheatNet-IP XYC control GUI is provided with the purchase of any of the
Wheatstone hardware controllers. Consult the manual included with the application for
specific information about your controllers.

For software based controllers please refer to the documentation provided with the
software package, or contact techsupport@wheatstone.com for more information.

WheatNet-IP / Jan 2011
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WheatNet-IP WDM Driver Installation
This technical document is intended to give you general information about

installing the WheatNet-IP WDM Driver. This driver is network based using
TCP/IP. It is recommended that a second Network Card be installed in the PC. The
first card will connect to the Audio storage network for file sharing. The second card
will connect to the WheatNet-IP network.

Hardware Requirements:

Standard PC (Intel or AMD x 86 based computer) with the following:
• 100 base T network interface configured to run in full duplex mode.
• USB Security Dongle (see page A-40) required for driver operation -

but DO NOT install it until after the driver has been installed.

Software Requirements:

The WheatNet-IP driver has been designed to run under the Windows™
operating system. The following are minimum requirements:

• Windows 2000 with Service Pack 4.
OR
• Windows XP with Service Pack 2.

Installation

To install the driver, locate the setup files on the CD received with the
WheatNet-IP system. Run the Setup_x.x.x.exe application (x represents the version
number of the current release). Make sure any previously installed version of the
WheatNet-IP driver or Audsnd (Winamp plugin) software has been removed.

1. Read the license and release notes before proceeding! Then click “I Agree”.
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2. Select the components you want to install (default selection is recommended) and
click “Next.” You will want to make sure that no audio applications are running at this time.

3. Choose the folder in which to install the WheatNet-IP PC Driver files. Using the
default destination folder is recommended. If required, select a new destination folder by
using the browse button. Navigate to the desired location and press “OK.” Once your
destination folder has been selected, click “Install” to proceed. During this process you will
see several DOS windows appear. This is normal as firewall and port settings are being
configured by the installer.
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4. During the file copy process you will see a Hardware Installation message. Click the
option to “Continue Anyway” to proceed with the install.

5. After the driver installs, you should see a successful install message. Click “OK,”
then click “Close.”
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6. You will see an error box appear indicating that the
AOIP License dongle is not present. Click “OK,” then insert
the AOIP License dongle now. The dongle was shipped with
your driver installation kit. One dongle is required per com-
puter. Each dongle has been programmed, as indicated on the
order sheet that accompanies the shipment, to enable a number of BLADE channels
(from 1 to 8, with 8 being typical). The dongle can be plugged into any USB port on
the computer, and its presence is required for the WheatNet-IP driver to work. As
indicated earlier, do NOT install the dongle until after the driver has been installed. If
you inadvertently installed the driver while the dongle was installed, you may need to
uninstall the driver and then re-install it with the dongle disconnected.

Once the dongle is connected to the machine you will see the License found dialog
box. Click “OK” to accept.

7. Now it is time to configure the driver settings. You will be prompted to run the
configuration program. Select “Yes” to configure the system.

WheatNet-IP / Dec 2009



A P P E N D I C E S

page  A – 41WheatNet-IP / Apr 2009

Configuration

The WheatNet-IP Driver Control application will allow you to setup the required
parameters for the driver. Here you will configure the unique ID of the PC driver, along
with choosing the Network interface card and number of channels available. There are
three versions of the driver. Depending on the version you purchased it will have one, four,
or eight stereo channels available.

Each control is described below:

System Parameters

• Network Interface – This control is used to select a specific network interface card
to use to connect to the WheatNet-IP network. If you only have one network
connection, then leave “Default Adaptor” selected. The IP Address of the selected
interface card is displayed in the IP Address field below the selection box.

• System ID – This control is used to form logical groups of equipment on a single
WheatNet-IP network. It is primarily used for engineering testing and should be
left at “1”.

• Status Report Interval(s) – This controls how often the driver sends status back
to the Master BLADE. The default value is 20 seconds.

• Number of Channels – This control is used to select the number of (full duplex)
stereo channels supported by this driver. There are three versions of the driver.
Depending on the version you purchased it will have one, four, or eight stereo
channels available. Select only the number of channels you plan on using on this
computer.

• PC BLADE ID – This is used to set the device number within the WheatNet-IP
system that this particular PC will be known as. Each device (BLADE) within the
system must have a unique ID number.

• Default Sample Rate – Select 44K or 48K as desired.

Other Controls

• Revert to Saved – This button causes the application to reread configuration values
from the registry, discarding any changes you have made.

• Cancel – Closes the application without updating the parameters.
• Apply – Applies the changes made to the driver parameters.
• OK – Applies the parameter changes and exits the application.
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Note that both the Apply and OK controls will need to re-start the driver for the changes
to take effect. The application will attempt to restart the driver for you. If the system is
unable to restart the driver, you will be prompted to reboot the computer. You may choose
to reboot the computer even if the driver restarts. Once the PC is rebooted you should see
it in the list of BLADEs in the Navigation GUI.

The configuration application and PC WheatNet-IP utility (if installed) are available
under the start menu. All of the WheatNet-IP driver related programs are grouped under
Start>All Programs>Wheatstone>WheatNet IP.

Uninstalling the Drivers

To uninstall the WheatNet-IP driver you can run unistaller application from
Start>All Programs>Wheatstone>WheatNet IP>Uninstall WheatNet-IP driver

and click “Uninstall” button.
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You will see a message box indicating that driver removal succeed. Click “OK.”
You will next see a dongle removal message:

After the driver uninstalled, you should see a successful uninstall message. Click
“Close.”

NOTE: Make sure you uninstall the driver before installing it again. If you
install it twice you will get multiple devices showing up, none of which will
work!
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IP-MTR64 Meters GUI

Adding Devices To The 3rd Party Tab

In order to utilize all the features of the IP-MTR64 Meters 
GUI the device must be added to the System 3rd Party Devices 
tab in the Wheatstone WheatNet-IP Navigator program (aka 
the  Navigator GUI). This sheet shows you the basics of that 
 procedure. 

You will need to know the IP address of the device being 
added, so you will want to find that out before you start.

Launch the Navigator GUI and make sure that System 0 is 
selected in the System pane. You will see something like this:

Now, to the right of the System pane, select the System 3rd Party Devices tab.

Click the Add button to bring up the Add 3rd Party Device dialog:
Type in a convenient Name and insert the IP  Address 

of the device being added. Leave the TCP Port at the 
default setting of 60021. From the Host Blade drop 
down select the Blade that you want to associate the 
3rd Party device with. Click Ok.

This completes the process of adding the device to 
the System 3rd Party Devices tab. The added device 
should show up in the System pane under the Blade 
you added it to. If it does not show up, or if it shows 
up but has a yellow question mark on it, then there 
is either a network issue that needs attention, or the 
device is not connected to the network at all, or one or 
more steps have been omitted or done incorrectly in 
the  configuration process.
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Introduction To IP-MTR64 METERS GUI
Get a quick read of any audio source, destination or stream in your WheatNet-IP 

Intelligent Network. Our new IP-MTR64 Meters GUI app displays a “wall of meters” 
on your computer screen for ongoing monitoring of audio peak levels and average levels 
at selected points throughout the entire network. Included is a separate FFT meter for 
spectral readings plus visual alerts should a channel go dark.

IP-MTR64 METERS GUI Overview

In today’s connected world of AoIP, it’s nice to know what’s going on with your 
audio. Not just the audio at local sources and destinations, either, but all audio at  every 
point in your network. You could haul out all that expensive test gear for a look, but who 
has time for that? It’s much easier to drop in an app like our new IP-MTR64 Meters 
GUI for the WheatNet-IP network, which gives you ongoing metering of audio levels, 
signal density, FFT readings – the works.

Fully customizable, the IP-MTR64 Meters GUI lets you display an almost  limitless 
array of metering and analysis on the monitor of any computer connected to the 
WheatNet-IP Intelligent Network. Plus, meters have silence detection, so you can see 
at a glance if an audio stream has gone down, and where.

Each meter – or cell – in your IP “wall of meters” can be set up as a horizontal, 
vertical or eyebrow bargraph meter. You can set up two or 20 or 60 or more cells in 
one “wall.” You determine where and what to meter: console inputs, mic outputs, the 
satellite receiver, studios, web streams, you name it. In addition, a separate analysis 
window allows you to view one audio stream in a variety of informative ways,  including 
FFT, 3-D plot, oscilloscope, energy vs. frequency, spectral dynamic range, and more.

Meters are arranged in a grid layout with the number of individual cells and the size 
and location of analysis windows you want. Style of metering can be curved, horizontal 
or vertical bargraph (you determine the number of bars) for mono or  stereo, and for 
 reading peak levels, average levels and peak over average levels. Set up one or two bright 
VU or PPM meters for instant loudness verification of on-air studios from across  the 
room, for example, and add five or 10 or 30 side meters for  checking levels of  players 
and mics feeding those studios. Size, background color and text  labeling for each cell 
is fully customizable by you. One meter at a time can be zoomed to a  full-screen view 
for detailed observation. Multiple layouts, complete with source  selection, metering 
choices, colors, labels, and analysis settings, can be saved and  recalled for use in  various 
situations.

IP-MTR64 METERS GUI Features

• Multiple bargraph meters in one computer display for checking levels of any 
source, destination or audio path in a WheatNet-IP network

• Separate analysis window for detailed signal evaluation using FFT, 3-D plot, 
oscilloscope, energy vs. frequency, spectral dynamic range,  and other tools

• Real-time metering of audio peak levels, average levels and peak over average 
levels; stereo or mono

• Two to more than 60 meter cells in a single display screen
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• Style of metering can be curved “eyebrow,” horizontal or vertical bargraph (you 
determine the number of bars)

• Silence detection/failover at a glance for alerting you if an audio stream has failed
• Customizable as an overall grid layout of meters with color options and font  selections 

for metering in a way that makes sense to you.

Installation
The IP-MTR64 Meters GUI software is distributed as a Windows executable installer file, 

WnetIP_MeterGui_x_x_x.exe, where the x_x_x part gives the version number.  Double-click 
this file’s icon to begin the installation.

Requirements

For small system the IP-MTR64 Meters GUI software does not have a heavy  requirements 
list. It will install on any modern computer with a Windows 2000 through Windows 7 
operating system.

In systems larger than 15 Blades the computer should have at least a dual core  processor 
and a minimum 4 GB of RAM.

Performing The Install

Double-click the installer file’s icon to begin the installation and see the following screen:

Click I Agree to accept the End User License Agreement.
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Click Next.

Click Install. 
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Click Close to complete the installation. An icon will appear on your desktop that you 
can use to start the IP-MTR64 Meters GUI program.

The program is installed by default to
C:\Program Files\Wheatstone\MeterMonitor\WheatNetIpMeterGui.exe
or in Windows 7 to
C:\Program Files (x86)\Wheatstone\MeterMonitor\WheatNetIpMeterGui.exe
 and can be launched from the Start menu, where it will appear in the Wheatstone group.

Program Operation – Getting Started
First time operation of any software is a learning experience. You will want to be 

on a computer that’s connected to a WheatNet-IP system when starting the program the 
first time. Note that the computer must have an IP address on the same subnet as the  
Wheat Net-IP system hardware.

License Key

The first time you start up the program you will be asked for a license key.
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If you wish to run the software beyond the seven day trial period you will need 
to  purchase a site license for the program from your Wheatstone Corporation sales 
 representative.

To continue without entering a license key click Ask Me Later. Each time you restart 
the program without having entered a valid license key you will again be prompted to 
enter one. In our example screen shot above there are four days remaining in the trial 
period. After the seven day trial period is over the nag screen will no longer give you the 
option of continuing unless you enter a valid license key.

If you have a license key to enter, 
click Enter License Key to bring up the 
screen on the right:

Enter the license key that you obtain 
from Wheatstone Technical Support 
and click OK. The following screen 
appears when a valid license key has 
been entered:

Click OK and the program will open in full screen mode.
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First Time Operation

The first time you start up the program you will need to do some basic setup. The 
program opens in full screen mode. For convenience the following screen shots are made 
with the screen resized. Here’s the opening screen:   

Network Setup

Select Setup>Network... from the menu to bring up the Network Setup dialog:

Click the Set NIC... button and select the NIC that interfaces to the WheatNet-IP 
system from the drop down list:
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Click Okay. Leave the 3rd Party 
Device Port: setting at the default.  
Click Okay. You will see a notice that 
you will need to restart the program for 
the changes to take effect.

Click OK, then close the program 
and restart it.

Note that the computer must have an IP address on the same subnet as the WheatNet-IP 
system hardware.
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“Discovering” The System Components

The IP-MTR64 Meters GUI will need to gather some information from the system. 
From the menu, select WheatNet-IP System>System Scan... to start the process.

In the Host Blade IP Address: field, enter the 
IP address of one of the Blades in the system and 
click the Start Scan button. The data display area 
will start to fill with data from the system. When 
the scan is complete the data display area’s last 
entry will be “Ok”, and the Cancel button will 
change to become a Finish button.

Click Finish. You’ll be asked if you want to 
save the system information to disk. Doing so 
will insure that the program uses the data the 
next time it is started. However, if you make 
any changes to the system you will need to redo 
the scan and re-save the scan results to keep 
the Meters GUI program up to date.

If you make any changes to 
the system you will need to 
redo the scan and re-save 
the scan results to keep 
the Meters GUI program up 
to date.
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If you click Yes a typical Windows file save dialog will appear. Select the desired 
location and give the file a name, then click Save.

Any time you want to see the current system information the program is operating 
with, select WheatNet-IP System>View Info... - the WheatNet-IP System Information 
screen will appear:

When done viewing this screen click the red ‘X’ icon in the upper right corner to 
close the window.
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Setting Up Meters
Until you start working with the meters you see a default layout with no working 

meters. So let’s get a meter playing.

Configuring A Meter Cell

Right-click in the first meter cell and select Configure... from the popup menu.

Change Meter Style: to Basic Bars. Now pick a signal from your system that you 
want to display. First choose either the Source or Destination tab, depending on which 
signal type you want to display, then click the set button (labeled with three dots) and 
 double-click the desired signal name in the list that appears. Give the meter a descriptive 
Label: and keep the other settings at their defaults. Click Okay.

You should see the meter running in the first meter cell, and it will show any audio 
present on that signal.

If you right-click on the same meter cell and select Zoom In... from the popup you will 
see that individual meter cell in a full screen display. Right-click in the full screen display 
and select Close in the popup to go back to the normal view.

Note that you can also configure a meter cell to show a graphic, such as a station logo, 
or even a picture of you, or your boss, or even a pet.

Go ahead and configure a few more cells. Here’s the standard layout on a typical system 
with a few meters configured:
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Configuring The Analysis Window

Before you can use the analysis window you need to do some configuring in 
WheatNet-IP Navigator. The meter application must be added to the 3rd Party Devices 
in Navigator to enable the analysis window.

In Navigator, select the System 3rd Party Devices 
tab and click the Add... button to bring up the Add 
3rd Party Device window.

Give the device, which in this case is actually 
the IP-MTR64 Meters GUI program, a convenient 
Name. Enter the IP Address of the computer on 
which the meter application is running. Accept 
the default TCP Port and click the down arrow 
to the right of the Host Blade button to select the 
desired Blade.

Click Ok.
You should now see an icon for the meter 
application in the Navigator System Dock 
and its characteristics should show up on 
the System 3rd Party Devices tab.
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Using The Analysis Window

The first step in using the analysis window is to select the audio you want to view. 
For reasons that will be mentioned below, this must be a source signal. You will not be 
able to select a destination directly for analysis.

Right-click in the analysis window and select Take Source... from the popup. Find the 
desired source and double-click it in the list to present that source to the analysis window. 
The analysis window will now show the source’s audio in the presentation format selected, 
which is O-Scope by default.

Right-click again in the analysis window to change the presentation format. Select 
the desired format from the popup. Go ahead and experiment with the available formats 
to determine which one you want to use for the task at hand.

Once you have selected the desired presentation format, right-click one more time in 
the analysis window and select Configure... from the popup. You will be presented with a 
number of choices to alter the analysis view. The configuration choices will be different 
for each display format.

As mentioned above, you can only select sources to analyze. This is because the audio 
being analyzed is streamed to the computer from the host Blade via the meter analysis 
destination signal that was created when the application was set up as a 3rd party device. 
By default, this destination is named Anlys A and appears as a destination on the host 
Blade that was selected for the meter application.

Changing The Meter Layout

So far we’ve been working with the default meter layout. Select Layout>Configure... 
to bring up the Meter Cell Layout dialog to edit this layout. The Simple tab shows a  gallery 
of layout starting points.
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If you don’t find a layout here that suits your needs, switch to the Advanced tab.

There you’ll find a way to set up almost any layout you could want. Begin by selecting 
the number of Cols: (1 through 16) and Rows: (1 through 16). Then set up the analysis 
window by selecting the starting Col:, the Col Span: (width), the starting Row:, and the 
Row Span: (height).

Check the No Analysis Window box if you don’t want an analysis window.
You can also invoke the layout dialog by selecting Layout>New. This is the starting 

point to use when creating a new layout, whereas Layout>Configure... is primarily used 
to edit an existing layout.

You can save layout changes by selecting Layout>Save or Layout>Save As... from the 
menu. Note that the Save option saves your changes to an existing file (setup.wnmtr by 
default), but the Save As option brings up a typical save dialog and allows you to create 
a new file, or save to an existing file, so you can have a library of layouts for  different 
applications. To load a previously saved layout, select Layout>Open... and select the 
desired file.

Configuring Silence Detect Alarms

The IP-MTR64 Meters GUI can give you a visual cue when a destination with silence 
detection enabled does not have audio on it. It is assumed here that you have at least 
one destination in your system configured for silence 
detect. Look in the “WheatNet-IP Navigator GUI” 
chapter of this manual for details on how to configure 
silence detect.

Configure a meter cell to display a destination that 
is configured for silence detect. As long as there is 
audio on that destination within the silence detection 
parameters set up for the signal, it will display like any 
other meter cell of the same type.
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But if the audio on that destination goes away 
long enough to trigger the WheatNet-IP silence 
detect, and if there is no failover audio present, the 
display will change to indicate an alarm condition. 
The orange label indicates the alarm, and the meter 
shows no audio.

Alternatively, if the audio on that destination 
has gone away but there is failover audio present, 
the display will be different; the orange label will 
still be there, but the meter will show the presence of the failover audio.

The alarm color, like several other layout colors, can be changed  by selecting 
Setup>Preferences... from the menu.

Double-click on the alarm label and a log will pop up showing you what silence 
detect activity has transpired since the log was 
last cleared.

This log window can also be invoked by 
right-clicking in the meter cell and selecting 
Alarm Logs... from the popup menu.

Click Okay to close the log window. Clicking 
Clear Logs removes all entries from the window.
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Security Settings
The IP-MTR64 Meters GUI can be password protected to keep unauthorized people 

from making changes. By default the password is empty.

Setting The Password

To set a password select Network>Password... from 
the menu.

Enter the Old Password: (or leave that field blank if 
there is no password currently set), then enter the new 
password in both the New Password: and Verify New: 
fields. Click Okay.

Operating With Security

When a password has been set and you start the 
 program, you’ll be prompted for a password:

Enter the password and click Okay to use the program. 
If the correct password is not entered the program  cannot 
be started. There is also a level of security applied to 
certain functions of the program.

Making The Security Settings

Select Setup>Preferences... and switch 
to the Security tab.

Here you will see a number of tasks 
that can be Un-Locked, set to work With 
Password, or Hidden. Use these settings 
to prevent unauthorized operators from 
performing certain tasks.

You can also select or deselect check 
boxes for Double Click to Zoom and Zoom 
Full Screen.

Click Okay when done.
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Menus
Operation of the IP-MTR64 Meters GUI is done through the use of menus, both drop 

down from the main menu bar, and popups that are activated by right-clicking at  specified 
areas of the GUI. In this section we describe the various menu items, both those that have 
been described throughout the manual and those that haven’t yet been mentioned.

View

The View menu contains a few items that are necessary for basic program  configuration 
and operation. The available items are:

Full Screen – switches the program to a full screen view that eliminates both the 
status bar and the title bar from the display and in fact also hides the Windows task 
bar. While in full screen mode you can right-click in the area of any meter cell and 
select Exit Full Screen from the popup to revert to a normal view. You can also use 
the F11 key to toggle in and out of full screen mode.
About... – brings up a typical About dialog box to show you the program version.
Exit – use to close the application.

Layout

The Layout menu contains items that are used to adjust the layout of meter cells and 
the analysis window. The available items are:

New – use to create a new meter layout.
Open... – use to open a previously saved layout file.
Save – use to save the current meter layout to the last opened layout file.
Save As... – use to save the current meter layout to a new file.
Configure... – use to edit the current meter layout.

WheatNet-IP System

The WheatNet-IP System menu contains items used to acquire needed information 
from the WheatNet-IP system. The available items are:

Open... – use to open a previously saved system information file containing a list of 
sources and destinations that the program used when system resources were discovered 
via a system scan. This is handy when you are going to be setting up a meter layout 
on a computer that is not currently connected to the system.
Save As – use to save the current source and destination system information to a file 
for reference at a later time. 
System Scan... – begins the process of discovering the available source and destination 
signals in the WheatNet-IP system.
View Info... – shows the list of source and destination signals known to the program.

Setup

The Setup menu contains items used to configure program options. The available 
items are:

Network... – use to set the network interface and the 3rd Party Devices port. 
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Preferences... – use to set program color and labeling schemes, and to set the tasks 
protected by password. 
Password... – use to set a password that must be used to start the program and 
 perform certain program functions. 

Additional Popup Menus

Some popup menus are available by right-clicking within certain areas of the 
 program window.

Right-click in a meter cell to bring up this popup:
Alarm Logs... – use to view silence detect activity on a meter cell that is monitoring 
a destination configured for silence detection.
Zoom In... – zooms that meter to a full-screen view for detailed observation.
Configure... – brings up the dialog for configuring that cell.
Right-click in the analysis cell to bring up this popup:
FFT – selects the FFT display type for the analysis window. This is a Fast Fourier 
Transform, or spectral analysis, of the selected audio signal.
O-Scope – selects the O-Scope display type for the analysis window. This is a time 
domain display of the audio waveform’s amplitude (vertical) vs. time (horizontal).
E vs F – selects the E vs F display type for the analysis window. This displays the 
relative loudness using a 31-band 1/3 octave analysis.
3-D Plot – selects the 3-D Plot display type for the analysis window. This is a 
three-dimensional plot of the audio. The left scale is audio level in dB, the bottom 
scale is audio frequency in Hz, and the diagonal lower-left-to-upper-right flow of 
the display represents time.
SDR – selects the SDR display type for the analysis window. The Spectral Dynamic 
Range meter is a Wheatstone exclusive. Using a 31-band, 1/3 octave analysis the 
dynamic range of audio within each of the 31 bands is measured. The peak audio 
level is represented by the highest position of each meter bar, while the amount of 
dynamic range in each band is shown by the overall height of each bar. Very dense 
audio will be displayed with much shorter bars than very dynamic audio.
Configure... – brings up the dialog to configure the current analysis window display.  
Each analyzer type has its own set of parameters that can be configured.
Take Source... – brings up the dialog to select the source for the analysis display.

Summary
We have briefly discussed the IP-MTR64 Meters GUI program. We have described 

its function, how to install it, and how to use it. Like any software program, the best 
way to become acquainted with it is to use it, go through the menus, do some clicking 
here and there, and along the way decide how you can make the best use of its features 
for your particular application.
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WheatNet-IP Scheduler

Introduction To WheatNet-IP Scheduler
The WheatNet‑IP Scheduler program is designed to fire Events in a WheatNet  ‑IP 

system at pre-arranged times.
In order to integrate the software into a WheatNet-IP system, you will need to run 

it on a computer having a unique IP address on the same subnet as the WheatNet‑IP 
system (typically 192.168.87.xxx). You will also need to know the IP address of at least 
one Blade in the system, since the software will need to directly address a Blade.

What are events? Simply put, they are actions that will occur within a WheatNet-IP 
system. The software supports Connect, Disconnect, Salvo, and ACI (Automation  Control 
Interface) events. Events are configured within the software, and are also fired by the 
software. Events act on system signals (Connect and Disconnect events) and salvos 
(Salvo events). ACI events direct automation‑specific commands to various devices in 
the WheatNet‑IP system. Events may be saved to a file, and the saved event files may 
be loaded into the program. This allows you to create a schedule on one computer, then 
load and run the schedule on a different computer.

Since a scheduler by its very nature performs tasks at specific times, it is important 
to note that the WheatNet-IP Scheduler depends on the clock on the PC that the program 
is running on to know precisely when to fire an event. Thus the PC clock needs to be 
set to the correct time and date to match its location. Otherwise, events will not fire as 
expected.

Events And Signals

As stated above, the software utilizes various event types, signals, salvo definitions, 
and commands to compose the events necessary to effect the desired actions within the 
system at the appropriate times. These items will be discussed briefly here.

As previously stated, an event is an occurrence within the system that can be caused to 
take place at a specified time according to a schedule. Four types of events are  supported 
in the software.

Connect Event

A Connect event is one that causes a particular source (input) in the system to feed 
a particular destination (output) in the system at the scheduled time. Both sources and 
destinations can be specified by signal Name and Location (which are assigned by the 
system administrator via the WheatNet‑IP Navigator program) or signal ID (which is 
automatically assigned within the WheatNet‑IP system based on the rules the system 
imposes to define signals).

It should be noted here that only one source can be connected to a given destination 
at a time. For this reason, an event that causes a source to be connected to a  destination 
which already has a different source connected will cause the original source to be 
 disconnected prior to making the new connection.

Also worthy of note is that connections in the system may be locked, and that the 
Scheduler software will not override signal locks.
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Disconnect Event

The next type of event is a Disconnect event. In this case no source need be  specified, 
only a destination. If a source is currently connected to the specified destination, the 
 disconnect event will break that connection. However, once again, the Scheduler software 
will not override signal locks.

Salvo Event

The third type of event is the Salvo event. Salvos are configured within the WheatNet‑IP 
Navigator program, and consist of sets of connections and/or disconnections that will 
 happen rapidly in sequence when the salvo is fired. Salvos are identified both by Name 
and ID when constructing a salvo event.

ACI Event

The fourth type of event is the ACI event. This type of event is used to send ACI 
 commands to various pieces of equipment within the WheatNet‑IP system. The program 
currently supports sending ACI commands to Blades, Surfaces, and Processors. It is beyond 
the scope of this manual to list all of the ACI commands available for your use. Examples 
will be shown, but otherwise please contact Wheatstone Technical Support at 252‑638‑7000, 
or email us at techsupport@wheatstone.com, to discuss your specific requirements.

Installation
The following instructions guide you through the software installation process.

Begin Installation

The software is delivered as an installation file named  wheatnetipsched_install_x.x.x.exe, 
where x.x.x is replaced with numbers indicating the version being installed. Double‑click 
the installer file icon to start the process.

Accept The License

The first screen that you see in the installer displays the EULA (End User License 
Agreement). You must accept the license to install the program.
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Click the I Accept radio button and click Install to continue.

Finish The Installation

You will see a progress screen that will look something like this when the installation 
is complete:

Click Close to finish the installation.
The installer will also add a shortcut to your Desktop for a convenient way to 

start the WheatNet-IP Scheduler after installation.

Uninstalling The Program

Should it become necessary or desirable to uninstall the WheatNet‑IP  Scheduler, 
navigate to the program’s working directory, which will be in the folder  
Wheatstone\WheatNetIPScheduler\ under C:\Program Files (x86)\ (Windows 7) or  
C:\Program Files\ (Windows XP). Find the uninstaller.exe program and double‑click 
its icon to remove the Scheduler. Or you can use the Windows Add or Remove Programs 
Control Panel.
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First Time Operation
First time operation of any software is a learning experience. With the WheatNet‑IP 

Scheduler program, the steps involved in first time operation will differ depending on 
whether or not you are actually connected on the same network as a WheatNet-IP system.

If You Are Not Connected To A System

This section will deal with what happens when you start the program and it is not 
 connected to a WheatNet-IP System.

Default Signal Warning

Whenever the program starts it will check to see if it can find a saved signal set. The 
program installer provides a sample signal set in the directory the program searches by 
default, and whenever you save a signal set the path to that file is remembered, so you 
may never see this warning.

If you do see this warning, it simply means that your program will not be aware of any 
system signals needed to create events. Later on we will see what steps you can take to 
rectify this situation, but for the present, if you see this warning, just click OK.

License Warning

The first time you start up the program you will be asked for a License Key. This will 
also happen every time you open the program during the software’s seven day trial  period 
if you haven’t yet entered a license key. Here is what the warning looks like on the second 
day of the trial period:

If you wish to run the software beyond the seven day Trial Period you will need to 
 purchase a site license for the program from your Wheatstone Corporation sales  representative.

To continue without entering a License Key click Later. Each time you restart the 
program without having entered a valid License Key you will again be prompted to enter 
one. After the seven day Trial Period is over the nag screen will no longer give you the 
option of continuing unless you enter a valid License Key.
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License Key Entry

If you have a License Key to enter, click Enter License Key... to bring up the  following 
screen:

Enter the License Key that you obtain from Wheatstone Technical Support. You can 
either type the license key in, or right-click in the key: field and select Paste from the 
popup menu. Once the key is entered, click OK. The following screen appears when a 
valid License Key has been entered:

Click Complete to continue.

Main Screen

Once you have either entered a key, or indicated you will enter a key later if you are 
still in the trial period, the following main screen will appear:

Proceed to section “Day To Day Operation”, page A‑71.
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If You Are Connected To A System

This section will deal with what happens when you start the program and it is  connected 
to a WheatNet-IP System.

The first few steps will be the same as when not connected to a system. You may 
encounter the default signal warning, and the first time you run the program you will 
certainly encounter the license warning, unless you had an older copy of the program 
already installed and licensed.

If you are connected to a system which contains a Blade with ID of 1 and the default 
IP address of 192.168.87.101, your main screen will look like the one shown earlier, with 
the exception that the ONLINE: indicator will be green rather than gray.

For the benefit of those who may have a system without a Blade of ID 1, or have their 
system set up on a different network subnet, the next step will be to change the IP address 
that the program looks for its host Blade at.

Set IP Address

There are two different ways to change the Blade that the program will connect to.
From the menu, select File>Set IP Address... to bring up the following form:

Note that the form indicates the current setting. Change the address information to that 
of the Blade you will use to host the Scheduler:

For convenience you can type a name in the Name field. The name is not actually used.
Once the IP address is entered, click Apply. You will be prompted to restart the 

 WheatNet‑IP Scheduler Program before your new IP address will take effect.
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You can click Yes to exit immediately, or click No if you are not ready to exit. Until 
you do exit and restart it, the program will still be attempting to communicate with the 
previously specified Blade.

The other way to change the IP address is to click on the word BLADE next to the 
ONLINE indicator.

This will bring up the change dialog, and the rest of the procedure is the same as when 
started from the menu.

Once you are connected to the host Blade the main screen ONLINE indicator will be 
green.

Day To Day Operation
As you become more familiar with the program operation you will begin discovering 

the tasks you want to perform with the software. This section of the manual details the 
various tasks, what they are for, and how to perform them. For the sake of discussion, tasks 
are organized by category: System, Signals, Events, Schedule Management, and Logs.

System

The following tasks relate to the interaction between the Wheatnet‑IP Scheduler and 
the WheatNet-IP system.

Set IP Address

In order to perform any useful function, the program ultimately needs to interface with a 
WheatNet‑IP Blade. Unless you will only be interfacing with a Blade at the default Blade 1 
IP address of 192.168.87.101, you will need to know how to specify the Blade that the 
program communicates with. This procedure has already been discussed above in section 
“Set IP Address” under “If You Are Connected To A System”, page A‑70.
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Please note that in a system with multiple Blades, it generally doesn’t matter which 
Blade you connect to when running a schedule.

Define Devices

If you plan on using any ACI command events you will need to define the device or 
devices you want to control. From the menu, select File>Define Devices to bring up the 
following form:

This is quite a busy form, so let’s take it on in sections.
The Current Settings area indicates any ACI devices that have already been set up. 

Until you have set up one or more devices this area will indicate that all eight devices are 
of type blade, and all of the IP Address entries will show  .   .   .   to indicate that they have 
not been defined.

The New Settings area on the right also shows any settings that have already been made, 
and allows you to easily add devices or edit existing devices.

The normal procedure for adding a device is to first use the Radio Buttons to specify if 
the device type is Blade (default), Surface, or Processor. Next, enter the IP Address of the 
device in the spaces provided. It is important to correctly match the device type and the 
IP Address since different device types use different ports for their ACI  communications.

Editing is just as simple; change the device type, if needed, and enter the new IP  Address.
If you want to undefine a device, simply click the Delete # X button that corresponds 

to the device you no longer need.
You can commit your changes at any time by clicking Apply; the form will remain open. 

If you have made some changes but want to cancel your changes, you can click Cancel to 
revert any uncommitted changes back to what they were. Cancel will not affect changes 
that have been committed.
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When you are done defining devices click the Close button to commit your changes 
and close the form. You will be prompted to restart the program before the new device 
data will actually be used. Click Yes or No as desired.

Signals

Signals are an integral part of Connect and Disconnect events. Although you can  schedule 
one of these events without specifying signals, the event will do nothing when fired.

Signals are operated upon within the WheatNet-IP system according to their Signal ID, 
and you can, in fact, specify signals by referring to the ID. However, the signal IDs are 
somewhat cryptic, and signals can be given names that we humans will find much more 
meaningful.

Further, it makes sense from a human standpoint to have items with similar functions 
named with similar names. For an example relative to the project at hand, we may find it 
convenient to have a signal named “Fred” feeding an input on a Blade located in Studio 1, 
and a signal of the same name feeding a Blade in Studio 2, because Fred sometimes works 
from one studio and sometimes from the other. And so we allow the name to be extended 
by appending a Location to the name. In this example we would have Fred – Studio 1 
and Fred – Studio 2. In this way we can easily distinguish the two signals even when they 
share a common name.

Signal names and locations are generally configured with the WheatNet‑IP  Navigator GUI. 
We just use the same names here, getting them from the fetched signal set.

Although earlier versions of the Scheduler always attempted to fetch signals from 
the attached system at program start, that has changed with version 2.0. Now, when the 
 program starts, it first looks for a signal file residing on the computer hard drive. If at some 
time since installing the program you have saved a signal set, the program will attempt to 
load the last saved signal file. Prior to the first time you save a signal set the program will 
attempt to load a default sample set that was installed for you along with the program.

If Scheduler cannot find a signal file at startup it will display a warning, as described 
above in section “Default Signal Warning”, page A‑68. This will not be the case,  however, 
if the AutoSchedule feature has been enabled (see below section “The AutoSchedule 
 Feature”, page A‑83)

It is also possible at any time while the Scheduler is running to request signals from 
the connected system. This is covered in the next section.

Request Signals From Connected Blade

To request signals from the connected Blade while at the main screen, select File>Request 
Config from the menu. Or, if you are on the Event Properties screen (see below “Create 
Events”  section, page A‑76) you can click the Request Config button. Either method will 
start the signal fetch process described below.
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The fetch process shows the following sequence of screens when connected to a Blade:

You may stop the fetch process at any time by clicking Cancel.
When the process completes, a window appears that advises you of some of the actions 

you can perform with the Scheduler. Close it by clicking OK. If you expect to be  fetching 
signals on a regular basis (something you might want to do if you are slowly building up 
your system, or if you are making changes to signal names) but don’t want to see this screen 
every time, check the Do not show this message again box before clicking OK.
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Should you be unable to fetch signals because the program can’t connect to the system, 
you’ll be presented with the above screen. After dismissing that one you’ll be presented 
with following screen:

Clicking Quit! will exit from the Scheduler. Clicking Proceed will open a standard 
Windows file open dialog via which you can load a previously saved signal set file.

Load Signals From File

If you have previously saved a signal set, or if you want to view the sample signal set 
that is provided for you during product installation, select Signals>Open Signal File... from 
the main menu. This will open a Windows file open dialog, which will point to the default 
location for event and signal files the first time the program is run, or the location loaded 
from or saved to the last time the program was run. Navigate to the desired  location, select 
the file, and click OK.
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Save Signals To File

If you have successfully fetched signals from a system and want to have a copy of the 
signal set available so you can create and edit events without needing to be connected to a 
Blade, you will want to save your set of found signals. Select Signals>Save Signal File... 
from the menu to open a standard Windows file save dialog. Navigate to the desired folder 
if necessary, choose a memorable name for the file, and click OK.

Events

The unit building block used by the schedule as it operates is termed an Event. As 
previously discussed, there are four types of events: the Connect Event, the Disconnect 
Event, the Salvo Event, and the ACI Event. Events are created and edited from the Event 
Properties form, as discussed below in the section “Create Events”. Sets of events can 
also be saved in a file for future scheduling.

Load Events From File

If you have previously saved an event set, you can load that set by selecting File>Open... 
from the main screen. A standard Windows file open dialog allows you to select a file to 
open. Once the file has been loaded you can begin working with it.

Save Events To File

You may find it desirable to save a set of events you have created. Select File>Save... 
from the main menu. This opens a standard Windows file save dialog.

Create Events

If you are starting from scratch to create events, select Events>New from the main 
menu. This opens the Event Properties screen, which looks like this:
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Let’s take a closer look at the various parts of this form, starting with the right side 
of the form. At the top we see an ID box that we can use to scroll through the events. 
This is followed by a Name field, where the event is given a name. To the right of that is 
an Event Type drop down box, where the type of event will be selected. Note that, in the 
picture, the Event Type is blank, and the tabbed area below displays a tab titled Undefined. 
The tabbed area title and contents will change depending on the type of event selected. 
When the Event Properties form is first viewed by clicking the New button on the main 
screen, or selecting Events>New from the menu, this is how the form will look. We will 
take a closer look at the various event type tabs later.

Worthy of note is the text displayed on the Undefined tab. This defines what is  required 
before an event being created is accepted by the software. If you try to proceed from the 
currently viewed event to another by clicking Apply or OK, you will not be able to proceed 
unless certain information is furnished. The event must have an Event Type specified, 
must have at least one Day box checked, and must have a Name assigned.

Note that you can get away with not assigning signals to a Connect or Disconnect 
Event; however, such events will do nothing when fired.

The left side of the dialog, at the top, gives you the tools for specifying when an event 
will fire. The Start Time specifies the first time on a checked Day that the event will fire.  
Enter the time in 12 hour mode, and specify AM or PM.

The Repeat Interval determines how often an event will fire on a checked Day. The 
Repeat Interval is specified in hours and minutes. As an example, if the Repeat Interval 
is specified to be 4 hours and 30 minutes, and the Start Time is 2:15:00 PM, the event can 
be expected to fire on a checked day at 2:15, 6:45, and 11:15 (all these are PM times).

There are separate check boxes for each day of the week, Sunday through Saturday. 
Events will not be fired on days that are not checked. For convenience, the Check All 
Days and Uncheck All Days buttons are provided, with rather obvious consequences. 
The Invert Selection button checks all unchecked Day boxes and unchecks all checked 
Day boxes.

The 1-Time-Only check box is a little less obvious. When this box is checked, once 
an event fires it is deleted from the Scheduled Events list. However, if the box is not 
checked, the fired event is added at the bottom of the schedule, one week later in time 
than when it just fired.

Below the schedule settings are two buttons used to enter the event in the Event   Manager 
list. OK enters the current event in the list and closes the Event Properties dialog, while 
Apply adds the current event to the list but leaves the Event Properties dialog in place. 
A third button, Cancel, er – ah – cancels the event, and it is not added to the list.

Advancing the previously described ID spin box without first clicking Apply on the 
current event results in a prompt that asks you to decide if you want to apply changes 
before viewing the next event.

The previously discussed Request Config button on the left side of the dialog at the 
bottom is used to fetch signals from a connected Blade.
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View Events

The Event Properties dialog shows you the properties of the event currently being 
viewed. As mentioned above, the tabbed area will change depending on the Event Type.  
Let’s look at this a little more closely.

If Connect is selected as the Event Type, the tabbed area looks like this:

Notice that a Connect Event is used to connect a given source signal to a given  destination 
signal. The signals are specified on this tab. You can select a signal by its Signal ID if you 
know it, but you do not need to know the Signal ID to specify it. The signal can also be 
selected by Name and Location. If you are not sure of the Name and Location associated 
with the signal you want to use, and do not know the Signal ID either, you can still have 
the event added to the Event Manager list. However, the event will do nothing when fired 
unless valid signals are specified.

Note that when you scroll to an already defined Connect Event the programmed  signals 
will be shown.

If Disconnect is selected as the Event Type the tabbed area looks like this instead:
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A Disconnect Event is used to disconnect the current source signal (which does not need 
to be specified) from a given destination signal. The destination is specified on this tab. Once 
again you can select a signal either by its Signal ID or by its Name and Location.

Note that when you scroll to an already defined Disconnect Event the programmed signal 
will be shown.

If Salvo is selected as the Event Type the tabbed area changes once again:

A Salvo Event is used to select a particular salvo to fire (please read the section of the 
WheatNet‑IP manual that deals with the Navigator software to find out more about salvos).  
You can select the desired salvo either by its Signal Number or by its Name.

Note that when you scroll to an already defined Salvo Event the programmed salvo 
information will be shown.

Selecting ACI as the Event Type results in this in the tabbed area:

Use the Device spin dial to select the desired device for this ACI event. As you cycle 
through the defined devices the device Type and IP Address fields will reflect the  properties 
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of the device. In this instance we have selected device 1, which is a control surface located 
at 192.168.87.202. The OnLine indicator will be green if the program is able to connect to 
the selected device, or red if not.

Once the device is selected you must compose a command string appropriate to the 
 device. In our example we want fader 1 on the surface to turn on when the command is 
 issued. The basic format for a fader on/off command to a surface is this:  <INPUT:x|ON:y>  
where x indicates the fader number and y indicates the desired fader state, with 1  indicating 
on and 0 indicating off. This command is entered in the Compose String field. Note that 
letters are automatically converted to upper case when entered, so there is no need to use 
Shift or Caps Lock.

Once you have composed the desired command string you may want to test it. Press the 
Test button and the string in the Compose String field will be sent to the selected device.

When you are sure the command string is doing what you want, press Enter. This copies 
the command string from the Compose String field to the Event ACI Command String field.

If you have composed a command string you think you may need again press the Save 
String button. The program can remember up to 50 command strings this way.

Note that when you scroll to an already defined ACI Event the programmed device 
information will be shown, and command string will appear in the Event ACI Command 
String field.

As previously mentioned, it is beyond the scope of this manual to list all of the 
ACI  commands available for your use. Please contact Wheatstone Technical Support 
at 252‑638‑7000, or email us at techsupport@wheatstone.com, to discuss your specific 
 requirements.

Edit Events

If you have an existing event that you want to modify, you once again need to be on 
the Event Properties dialog. If you are already on this form you can use the ID spin dial 
to scroll to the event you want to change. Or if you are at the main window and viewing 
the Event Manager tab you can highlight the event and click Edit or select Events>Edit 
from the menu. The process of editing an event is to change the Event Properties from the 
 current settings to the desired settings. The pertinent information has already been discussed.

Schedule Events

With a few events in the Event Manager list, your main screen, Event Manager tab, 
could look like this:
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With a single event highlighted, as shown, you can click Schedule, or select 
Events>Schedule, to schedule only that event. You could also highlight, using  either 
the Shift key or the Ctrl key, a small number of events, say two or three, and use 
 Schedule to schedule only those events. Or you can use the Schedule All button or select 
Events>Schedule All to add all events in the list to the schedule – in this case you only 
need to highlight one event.

Delete Events

From the Event Manager list, you can highlight an event and click the Delete button 
or select Events>Delete from the menu to delete that event. This will delete the event 
from the Event Manager list and also delete any as yet unfired instances of the event from 
the schedule. If the event (or events) has not yet been scheduled, the delete process will 
happen automatically. But when removing scheduled events you will be asked to verify 
your intent:

Click OK to proceed, or Cancel if you’ve changed your mind.

Schedule Management

Once you have created some events and added them to the schedule, you can view the 
schedule list from the main form by selecting the Scheduled Events tab:

As the event at the top of the list fires, it is removed from the list. If the event is not 
specified to fire one time only, the same event will then appear at the bottom of the schedule 
list, for a time one week in the future from the time the event just fired.
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The event at the top of the list is the next one due to fire. It is highlighted with a light 
red background, whereas the other events in the list are normally highlighted with a light 
green background.

If you click on an event in the list to select it for an action, such as to move, delete, 
or disable it, the event text changes from black to white. Multiple events can be selected 
using the Shift or Ctrl keys, as in normal Windows operation.

If an event is disabled it will show in the list as red text on a white background.  
An example of this is shown later.

Moving Items

Events in the schedule must fire in sequence. This means that two events scheduled 
to fire at the same time will still fire one after another, in the sequence they are listed on 
the Scheduled Events tab. If you have two (or more) such events and need to fire them 
in a specific sequence, you can adjust their relative positions in the list. If you highlight 
one of two (or more) events scheduled for the same time, one (or possibly both) of the 
Move  buttons (Move Up and Move Down) will become active. Clicking Move Up moves 
the position of the event one place higher up the screen, whereas Move Down does the 
opposite. The buttons will be disabled (grayed out) if the event highlighted is scheduled 
for a different time than the one in the direction that the button would move it if enabled.

Deleting Items

Just as you can delete events from the Event Manager tab, you can also delete events 
from the Scheduled Events tab. But the choices are a little more complicated. Highlight an 
event on the Scheduled Events tab, click Delete (or select Schedule>Del From Schedule 
from the menu) and the following dialog pops up:

The choices are clearly explained on the dialog box. Click the appropriate button.

Enabling And Disabling Items

You can disable all instances of an event from the Scheduled Events tab. This will 
prevent the event from firing but will not delete it from the 
schedule. The event can later be enabled. Select an event and 
click the Enable/Disable  button or select Schedule>Enable/
Disable from the menu. A dialog box asks you if you want 
to disable all instances of the event:

Click Yes to disable all instances of the event, or No to 
cancel the delete.
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You can select multiple events from the list  using the normal Windows techniques with 
the Shift and Ctrl keys. You will be prompted individually for each event you have selected.

Here is a section of the Scheduled Events tab showing a few disabled events:

To re‑enable an event (or events) the process is similar. The prompt dialog asks if you 
want to enable all instances of the event.

The AutoSchedule Feature

The Scheduler can be set up to load and run your schedule automatically at program 
start. The check box for enabling and disabling the AutoSchedule feature is located near 
the upper right corner of the Scheduler main window, and appears no matter which tab, 
Event Manager or Scheduled Events, is being displayed.

When AutoSchedule has not been enabled the check box looks like this:

When AutoSchedule is enabled the check box looks like this:

When AutoSchedule is enabled and the Scheduler started, it will attempt to load the 
last saved signal set. Whether this operation succeeds or not it will also attempt to load the 
last saved event file. If it succeeds at finding the event file it will schedule all events in the 
file and begin firing scheduled events at the required times.

The Scheduler, when not in AutoSchedule mode, will pop up a message indicating 
failure to find a signal set if it can’t find default set, which will then require an operator 
to click OK on the message box to continue. But in AutoSchedule mode, if the signals 
 cannot be found, no message about that appears. This is to keep the lack of a found signal 
set from preventing the running of the schedule automatically.
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 When the Scheduler is in AutoSchedule mode, it will stop and present a message 
requiring user action if it cannot find a schedule to run.

The main purpose of providing the AutoSchedule feature is so that a computer running 
a schedule on the Scheduler program can recover from a power outage without requiring 
user intervention to get the schedule running. In order for this to succeed you will need 
to be running the Scheduler as a user on the computer who is automatically enabled at 
computer startup without the need to have the user log in. Otherwise the program will 
not be able to start without some user input.

Exiting With A Schedule Running

Obviously, the software can only fire events from the schedule when the software is 
running. If a schedule is running and you close the program the following prompt will 
appear:

Clicking Yes will close the program, with the result that any as yet unfired events 
in the schedule will not be fired. Clicking No will dismiss the prompt and the program 
(and schedule) will continue to run. If you are tired of seeing this screen at program exit, 
check the Don’t ask me this again! check box. The software will then no longer warn 
you at program close.

More On Exiting

Upon exiting the program you will see the following prompt:

The program may continue running for a short time after all its windows disappear 
as it shuts down device connections.
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Logs

The WheatNet‑IP Scheduler program automatically keeps logs to indicate various 
types of activity. The files are named EventLog_weekX.log, where the X can be a 
number from 1 to 4. Upon program exit, log data from the current session is appended to 
the end of the currently active log file. Older logs are overwritten, so you need to look at 
the Date/Time stamp of the log files to determine which one is most current. Log files live 
in the same default location as the signal and event files previously discussed, typically  
C:\Documents and Settings\<username>\Application Data\ 
Wheatstone\ in Windows XP or C:\Users\<username>\AppData\ Roaming\
Wheatstone\ in Windows 7.

Should you need to contact Wheatstone Technical Support regarding an issue with the 
software you may be asked to provide the logs.

Viewing Logs

The current log may be viewed by selecting View Log from either the Events or the 
Schedule menu item, or by clicking the View Log button on the main window. A typical 
log when viewed shortly after the program starts might look like this:

Also added to the log file are indications of events that have fired, requests for  fetching 
signals, opening and saving event and signal files, and other useful information.

If any events have fired, they will be listed in the log. Any such listing contains the 
text “EVENT”. This keyword is used when clicking the Previous Event and Next Event 
buttons to find all such listings in the log.

Since the log files are plain text files, they can also be viewed in any simple text editor.
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Menus
The WheatNet‑IP Scheduler software is operated using buttons and menus. This  section 

serves to bring together the descriptions of the various menu items that have been described 
throughout the manual. Some items in the main menu depend on which tab is being viewed 
and what items on that tab are highlighted. The small menu on the log form is described 
at the very end of this section.

File

The File menu contains a few items that are necessary for basic program  configuration 
and operation. The available items are:

Open...   This item allows you to open a previously saved set of events for editing and/
or scheduling.
Save...   This item allows you to save the current set of events for later use.
Set IP Address...   This item allows you to specify the Blade that you expect to connect 
to for obtaining signals and as the avenue by which your fired Connect, Disconnect, 
and Salvo events will control the system. You will need to restart the program after 
changing this setting.
Define Devices   This item allows you to specify the device or devices that you  expect 
to connect to for firing ACI events. You will need to restart the program after  changing 
any device settings.
Request Config   This item allows you to fetch the signals known to the Blade to which 
you are connected. The program’s existing signal set is deleted first, so you may want 
to save a signal set before fetching a new one.
Print...   When selected while viewing the Event Manager tab, this item allows you to 
print the contents of the event list. When selected while viewing the Scheduled Events 
tab, this item allows you to print a snapshot of the current schedule list. Events that 
have already fired will not appear on the printout.
Exit   This item allows you to close the Scheduler software.

Edit

The Edit menu contains a couple of items that can be useful in creating new events 
that are similar to existing events. This menu is only usable on the Event Manager tab. 
The available items are:

Copy   This item will copy the Start Time and Repeat Interval of the currently  highlighted 
event to the clipboard, with a Name like “Copy of This Event”, assuming the Name of 
the event copied is “This Event”.
Paste  This item will paste the contents of the clipboard into the next available line on 
the event list.

Events

The Events menu is only visible when viewing the Event Manager tab. It contains items 
useful in managing the creation and editing of events. The available items are:

New   This item calls up the Event Properties dialog with the first available undefined 
event showing.
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Edit   This item calls up the Event Properties dialog with the currently selected event 
showing. If multiple events are highlighted, the last one selected is the one that will be 
showing.
Delete   This item begins the delete process for the event(s) highlighted. When an event 
is deleted from the Event Manager tab it is removed from the event list, and all  scheduled 
instances are removed from the schedule list.
Schedule   This item adds the highlighted event(s) to the schedule, at all scheduled times 
 indicated by the Event Properties.
Schedule All   Regardless of event(s) highlighted, this item adds all events to the  schedule 
at all scheduled times indicated by the Event Properties.
View Log   This item calls up the Event Log window.

Schedule

The Schedule menu is only visible when viewing the Scheduled Events tab. It contains 
items useful in managing the scheduling of events. The available items are:

Move Up   If the currently highlighted event is scheduled at the same time as the event 
immediately above it in the schedule list, this item moves the highlighted event up so 
it will fire first.
Move Down   Similarly, if the currently highlighted event is scheduled at the same time 
as the event immediately above it in the schedule list, this item moves the highlighted 
event down so it will fire second.
Del From Schedule   This item begins the delete process for the event(s) highlighted. 
When an event is deleted from the Scheduled Events tab it is not removed from the 
event list. You can also specify whether all scheduled instances are removed from the 
schedule list, or only the highlighted instance.
Enable /Disable   This item toggles the “firing state” of the highlighted event(s) in the 
schedule, at all scheduled times indicated by the Event Properties.
View Log   This item calls up the Event Log window.

Signals

The Signals menu contains a couple of items that can be useful in managing signal lists. 
The available items are:

Open Signal File...   This item opens a previously saved signal set file. This is useful 
if you want to do offline editing of events without being connected to a Blade since it 
 allows you to use the same signal set the software will be working with when connected 
to the target system.
Save Signal File...   This item allows you to save the signal set in current use to a file. 
The file can be loaded to do offline editing. You can also print the file (after opening it 
in a  standard text editor) for printed documentation of your system’s signals.

Help

The Help menu contains a couple of useful items:
Next Steps   This item displays a message box with some quick hints on using the software.
About   This item reveals the Version number of the software.
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Event Log Menu

The Event Log window has a small menu to help perform some useful tasks.

Event Log Menu – File

The File menu on the Event Log window contains a few items that are helpful in  working 
with logs. The available items are:

Save as...   This item allows you to save the current contents of the Event Log window 
to a file without removing the text from the window.
Purge to File...  This item allows you to clear the Event Log window. The current  contents 
of the window are appended to the end of the currently active EventLog_weekX.log 
file. A brief line is added to the now clear Event Log window indicating the date and time 
the window was purged and what file the data was appended to.
Print...   This item allows you to print the contents of the Event Log window.
Exit   This item closes the Event Log window. It does not close the Scheduler software.

Event Log Menu – Edit

The Edit menu on the Event Log window contains one additional item useful in  working 
with logs:

Copy   This item copies any highlighted text in the Event Log window to the Windows 
clipboardπ. The text can then be pasted into another application, such as a text editor 
from the clipboard. This is useful when you want to copy some data from the Event Log 
window, but don’t want the entire contents.
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WheatNet-IP PC-XY Software Configuration Guide

Overview
PC-XY is an easy to use PC application that facilitates audio and logic cross point 

control of a WheatNet-IP audio network. The software connects to any host Blade in 
the system via the PC’s Ethernet connection and provides customizable routing of 
audio or logic.

Source and Destination windows display user defined signal lists that give the  broadcast 
engineer tight control over access to system resources. Eight fully programmable “hot” 
buttons can act as source selectors for rack room or desktop speakers, control room to 
air chain selectors, recorder source selectors – the possibilities are endless. 

Installing The Software
WheatNet-IP PC-XY is a Windows platform program and runs 

on XP, Vista, or System 7. Installing the software is easy. Simply 
run the executable installation application and follow the  installation 
prompts. 

Once installation is completed you will be asked for a  License 
Key. You can choose to run the software free for 14 days or contact 
customer support at 252-638-7000 or  techsupport@wheatstone.com 
to get your license key emailed to you.

License keys are good for installing the product on multiple 
machines for up to seven days. The program will continue to run 
on the machine it is installed on, it is just the installation license 
key that expires.

Network Considerations
The PC-XY program communicates to the WheatNet-IP system over an Ethernet 

network. The PC hardware requirements are “bare bones minimal”. The PC’s network 
card can be Fast Ethernet (10/100BTX) or Gigabit (1000BT). The PC must have an 
IP address on the WheatNet-IP system’s subnet or have been routed there by your IT 
administrator.  

Multiple PC-XY’s
You can run multiple instances 
of PC-XY on one PC, each with 
unique buttons and visibilities. 
Each instance will share the same 
password.

• Copy the “bin” folder, from 
your current install folder:   
C:\ ProgramFiles\Wheat-
stone\WheatNetIpPCXYGui 
\bin

• Put “bin” inside a new folder 
in the Wheatstone folder.

 •  Create a shortcut to the new  
PC-XY.exe file location.
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Logging In
When PC-XY is first started you must log in to set 

a password and make various configuration changes. 
Right click on the PC-XY front panel to open the Login 
form. Click Ok to log in for the first time.

Menus
You may access the menu tree at any time by right clicking anywhere on the PC-XY 

controller. If you are not logged in you will be prompted to Login. Most menu choices are 
self explanatory. The following is a brief description of the key choices.

The default PASSWORD is blank when you install the program. 
Just click Ok to Login for the first time.

Sort Signals…
By Id – Sorts all signals in linear Blade ID order.
By Name – Sorts alphabetically - system wide.

Visibilites… – Create custom Source/Destina-
tion lists.

Change Password… – Modify password here.

Set IP Address… – Select a Blade that PC XY 
will use as an access point to the system’s 
signal map.

Logout… – When you logout users can freely 
use PC-XY controls but can not program any 
changes.

Setting Blade IP Address
This step lets PC-XY use a Blade in your system as an access point so it can gather 

Source and Destination names and also make cross points. Start by selecting Set IP  Address… 
from the right click menu.

In order to communicate with the WheatNet-IP 
system you must tell PC-XY which Blade in the system 
you’d like it to talk to. You may select the IP address 
of any Blade in the system. Click Ok when done.
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Once PC-XY establishes a connection with the specified Blade, you 
will see that the LINKED “LED” will turn bright green. Source and 
Destination signal names will also be available in the drop down lists.

Note that the Visibility controls, explained later, determine  exactly 
which Source and Destination signal names are available to this 
 particular installation of PC-XY.

Using Source / Destination Windows
These windows allow access to any number of sources and destinations. 

• Use the SOURCE drop down 
list to select the audio input 
you would like to route. 

• Select a DESTINATION 
from its drop down list. 

• Press “TAKE” to complete 
the route.

• Customize lists with Visibility settings.

Logging Out
When you have completed the setup of PC-XY you can Log Out. When you log out, 

PC-XY continues to function however users can not edit any of the settings without the 
Log In password.

Visibilities
The Set Visibilities form allows the engineer to configure PC-XY so the end user “sees” 

a limited set of Source, Destination, and Salvo signals. This is where you limit what shows 
up in the drop down Source and Destination lists on PC-XY’s front panel. This  function 
is  useful when 
you wish to give 
non-technical 
 users Source 
 select control 
of a very lim-
ited number 
of sources and 
 usually control 
of only a single 
destination – 
like a set of 
PC speakers 
or the input 
to a recording 
device. 
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Simply select the signals you want this installation of PC-XY to “see” and click Ok 
when finished. PC-XY will boot with these settings. Setting a Login password will prevent 
unauthorized changes to the visibility lists.

Hot Button Programming
The eight Hot Buttons located along the bottom of the PC-XY front panel may be 

 programmed to make dedicated cross points or fire salvos. Text typed in the Legend field will 
appear on the button. You may type approximately 10 characters before they are truncated. 

Right click on the button you want to program 
to open the button’s configuration form.

Enable… – Check this to activate the button for 
all users. Un-check Enable to disable the button 
but retain settings.

Legend: – Enter text to display on button face.

Connect – Select the cross point that will be 
“patched” when the button is pressed.

Fire Salvo – Choose a Salvo to be executed when 
the button is pressed. Salvos are simply a list of 
multiple cross points that are  simultaneously 
triggered. Salvos must be pre-configured in 
WheatNet-IP Navigator software.

Allow User Programming – Check this if you 
want to let users edit Hot Button settings without 
logging in.
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